S 0 NY 4-735-109-41 (1)
®

Digital Motion Picture Camera
VENICE

Istruzioni per l'uso

MPC-3610

Firmware versione 1.0

AI‘

‘ N
CineAlta

SRS

© 2017 Sony Corporation



Sommario

1. Descrizione generale 4. Ripresa
(aratteristiche 3 Operazioni di base 58
Configurazione del sistema 5 Funzioni utili 59
Ubicazione e funzione delle parti................ooocerceercen 6 — -
5. Collegamento di dispositivi esterni
2. Operazioni preliminari Connessione di monitor e dispositivi di
Preparazione dell'alimentazione.................o.... 14 registrazione esterni 60
Impostazione dell'orol0gio...........ocoeoesecren 15 Sincronizzazione estera 62
Montaggio di adattatore mirino e maniglia .................. 16 6. Appendice
Montaggio di un obiettivo e regolazione della
lunghezza focale diflangia...............oocoovsccerce 17 Precauzioni per fuso 63
Montaggio di un mirino 19 Formati diregistrazione e segnali di UsCita.................... 66
Utilizzo di schede dimemoria S¢S, 2 Indicazioni di errore e di aWertenza...........c..eeeceeeene 70
Utilizzo di schede SD per il salvataggio dei dati di Impostazioni salvate n fle 72
configurazione. 3 LICONZE ..t 76
Abbinamento con il registratore AXS-R7..........o......... 2% SPECIICNE . 77
3. Utilizzo della videocamera
Display SECONAAMNO ..vvvvvvvvvessveversverrsssesee s 26
Utilizzo della schermata Home del display
secondario 29
Schermata funzioni utente 32
Utilizzo dei menu 35
Operazioni del menu COMPIEL0......cccevvvevvverrereverrne 4
Flenco delle vodi del menu completo ..o 42
Operazioni sui clip 53
Riproduzione 55
Utilizzo della schermata Home del mini display............. 56



003

1. Descrizione generale

Caratteristiche

Nuovo sensore immagine CMOS Full
Frame da 3624 mm

Attacco ottiche PL

Design modulare

Consente l'acquisizione di immagini a una
risoluzione massima di 6048 x 4032 pixel.* Nelle
modalita Imager, la videocamera offre il supporto
nativo per numerosi formati di ripresa, fra cui
Super 35 da 24,3 X 12,8 mm, con risoluzione

4096 x 2160 pixel (equivalente a pellicola
cinematografica a 3 perforazioni) e Super 35
anamorfico 4:3 da 24,3 x 18,3 mm, con risoluzione
4096 x 3024 pixel (equivalente a pellicola

cinematografica a 4 perforazioni).
* La modalita Full Frame e la modalita anamorfica
richiedono licenze aggiuntive, in vendita separatamente.

Dotata di attacco ottiche PL standard nel settore.
L'attacco obiettivo supporta la tecnologia Cooke /i.
| dati delle ottiche vengono registrati come
metadati fotogramma per fotogramma.

Corpo compatto e utilizzo intuitivo

Ampia latitudine

L'unita offre una latitudine di oltre 15 stop. Grazie al
bassissimo livello di rumore, consente di produrre
immagini fenomenali nelle pit estreme condizioni
di illuminazione, dalla luce solare piu intensa
all'oscurita quasi completa, lasciando una liberta
creativa in fase di grading senza precedenti.

Acquisizione di immagini su un
ampio spazio colore

Le immagini possono essere catturate in uno
spazio colore ben pit ampio delle specifiche
DCI-P3. Utilizzando lo spazio di colore Sony
S-Gamut3.Cine in abbinamento con S-Log3,
l'operatore ha a sua disposizione una liberta di
grading assolutamente eccezionale.

Un design sorprendentemente compatto per un
apparecchio dotato di sensore Full Frame di grandi
dimensioni, ottenuto utilizzando la tecnologia di
miniaturizzazione Sony per facilitare le riprese in
spazi ristretti o su droni.

La posizione, la forma e le dimensioni dei comandi
sono state concepite prestando attenzione alle
esigenze degli operatori di ripresa per offrire un
utilizzo pratico e intuitivo. | comandi sono dotati di
retroilluminazione per facilita d'uso in condizioni di
scarsa illuminazione.

Progettata per durare

Lo chassis e realizzato in lega di magnesio per
garantire la massima robustezza e durata nel
tempo. Il sistema di ventilazione & completamente
isolato da tutti i componenti elettronici per evitare
infiltrazioni di polvere, sabbia e liquidi*

La silenziosissima ventola puo essere pulita o
addirittura sostituita sul set con rapidita e facilita,

garantendo elevati livelli di ridondanza.

* |l design prevede una protezione contro la polvere e la
pioggia ma non & concepito per impedire totalmente
l'ingresso di polveri e liquidi.

La videocamera ha un design completamente
modulare, permettendo I'utilizzo, con la massima
flessibilita, delle attrezzature, apparecchiature

e accessori richiesti dalle riprese specifiche. Per
garantire un equilibrio ergonomico e la facilita
d'uso con le varie ottiche, la maniglia superiore

e il mirino sono facilmente regolabili. Dato che
I'altezza dell'asse ottico e identica a quella della
PMW-F55. & possibile utilizzare gli stessi accessori
utilizzati con la PMW-F55. Inoltre, il montaggio sul
retro della videocamera di un registratore portatile
a schede di memoria AXS-R7 richiede solo quattro
viti a brugola.

Filtro ND ottico a 8 posizioni

La videocamera dispone di un filtro ND ottico a

8 posizioni. Con una ampia gamma ND da 0.3ND
(1/2 =1 stop) a 2.4ND (1/256 = 8 stop) riduce le
perdite di tempo sul set altrimenti necessarie per
cambiare filtri ND esterni. Il meccanismo del filtro
ND e servocomandato.

Operazioni intuitive e abituali sul set

Le schermate di menu sono disponibili su
entrambi i lati della videocamera. Il display di
comando principale si trova sul lato assistente
della videocamera per consentire il rapido accesso
alle impostazioni della videocamera da parte
dell'assistente durante la ripresa.

La presenza di un mini display OLED sul lato
operatore consente l'accesso alle funzioni di

uso piu frequente, quali posizione del filtro ND,
otturatore, bilanciamento del bianco, indice di

esposizione (El), e facilita inoltre il controllo dello
stato dell'unita da parte dell'operatore.

Vari formati di registrazione

L'unita supporta la registrazione su schede di
memoria SxS nei formati XAVC e MPEG HD.
Permette inoltre di registrare in formato 16 bit RAW
0 X-OCN su schede di memoria AXS, se utilizzata
insieme a un registratore portatile a schede di
memoria AXS-R7 opzionale.
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1. Descrizione generale: Caratteristiche

Dimensioni immagine effettive

Licenze software

L'unita consente la ripresa nelle dimensioni immagine effettive indicate di seguito.

[Nota]
La ripresa nei formati 6K 3:2 e 4K 4:3 richiede una licenza software specifica.

6K 3:2

l

[T 4K43

—————————— ---38K 169

D)

(Ultra H

m—@rmmmmmmm— e

Sono disponibili licenze software (opzionali) selezionabili in base all'uso previsto dell'unita.
Le licenze software vengono installate mediante l'opzione Maintenance > License Options (pagina 52)

nel menu completo.

Licenza software Modalita Numero effettivi di pixel L x A (mm) Frequenza fotogrammi
Imager di progetto
Licenza non richiesta  3.8K 16:9 3840 x 2160 22,8%x128 23,24, 25, 29,50, 59
4K17:9 4096 x 2160 243%x128 23,24, 25,29, 50,59
Licenza Anamorphic 4K 4:3 4096 x 3024 24,3 %183 23,24
Licenza Full Frame 6K 3:2 6048 x 4032 35,9 x24,0 23,24
[Nota]

La registrazione in 6K 3:2 & supportata, ma non ne & supportata la riproduzione.
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Configurazione del sistema

Portamicrofono (A-2182-620-A)
Morsetto asta (A-2182-621-A)

M1 Asta (4-684-612-01)
Mirino Mirino Microfono
DVF-EL200 DVF-L700 ECM-680S, ECM-678,
(richiede I'uso di cavo VF ECM-674
(A-2201-632-A 0 A-2201- (richiede EC-0.5X3F5M)
633-A)) D
N =
; E Registratore Scheda di memoria AXS Lettore per schede di
Sm: portatile AXS-A256524, AXS-A512548, memoria AXS
E g con memoria AXS-A512524, AXS-A1TS48, AXS-AR1, AXS-CR1
gl: AXS-R7 AXS-ATTS24

Obiettivo
SCL-PKe,
SCL-P11X15
S35 PL
- [l & [5—' Batteria
° @) BP-FL75, BP-FLX75
&-| o[ | }
o) (0] aD
5 g
Licenza formato o _ I / = j
anamorfico Obiettivo anamorfico <~
CBKZ-3610A, MPC-3610 Lettore per schede di memoria
CBKZ-3610AM, AXS AXS-AR1
CBKZ-3610AW '|
Adattatore CA
_~ AC-DN2B, AC-DN10
AT
— % f.,-'r/‘. / Lettore di schede USB
‘ , |' SBAC-US30/UT100
Licenza formato Full Adattatore per supporto a Scheda di memoria SxS
S : Obiettivo Full Frame spalla VCT-FSAS SBP-256D, SBP-1288/C/D, SBP-64A/B/C/D, SBP-32,
CBKZ-3610F, SBS-64G1A/B, SBS-32G1A/B
EE%?S SR\/AV Scheda di memoria XQD

QD-S64E, QD-S32E, QD-N64, QD-M128A, QD-M64A,
QD-M32A, QD-G128A/E, QD-G64A/E, QD-G32A/E
(con utilizzo di adattatore XQD ExpressCard QDA-EX1)
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1. Descrizione generale

Ubicazione e funzione delle parti

Lato operatore

Ingresso aria

Blocco slot
schede di memoria SxS (pagina 7)

12 3| 4
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1. Tasti programmabili ASSIGN 1/2 (pagina 32)
E possibile assegnare ai tasti ASSIGN varie
funzioni tramite la pagine EDIT della schermata

funzioni utente (pagina 32).

Ogni pressione del tasto attiva o disattiva
oppure abilita la funzione programmata.

2. Indicatori tasti programmabili ASSIGN 1/2

(pagina 32)

Ciascuna spia si illumina con luce arancione
quando la funzione ¢ attiva, oppure & spenta

quando la funzione non é attiva.

3. Tasti ITEM da 1 a 3 del mini display.

Comandano le funzioni visualizzate sul mini

display (pagina 56).

Mini display

Visualizza varie impostazioni, quali ad esempio
I'angolo dell'otturatore, per la verifica o la
modifica (pagina 56).

Indicatori ACCESS (SLOT A/B)

Ciascuna spia si illumina quando il supporto di
registrazione nello slot per schede di memoria
SxS A o B corrispondente ¢ la destinazione di
registrazione o riproduzione e vengono scritti
o letti dati da esso (pagina 21).

Connettore di rete (RJ-45)
Non supportato nella versione 1.0 del
firmware.

7.

9.

10.

1.

12.

Tasto CLIPS
Non supportato nella versione 1.0 del
firmware.

Interruttore di accensione

Spostare su ON (I) per accendere. Spostare su

OFF (M) per spegnere.

[ATTENZIONE]

e |'unita utilizza una piccola quantita di alimentazione
standby anche se l'interruttore di accensione si trova
in posizione OFF. Rimuovere la batteria se si prevede
di non utilizzare I'unita per un periodo di tempo
prolungato.

® Quando si rimuove la batteria o I'alimentazione DC
IN, accertarsi innanzitutto di impostare l'interruttore
di accensione in posizione OFF. Linterruzione
dell'alimentazione durante la registrazione o durante
I'accesso alla scheda di memoria potrebbe causare
malfunzionamenti.

Tasto HOME

Premere per uscire dalla selezione di voci e
tornare alla schermata Home sul mini display.
Se viene premuto mentre |'unita si trova in
modalita di riproduzione, 'unita passa alla
modalita di ripresa (pagina 56).

Selettore LOCK

Blocca il funzionamento dei tasti sul lato
operatore. Se bloccato, I'indicatore del
selettore € illuminato con luce arancione.

Connettore per cuffia (mini jack stereo)
Consente il collegamento di cuffie per il
monitoraggio audio. E possibile monitorare
I'audio diingresso durante la ripresa o la
riproduzione o l'audio di riproduzione durante
la riproduzione (pagina 55).

Altoparlante incorporato

Consente di monitorare l'audio di ingresso
durante la ripresa o la riproduzione o l'audio di
riproduzione durante la riproduzione .
L'altoparlante emette anche segnali acustici di
awviso per richiamare I'attenzione ad eventuali
awvisi visivi (pagina 55).

Se si collegano auricolari alla presa cuffie,
I'altoparlante viene automaticamente
disattivato.

. Spia REC ACTIVE

Questa spia si illumina con luce verde quando
il tasto REC e abilitato.

. Spia tasto programmabile ASSIGN 3

(pagina 32)

La spia si illumina con luce arancione quando
la funzione & attiva, oppure & spenta quando la
funzione non ¢ attiva.

. Tasto/spia REC (avvio/arresto registrazione)

Premere per avviare la registrazione,
accendendo la spia REC. Premere nuovo per
arrestare la registrazione, spegnendo la spia
REC (pagina 58).

La spia REC lampeggia in caso di errore o
avvertenza.

. Indicatore ¢

L'indicatore ¢ si trova sullo stesso piano del
sensore immagine.

Utilizzando l'indicatore ¢ come riferimento, e
possibile misurare la distanza precisa tra
videocamera e soggetto.
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1. Descrizione generale: Ubicazione e funzione delle parti

Blocco slot schede di memoria SxS (pagina 21)

Gli alloggiamenti delle schede di memoria SxS si
trovano dietro il coperchio.

1. Alloggiamenti schede di memoria SxS A/B

2. Terminale di calibrazione del fabbricante
Terminale del fabbricante per calibrazione e
assistenza. Non e utilizzabile dagli utenti.

3. Tasto SLOT SELECT (selezione della scheda di
memoria SxS)
Premere per selezionare lo slot attivo.

Lato assistente
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. Tasto programmabile ASSIGN 4

(pagina 32)

E possibile assegnare ai tasti ASSIGN varie
funzioni tramite la pagine EDIT della schermata
funzioni utente (pagina 32).

Ogni pressione del tasto attiva o disattiva
oppure abilita la funzione programmata.

. Spia tasto programmabile ASSIGN 4

(pagina 32)

La spia si illumina con luce arancione quando
la funzione & attiva, oppure & spenta quando la
funzione non é attiva.

12‘

11 10

3. Display secondario
Consente di controllare lo stato operativo
dell'apparecchio ed eseguire varie
impostazioni (pagina 27).
Mentre & visualizzata la schermata Home,
mantenere premuto il tasto BACK
(pagina 8) e ruotare allo stesso tempo il
comando SEL/SET per regolare la luminosita
del display secondario e del mini display.
La luminosita pud essere regolata anche
tramite la voce Technical > Control Display >
Brightness Level (pagina 51) del menu
completo.

. Tasti ITEM da 1 a 6 del display secondario

Comandano le funzioni visualizzate sul display
secondario (pagina 35).

. Gancio per metro a nastro

Il gancio del metro a nastro si trova sullo stesso
piano del sensore immagine. Utilizzando
questo gancio come riferimento & possibile
misurare la distanza precisa tra videocamera e
soggetto. Fissare l'estremita di un metro a
nastro a questo gancio per misurare la distanza
del soggetto.

. Tasto HOME

Premere per cancellare le visualizzazioni e
tornare alla schermata Home del display
secondario (pagina 29).

Se viene premuto mentre 'unita si trova in
modalita di riproduzione, I'unita passa alla
modalita di ripresa .

. Tasto MENU (visualizzazione menu on/off)

(pagine 35,41)

Premere il tasto MENU per visualizzare la
schermata di menu sul display secondario.
Mantenere premuto il tasto MENU per almeno
2 secondi per visualizzare la schermata del
menu completo sul display secondario.
Premere il tasto mentre e visualizzata una
schermata di menu o una schermata di menu
completo per tornare alla schermata
precedente.

. Comando SEL/SET (selezione/impostazione)

(comando MENU)

Cambia la selezione di una voce o
unimpostazione nei menu
(pagine 29, 35,41).

. Spia alimentazione +48V

Siillumina in verde se il selettore AUDIO IN e
impostato su MIC ed & fornita alimentazione
phantom a +48V al connettore AUDIO IN. Non
si illumina se non e fornita nessuna
alimentazione phantom.

E possibile attivare o disattivare l'alimentazione
phantom +48 V tramite la voce in categoria
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10.

11.

12.

13.

14.

15.

Audio > Audio Details > Audio Configuration >
Phantom Power +48V nel menu (pagina 49).

Selettore AUDIO IN (selettore audio)

Seleziona il tipo di segnale di ingresso

corrispondente alla sorgente audio collegata al

connettore AUDIO IN.

LINE: Quando si collega una sorgente di
segnale audio analogico esterna

AES/EBU: Quando si collega una sorgente di
segnale audio digitale esterna

MIC: Quando si collega un microfono.

Connettore AUDIO IN (XLR a 5 pin)

Ingresso dei segnali provenienti da
apparecchiatura audio o da microfono esterno.
Se la sorgente audio é stata impostata su LINE
o MIC con il selettore AUDIO IN, questo
connettore svolge la funzione di connettore
AUDIO IN CH-1 e AUDIO IN CH-2.

Se la sorgente audio é stata impostata su AES/
EBU con il selettore AUDIO IN, questo
connettore svolge la funzione di connettore
AUDIO IN CH-3/4.

Tasto BACK

Durante la visualizzazione del menu, annulla
limpostazione del menu e si sposta al livello
superiore nell'albero dei menu. Durante
l'esecuzione o l'attesa di un processo, annulla il
processo in esecuzione o in attesa (pagine

29, 35,41).

Selettore LOCK

Blocca il funzionamento dei tasti sul lato
assistente. Se bloccato, l'indicatore del
selettore e illuminato con luce arancione.

Spia ACCESS (accesso alla scheda SD)
(pagina 23)

Spia REC ACTIVE
Questa spia si illumina con luce verde quando
il tasto REC & abilitato.

16.

Tasto/spia REC (avvio/arresto registrazione)
Premere per avviare la registrazione,
accendendo la spia REC. Premere nuovo per
arrestare la registrazione, spegnendo la spia
REC (pagina 58).

La spia REC lampeggia in caso di errore o
avvertenza.

. Tasto CLIPS

Premere per visualizzare la schermata di elenco
dei clip sul display secondario e permettere la
gestione dei clip (pagina 53).

Per passare dalla modalita di riproduzione alla
modalita di ripresa, premere il tasto HOME.

. Tasto USER

Premere per visualizzare sul display secondario
l'elenco delle funzioni utente ed utilizzare i tasti
ITEM da 1 a 5 come tasti funzione utente.

Il tasto ITEM 6 ¢ il tasto EDIT per l'elenco
funzioni utente. Premere questo tasto per
visualizzare la schermata di selezione delle
funzioni per i tasti funzioni e per i tasti
programmabili. Premere nuovamente, mentre
e visualizzata la schermata delle funzioni
utente, per tornare alla visualizzazione
precedente (pagina 32).

Vista frontale

;‘_f | — —J

. Tasto programmabile ASSIGN 3

(pagina 32)

E possibile assegnare ai tasti ASSIGN varie
funzioni tramite la pagine EDIT della schermata
funzioni utente (pagina 32).

Ogni pressione del tasto attiva o disattiva
oppure abilita la funzione programmata.

. Adattatore attacco obiettivo PL

(pagina 17)

3. Connettore VF (uscita mirino) (pagina 19)

. Connettore LENS (12 pin)

Non supportato nella versione 1.0 del
firmware.

|
2

5. Connettore 24V OUT (DC OUT 24V, Fischer,

3 pin)
Connettore di uscita alimentazione 24 Vicc
(pagina 60).
La tensione di uscita e la corrente di uscita
massima di questo connettore variano a
seconda della tensione in ingresso all'unita. La
corrente massima include anche la corrente di
uscita dal connettore 24V OUT sul pannello
posteriore (pagina 9).
Ingressoda 11Va 17V

Tensione di uscita: 24V

Corrente massima di uscita: 1,0 A

Ingressoda22Va32V
Tensione di uscita: Identica alla tensione in
ingresso
Corrente massima di uscita: 2,0 A
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Vista posteriore

13
12

11

10

. Connettore 24V OUT (DC OUT 24V, Fischer,

3 pin)
Connettore di uscita alimentazione 24 Vcc
(pagina 60).
La tensione di uscita e la corrente di uscita
massima di questo connettore variano a
seconda della tensione in ingresso all'unita. La
corrente massima include anche la corrente di
uscita dal connettore 24V OUT sul pannello
anteriore (pagina 8).
Ingressoda11Vai17V

Tensione di uscita: 24V

Corrente massima di uscita: 1,0 A

Ingressoda22Va32V
Tensione di uscita: Identica alla tensione in
ingresso
Corrente massima di uscita: 2,0 A

2. Connettore 12V OUT (DC OUT 12V, Hirose,
4 pin)
Connettore di uscita alimentazione 12 Vicc
(pagina 60).
La tensione di uscita e la corrente di uscita
massima di questo connettore variano a
seconda della tensione in ingresso all'unita.

Ingressoda11Va 17V

Tensione di uscita: Identica alla tensione in

ingresso

Corrente massima di uscita: 1,0 A
Ingressoda22Va32V

Tensione di uscita: 15V

Corrente massima di uscita: 0,8 A

3. Connettore MONITOR OUT (tipo BNC)

Connettore di uscita del segnale di
monitoraggio HD SDI (pagina 60).

4. Connettore GENLOCK (ingresso genlock)

(tipo BNQ)
Consente l'ingresso di un segnale di
riferimento esterno per sincronizzare in

genlock I'unita con una sorgente esterna
oppure agganciare a una sorgente esterna il
codice temporale dell'unita.

Sono supportati sia segnali digitali che segnali
analogici.

Segnale digitale: Segnale 1.5G HDSDI
interlacciato

Segnale analogico: Sincronizzazione HD,
analogico

. Connettore TC IN (ingresso codice

temporale) (tipo BNC)

Consente l'ingresso di un segnale di
riferimento di codice temporale per
sincronizzare il codice temporale dell'unita su
una sorgente esterna.

. Connettore AUX (LEMO 5 pin)

Emette in uscita il segnale del codice
temporale (pagina 61).

. Connettore REMOTE (telecomando) (8 pin)

Non supportato nella versione 1.0 del
firmware.

. Connettore 12V/24V (ingresso alimentazione

c.c) (pagina 14)

Connettore di ingresso dell'alimentazione c.c.
dell'unita proveniente da una sorgente
esterna. Possono essere utilizzate tensioni di
alimentazionea 12V 024 V.

@
(D@@

N. Segnale

GND

NC

NC

ATw N

DCIN(da11Va17Voppureda22Va
32V)

Terminale di connessione della batteria
(pagina 14)

. Connettori SDI OUT da 1 a 4 (uscita digitale

seriale) (tipo BNC) (pagina 60)

. Aggancio batteria (pagina 14)

. Levetta dirilascio della batteria

(pagina 14)

. Connettore HDMI OUT (pagina 60)
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Vista dall'alto

Vista dal basso
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1. Connettore dispositivo esterno
Non supportato nella versione 1.0 del
firmware.

2. Pulsante di rilascio (pagina 16)

3. Adattatore mirino e maniglia (pagina 16)

4. Fori per viti di montaggio accessori
Tipo di vite: 1/4-20UNC (8)
Tipo di vite: 3/8-16UNC (10)
Lunghezza di inserimento max.: 10 mm
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Apertura ventilazione

1. Fori difissaggio piastra cavalletto
Tipo di vite: 1/4-20UNC (2)
Tipo di vite: 3/8-16UNC (4)
Lunghezza di inserimento max.. 9 mm

2. Coperchio inferiore
Rimuovere le quattro viti a brugola per togliere
il coperchio.

3. Slot per scheda SD (pagina 23)
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1. Descrizione generale: Ubicazione e funzione delle parti

Schermo del mirino

Durante la ripresa (registrazione o standby) e la riproduzione, lo stato e le impostazioni dell'apparecchio
sono visualizzate in sovraimpressione sullimmagine visualizzata sullo schermo del mirino.

Informazioni visualizzate sulla schermata durante la registrazione

l.-II-l l!
(§

10
12

B4
=15
B 16
=7
@18

11
13

24 23 22

1. Indicazione frequenza fotogrammi di
registrazione
Visualizza la frequenza fotogrammi di
registrazione e la frequenza fotogrammi di
progetto.

2. Indicazione angolo o velocita otturatore
Visualizza I'angolo o la velocita dell'otturatore
elettronico.

3. Indicazione filtro ND
Mostra la densita del filtro ND. Il valore
visualizzato e un valore LOG (in base 10)
(pagina 42).
03:1/2
0.6:1/4
0.9:1/8

21

=
(12:34:56:00)) (A001C001 (T Rec ) (X-OCN ST/MPEG 422)) ((TAXS I 120 min [SxS E4 180 mi A 1 9

20

1.2:1/16
1.5:1/32
1.8:1/64
2.1:1/128
24:1/256

Icona del termometro

Visualizzata quando & emesso un messaggio di
avvertenza di alta temperatura.

La descrizione e visualizzata nella categoria
Info del menu.

Icona di avvertenza

Visualizzata quando & emesso un messaggio di
avvertenza diverso dall'avvertenza di alta
temperatura.

La descrizione & visualizzata nella categoria

10.

11.

12.

13.

14.

15.

Info del menu.

Indicazione indice di esposizione
Mostra il valore dell'indice di esposizione (El).

Indicazione temperatura di colore
Visualizza la temperatura di colore e il valore di
Tint del bilanciamento del bianco.

Indicazione informazioni Look
Visualizza il Look selezionato (pagina 43).

Indicazione capacita e tensione della batteria
Visualizza le seguenti informazioni, in base al
tipo di batteria di alimentazione:

Tipo di batteria Indicazione

Capacita residua della
batteria e tempo di
registrazione rimanente

Batteria
InfoLithium

Batteria Anton/
Bauer

Capacita residua della
batteria (%)

Altre batterie  Tensione diingresso

Indicazione VF LUT
Visualizza la LUT del mirino (pagina 43).

Indicazione VF Double Speed Scan

Visualizza lo stato di attivazione della funzione
di raddoppio della frequenza fotogrammi della
visualizzazione sul mirino.

Indicazione VF Peaking
Visualizza lo stato di attivazione della funzione
di peaking nella visualizzazione sul mirino.

Indicazione VF Zebra

Visualizza lo stato di attivazione della funzione
zebra nella visualizzazione sul mirino

(pagina 34).

Indicazione LUT connettori SDI OUT 1/2
Mostra l'impostazione di LUT dei connettori
SDI'OUT 1/2 (pagina 42).

Indicazione LUT connettori SDI OUT 3/4
Mostra l'impostazione di LUT dei connettori
SDI'OUT 3/4 (pagina 42).

16. Indicazione LUT monitor
Mostra I'impostazione di LUT dell'uscita
Monitor (pagina 42).

17. Indicazione HDMI LUT
Mostra l'impostazione di LUT dell'uscita HDMI
(pagina 43).
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18.

19.

20.

Indicazione trigger REC uscita SDI

Visualizza lo stato del trigger REC per l'uscita SDI.

Stato Indicazione
Technical > System Configuration > SDI Rec Remote Comando di registrazione
Trigger nel menu completo sovraimposto sull'uscita
SDI
Off - (Vuoto)
HD SDI Remote I/F Comando Stop In alto: SDI
In basso: Stop
Comando Rec In alto: SDI
In basso: REC
Parallel Rec Comando Stop In alto: SDI-P
In basso: Stop
Comando Rec In alto: SDI-P
In basso: REC

Indicatori di livello audio
Visualizzano i livelli dei canali audio 1 e 2
durante la registrazione.

Indicazione stato e capacita residua del
supporto di registrazione per ciascuno slot
Visualizza lo stato e la capacita residua dei
supporti negli slot per schede di memoria SxS
A/B e negli slot per schede di memoria AXS
A/B.

Lindicazione [ sulla sinistra di "AXS" 0 “SxS”
mostra il supporto di registrazione di
destinazione.

Lindicazione A® in alto a destra sullicona dello
slot A/B a destra di"AXS" 0“SxS"indica il
supporto di memoria specificato per la
riproduzione (se l'indicatore € verde, la
riproduzione & in corso).

Lindicazione A\ viene visualizzata per il
supporto di memoria se si verifica una
condizione negativa per la registrazione.

21.

22.

23.

24,

Indicazione formato di registrazione supporto
(codec)

Visualizza il formato della registrazione su una
scheda di memoria AXS o SxS.

Indicazione dello stato di registrazione
Visualizza i seguenti stati operativi di
registrazione dell'unita.

Indicazione Descrizione

Rec Durante la registrazione

Standby registrazione

Visualizzazione nome clip

Nella modalita di standby di registrazione,
visualizza i primi 8 caratteri del nome del clip in
attesa di registrazione.

Durante la registrazione, visualizza i primi 8
caratteri del nome del clip in corso di
registrazione.

Indicazione dati temporali

Visualizza la durata o il codice temporale, in
base all'impostazione di categoria TC/Media >
TC Display nel menu (pagina 36).

25.

26.

21.

28.

29.

30.

31.

Indicazione posizione diaframma
Visualizza la posizione del diaframma (solo
quando é montato un obiettivo compatibile
con la funzione di visualizzazione
dellimpostazione del diaframma).

Indicazione posizione messa a fuoco
Visualizza la posizione di messa a fuoco (solo
quando é montato un obiettivo compatibile
con la funzione di visualizzazione
dellimpostazione della messa a fuoco).

Indicazione posizione zoom

Visualizza la lunghezza focale dello zoom
(visualizzata solo quando & montato un
obiettivo che supporta l'indicazione
dell'impostazione dello zoom).

Indicazione stato di registrazione simultanea
Nella modalita di registrazione su uno slot,
visualizza il formato di registrazione del clip
secondario (pagina 59).

Indicazione SxS Sub LUT

Nella modalita registrazione simultanea su uno
slot, visualizza l''mpostazione della LUT da
registrare sul clip secondario SxS.

Indicazione SxS LUT
Visualizza l'impostazione della LUT per la
registrazione SxS .

Indicazione delle dimensioni effettive
dellimmagine

Indica le dimensioni effettive dellimmagine e
se e applicata la conversione di
decompressione anamorfica, impostata in
categoria Project > Imager Mode nel menu
(pagina 36).
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Informazioni visualizzate sulla schermata di riproduzione

Le seguenti informazioni vengono visualizzate sullimmagine di riproduzione.

78
o

BAT 120 min

=t e e
1 2 3 4

5

Indicazione dati temporali 6. Indicatori di livello audio
Visualizza la durata o il codice temporale, in Visualizzano i livelli dei canali audio 1 e 2
base allimpostazione di categoria TC/Media > durante la riproduzione.
TC Display nel menu (pagina 36).
piay pag 7. lcona del termometro

Indicazione nome clip in riproduzione Visualizzata quando & emesso un messaggio di
Mostra i primi 8 caratteri del nome del clip in avvertenza di alta temperatura.
riproduzione. La descrizione e visualizzata nella categoria

. . . Info del menu.
Indicazione dello stato della riproduzione
Visualizza lo stato della riproduzione. 8. Iconadiavvertenza

Indicazione formato di riproduzione
supporto (codec)

Visualizza il formato di registrazione (codec)
del clip in riproduzione.

Indicazione supporto di riproduzione
Visualizza il tipo di supporto di registrazione
che viene riprodotto.

Se la scheda di memoria ¢ protetta da scrittura,
sulla destra viene visualizzata l'icona (9.

Visualizzata quando & emesso un messaggio di
avvertenza diverso dall'avvertenza di alta
temperatura.

La descrizione & visualizzata nella categoria
Info del menu.
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2. Operazioni preliminari

Preparazione dell’alimentazione

E possibile utilizzare una batteria o
un‘alimentazione a corrente alternata mediante
adattatore CA.

Per sicurezza, utilizzare esclusivamente i seguenti
pacchi batterie e adattatori CA Sony.

Batteria agli ioni dilitio
BP-FL75
BP-FLX75

Adattatore CA
AC-DN2B
AC-DN10

Utilizzo della batteria

Appoggiare la batteria sull'apposito attacco

dell'adattatore della batteria, quindi spingerla

verso il basso per bloccarla in posizione

(pagina 9).

Per rimuovere la batteria, & necessario sbloccarla

facendola scorrere verso I'alto, mantenendo

premuta allo stesso tempo la levetta di rilascio

della batteria (pagina 9).

[Note]

e Prima dell'uso, caricare la batteria con il caricabatteria.

® Puo non essere possibile ricaricare una batteria
completamente se questa e ancora calda,
immediatamente dopo il suo utilizzo.

e Rimuovere |'adattatore della batteria afferrando
saldamente ['unita con la mano.

(Controllo della carica residua della batteria

Durante la registrazione o la riproduzione con
alimentazione a batteria, nel display secondario
(pagina 27) e nel mirino (pagina 11) viene
visualizzata un’icona che indica la durata residua e
la tensione erogata dalla batteria.

L'unita indica la durata residua in minuti,
calcolando il tempo disponibile sulla base del
consumo attuale della batteria in modalita
operativa.

Se il livello di carica della batteria residua scende

Se, durante I'utilizzo, la carica residua della batteria
si riduce fino a raggiungere un determinato livello,
I'indicatore della carica residua della batteria e

la spia REC cominciano a lampeggiare come
avvertimento.

Se il livello di carica residua scende oltre un certo
valore e non & piu possibile mantenere acceso

il dispositivo, viene visualizzato un messaggio di
batteria esaurita.

Sostituire la batteria con un’altra batteria
completamente carica.

Per modificare i livelli dei messagq

Modificare i livelli con la voce Technical > Battery
(pagina 50) nel menu completo.

Utilizzo dell'alimentazione CA
(alimentazione DC IN)

L'unita pud essere alimentata anche a corrente
alternata utilizzando un adattatore modello AC-
DN10 (opzionale) o AC-DN2B (opzionale) e il cavo
CCDD-X2 DC (opzionale).

Sono supportate tensioni in ingresso comprese fra
11Vel7Vefra22Ve32V.

[Nota]

Passando all'alimentazione DC IN durante il funzionamento
a batteria, assicurarsi che I'alimentazione utilizzata abbia una
tensione compresa fra 12Ve 17V oppure 22V e 32 V.
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Impostazione dell'orologio

Alla prima accensione dell'unita viene visualizzata
sul display secondario la schermata delle
impostazioni iniziali.

Utilizzare questa schermata per impostare data e
ora nell'orologio incorporato.

FUso orario

Il valore indica la differenza di orario rispetto
all'UTC (Coordinated Universal Time). Modificare le
impostazioni, se necessario.

[Nota]

Cambiando il valore di Time Zone, cambieranno in base alla
differenza oraria anche le impostazioni dell‘orologio.

Impostazione della data e dell'ora

Ruotare il comando MENU (pagina 7) per
spostare il cursore, quindi premere il comando
MENU per impostare ciascuna voce di menu.

Al termine, salvare le impostazioni dell'orologio
spostando il cursore su“Set”e premendo il
comando MENU. La schermata di impostazione
scompare.

Se necessario, & possibile modificare in seguito le
impostazioni di Time Zone e orologio anche dopo
la scomparsa della schermata delle impostazioni
iniziali utilizzando la voce Maintenance > Clock Set
(pagina 51) nel menu.

[Note]

® Se le impostazioni dell'orologio vengono perdute
in seguito all'esaurimento della batteria di riserva
mentre il dispositivo non e collegato ad altro sistema
di alimentazione (batteria o collegamento CC IN), verra
visualizzata la schermata delle impostazioni iniziali alla
successiva riaccensione dell'unita.

e Mentre viene visualizzata la schermata delle impostazioni
iniziali, non & possibile eseguire alcuna operazione ad
eccezione dello spegnimento finché limpostazione di tale
schermata non viene completata.
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Montaggio di adattatore mirino e maniglia

Montaggio dell'adattatore del mirino Montaggio della maniglia
] Per il montaggio, inserire e fare scorrere 1 Per il montaggio, inserire e fare scorrere la
I'adattatore del mirino della direzione indicata maniglia nella direzione indicata dalla freccia.
dalla freccia.
2 Spostare la maniglia nella posizione
2 Spostare |'adattatore del mirino nella posizione longitudinale desiderata, quindi ruotare la
longitudinale desiderata, quindi ruotare la levetta di blocco per fissarlo in tale posizione.

levetta di blocco per fissarlo in tale posizione.

Vite a testa
esagonale

Vite di blocco

Levetta di

blocco
[Nota] (Note]
L'adattatore del mirino pud essere montato sia e E ppssibile ﬁssare_la maniglia in posizione anche
longitudinalmente che trasversalmente. utilizzando una vite a brugola da 5 mm.
® Se lalevetta di blocco si allenta durante I'uso, &
. . , . possibile fissare la maniglia stringendo la vite a
Rimozione dell'adattatore del mirino brugola (2 mm) accanto alla vite di blocco.
e Lamaniglia pud essere montata anche in senso
Sbloccare I'adattatore del mirino ruotando la inverso.
levetta, premere il pulsante di rilascio e sfilare
I'adattatore del mirino nella direzione opposta a Rimozione della manigHa

quella diinserimento.
Sbloccare la maniglia ruotando la levetta di blocco,
premere il pulsante di rilascio e sfilare la maniglia
nella direzione opposta a quella di inserimento.
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2. Operazioni preliminari

Montaggio di un obiettivo e regolazione della lunghezza focale di flangia

Ottiche raccomandate (Super 35mm)

SCL-PK6/F, SCL-PK6/M (set di 6 obiettivi, 20 mm/
25 mm/35 mm/50 mm/85 mm/135 mm)
SCL-PK3/F, SCL-PK3/M (set di 3 obiettivi, 20 mm/
25 mm/135 mm)

SCL-P11X15

Per informazioni sulle ottiche disponibili, rivolgersi a un
rappresentante di assistenza Sony.

[ATTENZIONE]

Non lasciare gli obiettivi esposti direttamente alla
luce solare. La luce solare diretta condotta dalle
ottiche puo mettersi a fuoco all'interno dell'unita e
causare incendi.

[Note]

e Gliobiettivi sono componenti di elevata precisione. Non
appoggiare mai l'obiettivo su una superficie con l'attacco
rivolto verso il basso. Montare sempre il coperchietto
fornito con l'obiettivo.

e |'interfaccia dell'obiettivo dell'unita & configurata, per
impostazione predefinita, su SCL-P11X15 e obiettivi con
connettore tipo Cooke. Per utilizzare obiettivi modello
SCL-PK6 o SCL-PK3, oppure altre ottiche che non sono
dotate di connettore tipo Cooke, impostare Technical
> System Configuration > Lens Interface (pagina 50)
su Off nel menu completo. Se questa impostazione non
& corretta, viene visualizzato un messaggio di avviso
quando si accende l'unita dopo aver montato l'obiettivo.

Montaggio di un obiettivo con
attacco PL

] Rimuovere il coperchio dall'attacco
dell'obiettivo ruotando la levetta dell'attacco
PL in senso antiorario.

Levetta
attacco PL

[Nota]
Ruotare la levetta dell'attacco PL in senso antiorario fino
alla posizione di arresto.

2 Inserire l'obiettivo nell'attacco allineando il
recesso dell'obiettivo con il pernetto di
riferimento in alto a destra sull'attacco
dell'obiettivo.

3 Fissare l'obiettivo ruotando la levetta
dell'attacco PL in senso orario, sostenendo
l'obiettivo con la mano.

[Nota]

Non ruotare l'obiettivo quando si inserisce l'attacco per
obiettivo PL. In caso contrario si potrebbe danneggiare il
perno della slitta di contatto a caldo.

Montaggio di un obiettivo Cooke /i

Allineare i contatti dell'obiettivo con la slitta a
caldo dell'unita. Sul lato dell'adattatore sono
presenti due connettori, ciascuno dei quali pud
essere utilizzato indifferentemente.

Rimozione dell'obiettivo

] Ruotare la levetta dell'attacco PL in senso
antiorario sostenendo l'obiettivo da sotto.

2 Tirare l'obiettivo in avanti.

[Note]

® Se non viene montato un altro obiettivo
immediatamente, montare il coperchietto di
protezione allineandone il recesso con cura,
quindi bloccare il coperchietto ruotando la levetta
dell'attacco PL in senso orario.

e Nella versione 1.0 del firmware, le immagini non
verranno emesse in uscita normalmente se viene
rimosso I'adattatore di attacco PL.

Regolazione della lunghezza focale di
flangia

L'unita viene fornita con la lunghezza focale di
flangia gia registrata. Se dovesse essere necessario
regolare ulteriormente la lunghezza focale di
flangia, rimuovere |'attacco obiettivo e sostituire
gli spessori con altri delle dimensioni desiderate.
Lo spessore e regolabile da -0,1 a +0,1 mm in
incrementi di 0,01 mm.

Spessori

Con l'unita sono forniti i seguenti spessori:

0,05 mm x 1 (circolare)

0,01 mm x 15 (1/3 di arco)

Gli spessori da 1/3 di arco devono essere sempre
utilizzati in gruppi di 3. Aggiungere spessori per
aumentare la lunghezza focale di flangia. Lunita
viene fornita con la lunghezza focale flangia gia
regolata utilizzando i seguenti tre tipi di spessori:
0,10 mm (circolare)

0,05 mm (circolare)

0,01 mm (1/3 di arco)

Lo spessore di regolazione alla spedizione &
indicato da un adesivo.
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Regolazione della lunghezza focale di flangia

] Svitare le sei viti Torx e rimuovere la flangia
dell'attacco PL.

2 Allentare le quattro viti Phillips sui due lati dei
connettori PL (due posizioni) e rimuovere i
connettori PL e le piastre di connessione PL.

3 Collocare gli spessori sull'adattatore
dell'attacco PL (tre posizioni).

connessione PL

Utilizzo di spessori da 1/3 di arco
Utilizzare sempre spessori identici nelle tre
posizioni.

{

Spessori

Utilizzo di spessori circolari
Montare con la superficie in cui sono presenti
marcature rivolta in avanti.

Marcature

{

Marcature

4 Rimontare i connettori PC (due posizioni) nelle
loro posizioni originali e serrare le quattro viti
Phillips a una coppia di 0,18 N-m.

5 Rimontare la flangia dell'attacco PL nella sua
posizione originale e serrare le sei viti Torx a
una coppia di 0,35 N-m utilizzando una chiave
dinamometrica T8.

Pulizia del filtro

Per poter pulire il filtro € necessario rimuovere
prima I'adattatore. Pulire la parte centrale
dell'adattatore (in grigio nella figura) con un panno
0 altro materiale adatto prestando attenzione

che fibre e peluzzi non aderiscano alle superfici.
Rimuovere eventuali fibre aderite alle superfici con
un pennello morbido.

Adattatore
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Montaggio di un mirino

Mirini disponibili
DVF-EL200: Mirino a colori OLED
DVF-L700: Mirino a colori LCD

Fermacavo

Montaggio di un mirino C Regolazione della posizione del

mirino

] Allineare la slitta del mirino con la
corrispondente sede sull'attacco

I mirini sono disponibili separatamente. = At
dell'adattatore mirino, quindi inserire il mirino.

Questa sezione descrive, come esempio, il
montaggio di un mirino DVF-EL200.

Regolazione della posizione longitudinale

2 Ruotare la levetta di blocco del mirino nella
direzione LOCK per bloccarlo in posizione.

1 Allentare una o entrambe le levette di blocco
dell'asta longitudinale dell'adattatore del
mirino.

Per informazioni dettagliate sul montaggio di ciascun modello
di mirino, fare riferimento alle relative Istruzioni per I'uso.

[ATTENZIONE]

Non lasciare mai I'unita con le ottiche del mirino
rivolte in direzione del sole. La luce solare diretta
potrebbe attraversare l'oculare, venire focalizzata
nel mirino e provocare un incendio.

2 Spostare in avanti o indietro I'adattatore del
mirino fino a trovare la posizione desiderata
per il mirino.

40— |evettadi

"
LS&‘

V%,

[Note]

e Montare e smontare il mirino solo mentre l'unita & spenta.

® || montaggio del mirino DVF-L700 richiede I'utilizzo di
un cavo VF di connessione (A-2201-632 o A-2201-633-A).
Assicurarsi inoltre di accendere I'unita solo dopo aver
spostato su ON l'interruttore POWER del mirino DVF-L700.

[Nota]
Fissare il cavo nel fermacavo secondo le proprie
esigenze.

Rimozione del mirino

1 Scollegare il cavo VF di connessione dal mirino
e dall'unita.

Q / ‘ Levette di
QQ 0 g ) W b‘\egcecoeas‘ta
\ &

2 Ruotare la levetta di blocco in senso opposto a
LOCK, quindi sfilare il mirino dall’adattatore del
mirino.

3 Collegare il mirino all’'unita utilizzando il cavo
VF di connessione.

Lato mirino:

Inserire completamente il connettore
assicurandosi che l'indicatore rosso del
connettore stesso sia rivolto verso l'alto.

Lato videocamera:

Inserire completamente il connettore
assicurandosi che il recesso del connettore sia
allineato con l'indicatore rosso.

3 Stringere le levette di blocco dell'asta.

[Nota]

Se risultasse difficile ruotare una levetta di blocco
dell'asta, & possibile estrarla, ruotarla nella posizione
desiderata e quindi reinserirla.
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2. Operazioni preliminari: Montaggio di un mirino

Regolazione della posizione laterale e dell'altezza
(angolo)

1 Allentare la levetta di blocco asta che si trova

nella parte anteriore dell'adattatore del mirino.

2 Regolare la posizione del mirino facendo
scorrere trasversalmente l'asta dell’adattatore
e/o ruotandola verso I'alto o il basso.

Levetta di
blocco asta

3 Stringere la levetta di blocco dell'asta.

[Nota]

Se la levetta di blocco si allenta, & possibile evitare la
possibile caduta del mirino stringendo la vite di blocco
con una chiave a brugola (3 mm).

Regolazione dell'angolazione del mirino

E possibile regolare I'angolazione del mirino anche
durante la ripresa.

1 Allentare la levetta di blocco della rotazione
dell'attacco del mirino.

2 Regolare la posizione del mirino verso l'alto o il
basso secondo le proprie esigenze.

Levetta di blocco della rotazione

3 Stringere la levetta di blocco della rotazione.
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2. Operazioni preliminari

Utilizzo di schede di memoria SxS

Questa unita registra audio e video su schede di
memoria SXS (opzionali) inserite negli appositi slot.

Informazioni sulle schede di memoria
XS

Utilizzare le schede di memoria SxS o XQD Sony

indicate di sequito.*
* Lutilizzo di schede di memoria XQD richiede I'adattatore
XQD ExpressCard (QDA-EX1).

Le schede di memoria supportate variano a
seconda del formato di registrazione.

SxS PRO+
SBP-256D, SBP-128B/C/D, SBP-64B/C/D: Supportate
per tutti i formati di registrazione.

X5 PRO
SBP-64A, SBP-32:
MPEG 1920x1080P/i

SxS-1
SBS-64G1A/B, SBS-32G1A/B:
MPEG 1920x1080P/i

Scheda di memoria XQD serie S, serie G

QD-S64E, QD-S32E, QD-G128A/E, QDGE4A/E,
QD-G32A/E: Supportate per tutti i formati di
registrazione.

Scheda di memoria XQD serie N, serie M
QD-N64, QD-M128A, QD-M64A, QD-M32A:
MPEG 1920x1080P/i

Il funzionamento non & garantito con altre schede
di memoria.
Le schede di memoria sono conformi allo standard
ExpressCard.

Per dettagli sull'uso delle schede di memoria SxS e delle relative
precauzioni d'uso, consultare il manuale di istruzioni della
scheda di memoria SxS.

® SxS, SxS PRO e SxS-1 sono marchi di fabbrica di
Sony Corporation.

® XQD & un marchio di Sony Corporation.

® || marchio e il logo ExpressCard sono di
proprieta di Personal Computer Memory Card
International Association (PCMCIA) e sono
concessi in licenza a Sony Corporation. Gli altri
marchi di fabbrica sono da ritenersi proprieta dei
rispettivi proprietari.

Inserimento di una scheda di
memoria Sx5

Rimozione di una scheda di memoria
XS

] Aprire il coperchio del blocco degli slot delle
schede (pagina 7).

2 Inserire la scheda di memoria SxS nello slot
con l'etichetta SxS rivolta verso destra.
La spia ACCESS (pagina 6) si illumina in
rosso quindi cambia in verde una volta che la
scheda di memoria e pronta per I'utilizzo.

3 Chiudere il coperchio.

Stato della spia ACCESS

Gli slot delle schede A e B sono dotati di una spia
ACCESS che ne indica lo stato.

Spia Stato dello slot

Accesso alla scheda di
memoria SxS (scrittura/
lettura dei dati)

Rossa

Verde Standby (la videocamera e
pronta per la registrazione o
la riproduzione mediante la
scheda di memoria SxS)

Spenta ® Non e inserita nessuna

scheda di memoria SxS.

® |ascheda di memoria SxS
inserita non e valida.

e [ inserita una scheda
di memoria SxS, ma é
selezionato I'altro slot.

] Aprire il coperchio del blocco degli slot delle
schede.

2 Estrarre la scheda di memoria SxS.

[Nota]

Non é possibile garantire l'integrita dei dati qualora
I'alimentazione venga interrotta o la scheda di memoria
venga rimossa durante l'accesso alla scheda stessa. | dati
presenti sulla scheda possono andare perduti. Controllare
sempre che la spia ACCESS della scheda di memoria sia
illuminata con luce verde o sia spenta prima di spegnere la
videocamera o rimuovere la scheda di memoria.

Passaggio da una scheda di memoria
xS all'altra

Quando sono presenti schede di memoria SxS sia
nello slot A che nello slot B, e possibile selezionare
la scheda di memoria SxS da utilizzare premendo il
tasto SLOT SELECT(pagina 7).

Se una scheda e piena, la registrazione continua
dopo la commutazione automatica sulla seconda
scheda.

[Nota]

Il tasto SLOT SELECT e disattivato durante la riproduzione o
la registrazione. Anche se viene premuto il tasto, l'operazione
non passa all'altra scheda.
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2. Operazioni preliminari: Utilizzo di schede di memoria SxS

Formattazione (inizializzazione) di
schede di memoria Sx5

Se viene inserita una scheda di memoria SxS non
formattata o formattata con un sistema diverso,
viene visualizzato un messaggio che segnala che
la scheda e formattata con un file system diverso.
In questo caso, formattare la scheda di memoria
come descritto di seguito.

] Selezionare categoria TC/Media > Format
Media nel menu.

2 Selezionare SxS Slot A (slot A) o SxS Slot B (slot
B), quindi premere il comando MENU.
Viene visualizzata una schermata di conferma
della formattazione.

3 Per eseguire la formattazione, premere e
mantenere premuti i tasti ITEM 1 e ITEM 3 per
3 secondi.
La formattazione si avvia, durante l'esecuzione
viene visualizzato un messaggio e la spia
ACCESS siillumina con luce rossa.
Al termine della formattazione viene
visualizzato un messaggio di conferma.
Premere il comando MENU per chiudere il
messaggio.

Se la formattazione non riesce

Non e possibile formattare schede di memoria
SXS protette da scrittura o schede di memoria non
utilizzabili con questa unita.

Viene visualizzato un messaggio di avvertimento.
Sostituire la scheda con una scheda di memoria
SXS appropriata, seguendo le istruzioni contenute
nel messaggio.

[Nota]

Tutti i dati, incluse le immagini registrate e i file di

installazione, vengono cancellati quando la scheda di
memoria viene formattata.

Formattazione durante la registrazione

E possibile formattare una scheda di memoria SxS
anche durante la registrazione purché sia inserita
nello slot non utilizzato per la registrazione.

Controllo del tempo di registrazione
rimanente

Durante le riprese (registrazione o standby), &
possibile controllare la capacita residua delle
schede di memoria SxS inserite in ciascuno

slot utilizzando l'indicazione della capacita
residua del supporto di registrazione visualizzata
sulla schermata Home del display secondario
(pagina 27) o sullo schermo del mirino

(pagina 11).

Il tempo di registrazione residuo disponibile

nel formato video corrente (frequenza di bit di
registrazione) viene calcolato in base allo spazio
rimanente su ciascuna scheda e viene visualizzato
in unita di tempo (minuti).

[Nota]

Se la scheda di memoria e protetta da scrittura, viene
visualizzata licona (3}

Sostituzione di una scheda di memoria SxS

® Se, durante la registrazione, lo spazio totale
rimanente sulle schede inserite scende al di
sotto di 5 minuti, l'indicazione della capacita
residua del supporto di registrazione e la spia
REC lampeggiano. Viene inoltre emesso un
segnale acustico di avvertimento. Sostituire
le schede con altre che dispongano di spazio
sufficiente.

® Se si continua la registrazione, all'esaurimento
del tempo totale di registrazione, apparira il
messaggio “Media Full”e la registrazione si
arresta.

[Nota]

E possibile registrare circa 600 clip su una singola scheda di
memoria SxS.

Al raggiungimento del limite massimo di clip consentito, il
tempo di registrazione rimanente indichera “0" ed apparira il
messaggio “Media Full”

Ripristino di una scheda di memoria
XS

Qualora si verifichi un errore su una scheda di
memoria, la scheda dovra essere ripristinata prima
di poterla utilizzare nuovamente.

Se viene caricata una scheda di memoria SxS
che necessita il ripristino, il display secondario
visualizzera un messaggio che ne richiede
I'esecuzione.

Per avviare la procedura di ripristino, selezionare
Execute ruotando il comando MENU, quindi
premere il comando MENU.

Il ripristino si avvia.

Durante l'esecuzione, viene visualizzato un
messaggio e la spia ACCESS si illumina con luce
rossa.

Al termine del ripristino viene visualizzato un
messaggio di conferma. Premere il comando
MENU per chiudere il messaggio.

Se il ripristino non riesce

® Non e possibile ripristinare schede di memoria
SXS protette da scrittura o per le quali si e
verificato un errore. Per tali schede, viene
visualizzato un messaggio di avvertenza.
Disattivare la protezione della scrittura o
sostituire la scheda seguendo le istruzioni
contenute nel messaggio.

e Riformattando le schede di memoria SxS sulle
quali si e verificato un errore & possibile che
divengano nuovamente utilizzabili.

® |n alcuni casi, potranno essere ripristinati solo
alcuni clip e non altri. | clip ripristinati diventano
nuovamente riproducibili.
® | a procedura indicata di seguito potrebbe
consentire il ripristino di schede di memoria
SXS per le quali viene visualizzato il messaggio
“Could not Restore Some Clips”ad ogni tentativo
di avvio del processo di ripristino.
[1] Copiare i clip desiderati su un‘altra scheda
di memoria SxS.
[2] Formattare sull'unita la scheda di memoria
SxS non utilizzabile.
[3] Copiare nuovamente i clip desiderati sulla
scheda di memoria SxS appena formattata.
[4] Aggiornare il file di gestione come
descritto di seguito.

[Nota]

Per il ripristino dei supporti, utilizzare sempre lo stesso
apparecchio utilizzato per registrarli.

Questo apparecchio non consente di ripristinare supporti
registrati con apparecchi diversi o con apparecchi di versione
diversa (anche se dello stesso modello).

Aggioramento del file di gestione

Se non é possibile riprodurre i clip,
I'aggiornamento del file di gestione sulla scheda
potrebbe migliorare la situazione.

Per aggiornare il file di gestione, utilizzare la voce
Use TC/Media > Update Media (pagina 45) nel
menu completo.

Se si copia un file XAVC importato da RAW Viewer
V2.2 o successivo nella directory “XDROOT\Clip”
di una scheda di memoria SxS direttamente, e
possibile rendere riproducibile il file eseguendo
Update Media.
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2. Operazioni preliminari

Utilizzo di schede SD per il salvataggio dei dati di configurazione

| file di configurazione della videocamera possono
essere salvati su una scheda SD (opzionale). Il
file memorizzato sulla scheda SD pud essere
successivamente caricato sulla videocamera.

Rimozione di una scheda di memoria
SD

Schede SD supportate

Schede di memoria SDHC* (Speed Class:da 4 a 10,

non UHS, Capacita: da 2 a 32 GB)

Schede di memoria SD* (File system: FAT 16,

Capacita: fino a 2 GB)

* Indicate collettivamente come “schede SD"in questo
manuale.

Inserimento di una scheda SD

Inserire una scheda SD nell'apposito slot
(pagina 10).

La spia ACCESS (pagina 8) si illumina prima in
rosso e quindi in verde non appena la scheda di
memoria e pronta per |'utilizzo.

Stato della spia ACCESS

Spia Stato dello slot
Rossa Accesso alla scheda SD
(scrittura/lettura dei dati)
Off ® Nessuna scheda SD
caricata.

® [ ascheda di memoria
SxS caricata non e
valida.

Premere leggermente la scheda SD, quindi
rimuoverla.

[Note]

® Non & possibile garantire I'integrita dei dati qualora
I'alimentazione venga interrotta o la scheda di memoria
venga rimossa durante |'accesso alla scheda stessa. | dati
presenti sulla scheda possono andare perduti. Controllare
sempre che la spia ACCESS della scheda di memoria sia
illuminata con luce verde o sia spenta prima di spegnere
la videocamera o rimuovere la scheda di memoria.

® Assicurarsi che la scheda di memoria non salti fuori dallo
slot al momento dell'inserimento o estrazione.

Formattazione (inizializzazione) di
una scheda SD

Le schede SD devono essere formattate prima di
poterle utilizzare sull'unita.

Le schede SD da utilizzare con questa unita
devono essere formattate con la funzione di
formattazione dell’'unita stessa. Inoltre, & necessario
formattare una scheda di memoria SD anche nel
€aso in cui venga visualizzato un messaggio di
avvertenza al momento del suo inserimento.

Se viene inserita una scheda SD formattata con
un formato non supportato, verra visualizzato un
messaggio che segnala che il file system non e
compatibile.

] Selezionare categoria TC/Media > Format
Media > SD Card nel menu, quindi premere il
comando MENU.

Viene visualizzata una schermata di conferma
della formattazione.

2 Per eseguire la formattazione, premere e
mantenere premuti i tasti ITEM 1 e I[TEM 3 per
3 secondi.
La formattazione si avvia, durante l'esecuzione
viene visualizzato un messaggio e la spia
ACCESS si illumina con luce rossa.
Al termine della formattazione viene
visualizzato un messaggio di conferma.
Premere il comando MENU per chiudere il
messaggio.

[Nota]

La formattazione di una scheda SD ne elimina tutti i dati, che
non potranno piu essere recuperati.

Utilizzo di supporti di memoria formattati con
questo apparecchio negli slot di altri dispositivi

Eseguire un backup del supporto e quindi
formattarlo con I'altro dispositivo.
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2. Operazioni preliminari

Abbinamento con il registratore AXS-R7

Montando sull’'unita un registratore opzionale
AXS-R7 AXS: (Access Memory Card System), &
possibile utilizzarlo per registrare video ed audio in
formato RAW o X-OCN.

[Nota]

Aggiornare il registratore AXS-R7 alla versione 1.1 prima di
montarlo sull'unita. Dopo I'aggiornamento della versione,
rimuovere il modulo di docking dal registratore AXS-R7 e
montare il registratore AXS-R7 sull'unita. Per informazioni
dettagliate sull'aggiornamento del registratore AXS-R7, fare
riferimento alla Guida all'aggiornamento del registratore
stesso.

Montaggio del registratore AXS-R7

[Notal
Montare o smontare il registratore AXS-R7 solo con l'unita
spenta.

1 Svitare le quattro viti a testa esagonale (3 mm)
sulla parte posteriore dell'unita e rimuovere la
piastra della batteria.

Piastra della
batteria

2 Svitare le quattro viti a testa esagonale sulla
parte posteriore del registratore AXS-R7 e
rimuovere il modulo di docking dal
registratore.

Modulo di docking

3 Montare il registratore AXS-R7 sull’'unita e
stringere le quattro viti a testa esagonale.

Rimozione del registratore AXS-R7

Svitare le quattro viti a testa esagonale e rimuovere
il registratore AXS-R7.

Inserimento di una scheda di
memoria AXS

Rimozione di una scheda di memoria
AXS

] Premere il coperchietto dello slot della scheda
di memoria per aprirlo.

2 Inserire la scheda di memoria AXS nel suo slot

con l'etichetta rivolta come indicato di seguito.

Etichetta

3 Chiudere il coperchietto.

Aprire il coperchietto dello slot della scheda di
memoria AXS del registratore AXS-R7 ed estrarla.

[Nota]

Non e possibile garantire l'integrita dei dati qualora
I'alimentazione venga interrotta o venga rimossa una scheda
di memoria AXS durante I'accesso alla scheda stessa. | dati
presenti sulla scheda possono andare perduti. Controllare
sempre che la spia ACCESS della scheda di memoria sia
illuminata con luce verde o sia spenta prima di spegnere la
videocamera o rimuovere la scheda di memoria.

Registrazione su una scheda di
memoria AXS

Scegliere il formato di registrazione sulla scheda di
memoria AXS tramite la voce di categoria Project >
AXS Rec Format (pagina 36) nel menu,

[Nota]

La scheda di memoria AXS nellAXS-R7 non passa
automaticamente alla seconda scheda, anche se la scheda si
riempie durante la registrazione. Per passare da una scheda
all'altra, premere il tasto SLOT SELECT del registratore AXS-R7
durante la modalita standby di registrazione.
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2. Operazioni preliminari: Abbinamento con il registratore AXS-R7

Formattazione (inizializzazione) di
una scheda di memoria AXS

Le schede di memoria AXS devono essere
formattate prima di poterle utilizzare con il
registratore AXS-R7 montato sull'unita.
Utilizzare la funzione di formattazione dell'unita
per formattare le schede di memoria AXS da
utilizzare con il registratore AXS-R7. Inoltre, la
scheda di memoria AXS deve essere formattata
anche nel caso in cui viene visualizzato un
messaggio di avvertenza quando viene accesa
I'unita con il registratore AXS montato.

Se e inserita una scheda di memoria AXS
formattata in un formato non supportato

dal registratore AXS-R7, verra visualizzato un
messaggio che segnala che il file system non &
compatibile.

1 Selezionare categoria TC/Media > Format
Media nel menu, quindi premere il comando
MENU.

2 Selezionare AXS Slot A (slot A) o AXS Slot B
(slot B).
Viene visualizzata una schermata di conferma
della formattazione.

3 Per eseguire la formattazione, premere e
mantenere premuti i tasti [TEM 1 e ITEM 3 per
3 secondi.
La formattazione si avvia, durante l'esecuzione
viene visualizzato un messaggio e la spia
ACCESS siillumina con luce rossa.
Al termine della formattazione viene
visualizzato un messaggio di conferma.
Premere il comando MENU per chiudere il
messaggio.

[Nota]

Quando si formatta una scheda, tutti i dati vengono eliminati
€ non potranno essere recuperati.

Controllo del tempo di registrazione
rimanente

Durante le riprese (registrazione o standby), &
possibile controllare la capacita residua di una
scheda di memoria AXS inserita utilizzando
l'indicazione della capacita residua del supporto
di registrazione, visualizzata sulla schermata Home
del display secondario (pagina 27) o sullo
schermo del mirino (pagina 11).

Il tempo di registrazione residuo disponibile

nel formato video corrente (frequenza di bit di
registrazione) viene calcolato in base allo spazio
rimanente su ciascuna scheda e viene visualizzato
in unita di tempo (minuti).

[Nota]

Se la scheda di memoria AXS é protetta da scrittura, viene
visualizzata licona (3,

Ripristino di una scheda di memoria
AXS

Qualora si verifichi un errore su una scheda di
memoria, la scheda dovra essere ripristinata prima
di poterla utilizzare nuovamente.

Se viene caricata una scheda di memoria AXS
che necessita il ripristino, verra visualizzato un
messaggio che ne richiede l'esecuzione.

Per avviare la procedura di ripristino, selezionare
Execute ruotando il comando MENU, quindi
premere il comando MENU.

Il ripristino si avvia.

Durante l'esecuzione, viene visualizzato un
messaggio e la spia ACCESS si illumina con luce
rossa.

Al termine del ripristino viene visualizzato un
messaggio di conferma. Premere il comando
MENU per chiudere il messaggio.

Se il ripristino non riesce

® Non e possibile ripristinare schede di memoria
AXS protette da scrittura o per le quali si &
verificato un errore. Per tali schede, viene
visualizzato un messaggio di avvertenza.
Disattivare la protezione della scrittura o
sostituire la scheda seguendo le istruzioni
contenute nel messaggio.

® Riformattando le schede di memoria AXS sulle
quali si e verificato un errore & possibile che
divengano nuovamente utilizzabili.

® |n alcuni casi, potranno essere ripristinati solo
alcuni clip e non altri. | clip ripristinati diventano
nuovamente riproducibili.

[Nota]

Per il ripristino dei supporti, utilizzare sempre lo stesso
apparecchio utilizzato per registrarli.

Questo apparecchio non consente di ripristinare supporti
registrati con apparecchi diversi o con apparecchi di versione
diversa (anche se dello stesso modello).

Aggiornamento del file di gestione

Se non é possibile riprodurre i clip,
I'aggiornamento del file di gestione sulla scheda
potrebbe migliorare la situazione.

Per aggiornare il file di gestione, utilizzare la voce
Use TC/Media > Update Media (pagina 45) nel
menu completo.
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3. Utilizzo della videocamera

Display secondario

Il display secondario visualizza la schermata Home, la schermata di riproduzione, la schermata del menu, la schermata del menu completo e la schermata delle

funzioni utente.

Per passare da una schermata all‘altra sullo display secondario, utilizzare i tasti sul lato assistente dell'unita.

é Y
Schermata delle funzioni utente
1 2 User 3
SDI Frame Line Monitor Monitor
Status Info LUT bypass
On On Off
00:00:00:00
Off Auto
Monitor Fan Mode
Highlight Clip Ind
User 4 User 5
\ S

Tasto HOME

Tasto USER

Tasto MENU

Fixed-24 50

Schermata Home

FPS El Shutter

90.0

7c600:00:00:00 2398

DCIN 15.0V/ A001 Co04

Isxs [ 120 min  XAVC QFHD C480

S B 180min 132

1.8 o: Look | 3900+03

WwB

Tasto USER

Tasto CLIPS

Tasto HOME

Tasto CLIPS

Tasto HOME

Schermata elenco dei clip

/A001C001_180101CQ
A001C002_180101G7
A001C003_180101HR
/A001C004_180101WK
‘A001C005_180101S8
A001C006_180101GF

3

Schermata di riproduzione

F Rev

<<« >
bur 00:00:00:00 23.98fps 3.8K 16:9
»» x24 DCIN 15.0V FPS 60
SXS @ 002/010 XAVC QFHD C480
A001C002_160328WW &

<<

Tasto MENU

Tasto MENU

Tasto CLIPS

Schermata menu

Project TC/Media
Imager Mode 4K 17:

Project Frame Rate

Monitoring

Color Space

AXS Rec Format
SxS Rec Format

Sub Rec Format

Audio

Schermata menu completo

Project Shutter

TC/Media ND
Monitoring Exposure Index
Audio

Technical

White Balance
LUT Select
Look

GO HMEE

Maintenance

Tasto USER
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Schermata Home

Premere il tasto HOME sul lato assistente per visualizzare la schermata Home. La schermata Home
consente di controllare lo stato dell'unita e configurarne le principali impostazioni.

r FPS

Nome voce/Valore
impostazione/Area
visualizzazione
funzione

1.8

Nome voce/Valore impostazione/Area
visualizzazione funzione

fasto [TEM 1 fasto ITEM 2 fasto ITEM 3
1 2 3

1cG00:00:00:00 23.98fps 3.8K 16:9
DC IN 15.0V A001 C004

XAVC QFHD €480

I sxs 120 min
sxs B i

4 5 6
o o o

Tasto ITEM 4 Tasto ITEM 5 Tasto [TEM 6

Fixed—24 50

TcG00:00:00:00 23.98fps

DCIN 15.0V
| sxs 120 min
SxS B 180 min
SDI 3/4: Look
SxS: Log

El Shutter

90.0

3.8K 16:9 ==
A001 co04 ==
XAVC QFHD C480 Aread
visualizzazione
stato

3200+03
WB

[Nota]

Le zone indicate con i numerida 1 a 6 si riferiscono ai
corrispondenti tasti ITEM da 1 a 6 (pagina 32). Premere

un tasto ITEM per selezionare la voce corrispondente. | tasti
ITEM per le funzioni visualizzate in arancione sono abilitati.
La selezione del valore di FPS tramite il tasto ITEM 1 non &
supportata nella versione 1.0 del firmware.

1. FPS
Mostra la frequenza fotogrammi video.

2. Exposure Index

Visualizza e imposta l'indice di esposizione (El).

3. Shutter
Visualizza e imposta angolo o velocita
dell'otturatore elettronico.

4. ND Filter
Visualizza e imposta la posizione del filtro ND.
5. LWUT

Visualizza e imposta la monitor LUT.

6. WB (White Balance)
Visualizza e imposta il bilanciamento del
bianco.

Area di visualizzazione stato

1. Indicazione dati temporali
Visualizza la durata o il codice temporale, in
base allimpostazione di categoria TC/Media >
TC Display nel menu (pagina 36).
Indica il tipo di dati correntemente visualizzato
sullo schermo, come segue:
TCG: Codice temporale registrato
TCR: Codice temporale di riproduzione
DUR: Durata

2. Indicatore frequenza fotogrammi
Visualizza il valore dell'impostazione di
categoria Project > Project Frame Rate nel
menu (pagina 36).

3. Indicatore modalita imager
Visualizza I'impostazione di categoria Project >
Imager Mode nel menu e informazioni relative
alla decompressione (de-squeeze).

4. Visualizzazione nome clip
Visualizza "Reel: Camera ID + Reel Number”e
“ShotNumber”.

5. Indicatori di livello audio
Visualizzano i livelli di registrazione o
riproduzione audio. | numeri 1 e 2 indicano i
canalile2.

6. Indicatore registrazione simultanea
Quando é configurata la modalita di
registrazione simultanea su uno slot per il
supporto visualizzato, apparira l'indicazione
"Sub”alla destra del formato di registrazione
principale visualizzato.

Indicazione formato di registrazione (codec)
Visualizza il formato della registrazione su una
scheda di memoria AXS o SxS.(pagina 39)

Indicatore tensione di alimentazione/carica
residua della batteria

Visualizza la tensione di alimentazione o la
capacita residua della batteria.

Indicatore capacita residua supporto
Visualizza l'icona del supporto attivo, il tipo di
supporto, il tipo di slot (A/B) e il tempo di
registrazione rimanente (nel formato di
registrazione corrente).

Visualizza anche il nome del clip durante la
riproduzione.

. Indicazione dello stato di registrazione

Visualizza i seguenti stati operativi di
registrazione dell’'unita.

Indicazione Descrizione
Stby Standby registrazione
@®Rec Durante la registrazione

. lcona del termometro

Visualizzata quando & emesso un messaggio di
avvertenza di alta temperatura.

La descrizione & visualizzata nella categoria
Info del menu.
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12. Icona di avvertenza
Visualizzata quando € emesso un messaggio di
avvertenza diverso dall'avvertenza di alta
temperatura.
La descrizione e visualizzata nella categoria
Info del menu.

13. Icona Ext-LK
Visualizzato quando il generatore di codici
temporali interno e sincronizzato su un
segnale esterno in ingresso sul connettore TC
IN (ingresso codice temporale).
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Utilizzo della schermata Home del display secondario

Operazioni principali

1 Premere il tasto HOME.
Viene visualizzata la schermata Home.

FPS El

Fixed-24 50

Shutter

90.0

7¢G00:00:00:00 23.98fps 4K 4:32xSV ==
DCIN 15.0V Reel A001 Shot C004 ==

ISxS [ 120 min  XAVC QFHD C480
SxS Ed 180min 12

1.8 SDI 3/4: Look 3200+03
ND

SxS: Log WB

2 Selezionare la voce desiderata da impostare
conitastilTEMda1a6.
Il valore di impostazione delle voci che
possono essere modificate € visualizzato in
arancione.
La seguente figura mostra un esempio nel
caso in cui venga premuto il tasto ITEM 3.

Step / Cont. *
22.5
45.0

e 90.0

Current:
2144.0

(1/59.95 sec)

Use buttons or
dial to select.

172.8

Cancel

Step Edit

v

3 Spostare il cursore sulla voce o sul valore di
impostazione desiderato con i tasti o &
(rispettivamente tasto ITEM 2 e tasto ITEM 5),
oppure con il comando MENU.

4 Premere il comando MENU o il tasto Set (tasto
ITEM 3) per applicare l'impostazione.

Regolazione della luminosita del display
secondario

E possibile regolare la luminosita del display
secondario mediante Technical > Control Display >
Brightness level (pagina 51) nel menu completo.
Nella schermata Home, & possibile anche regolare
la luminosita del display secondario mantenendo
premuto il tasto BACK e ruotando allo stesso
tempo il comando MENU in senso orario. La
luminosita cambia nella sequenza: Minimum —
Low — Mid — High a partire dal valore corrente.
La luminosita del display secondario pud essere
regolata anche mantenendo premuto il tasto BACK
e ruotando allo stesso tempo il comando MENU

in senso antiorario. La luminosita cambia nella
sequenza: High — Mid — Low — Minimum a
partire dal valore corrente.

[Nota]

L'impostazione della luminosita &€ comune al display
secondario e al mini display e viene applicata ad entrambi i
display contemporaneamente.

Modifica di Step Edit

E possibile modificare le impostazioni selezionabili
con la visualizzazione di“Step Edit” per il tasto

ITEM 4 al passo 2 del funzionamento di base. La
schermata di modifica delle impostazioni consente
di aggiungere ed eliminare impostazioni.

1 Nella schermata di selezione delle
impostazioni, spostare il cursore
sullimpostazione da modificare od eliminare,
quindi premere il tasto Step Edit (tasto ITEM 4).
Viene visualizzata la schermata di modifica
delle impostazioni.

+

Step Edit

_
Use buttons or

90.0

A 4

dial to select.

Add Delete Cancel

2 Per eliminare unimpostazione, premere il tasto
Delete (tasto ITEM 4)

[Nota]
L'impostazione selezionata puo essere eliminata se la
stringa di caratteri “Delete” & visualizzata in arancione.

3 Premere il tasto T (tasto ITEM 2), il tasto $
(tasto ITEM 5) o il comando MENU per
modificare unimpostazione.

4 Al termine, premere il tasto Add (tasto ITEM 4).
Limpostazione viene aggiunta e il display torna
alla schermata di selezione delle impostazioni.
[Nota]

L'impostazione pud essere aggiunta se la stringa di
caratteri "Add" & visualizzata in arancione.

Impostazione di White Balance

Il tasto Coarse/Fine (tasto ITEM 1) nella schermata
di modifica delle impostazioni di White Balance
consente di specificare la differenza fra i passi
diregolazione, aumentandola (Coarse) o
diminuendola (Fine). Il tasto Temp/Tint (tasto ITEM
3) consente di scegliere la temperatura di colore
(Temp) o il tono di colore (Tint).

Coarse / Fine + Temp / Tint

Step Edit *

Use buttons
User Preset p | 3200K +03 or dial to

select temp.
Base:

3200 K + 03

[ |
v

Add Delete Cancel



030 @ 3. Utilizzo della videocamera: Utilizzo della schermata Home del display secondario

Utilizzo delle LUT Modifica del Preset Look Voi della schermata Home nel display secondario

E possibile impostare una LUT quando &
selezionato Look nella schermata di selezione delle  pj sequito si elencano i nomi delle voci e i rispettivi valori di impostazione disponibill.

Impostazione di una LUT LUT mediante il tasto Edit Look (tasto ITEM 4) nelle | valori predefiniti sono sottolineati e in grassetto.
pagine 10 2.
; Voce Descrizione
” tasto ITEM 5 Qe!g schderm{ata Home con§ente di 1 Premere il tasto Edit Look (tasto ITEM 4) nella EpS v i ; video 1l valore & d - Bl -
Ljnjpogtare LUT indipendenti per ciascun sistema schermata di selezione delle LUT. d‘osttra a ‘reguelnzloliog'rartn;m Vi eRo.t za orgegg;errrlwlnato allimpostazione
tuscita. Viene visualizzata la schermata di selezione del | categoria Froject > Froject Frame Rate (pagina 3o/ nelmenu.
] Premere il tasto ITEM 5 nella schermata Home. Look.
Viene visualizzata la schermata di selezione Py Project Frame Rate Display
della LUT. 23.98 Fixed-24
Category Preset look
Pagefll/ 2 SDI1/2 SDI 3/4 Preset Look 24 Fixed-24
Outputs Log _ 25 Fixed-25
2997 Fixed-30
Look Info  s709 50 Fixed-50
59.94 Fixed-60
. LOOk -/
Edit Look Monit HDMI
ditLoo ontor 2 . Exposure Index Imposta il valore di El. Sono disponibili le seguenti impostazioni:
Premere il tasto SELECT (tasto ITEM 3).

125EI/160EI/200El/250El/320El/400El/500EIl/640El/800EI/1000El/

La schermata di selezione della LUT consiste di Vengono visualizzate le voci selezionabili. 1250E1/1600E1/2000E|
due pagine. Premere il tasto ITEM 1 per passare
da una pagina allaltra. 3 Premere il tasto B (tasto ITEM 2), il tasto &

Nella pagina 1 si possono configurare le
impostazioni di LUT per SDI 1/2 (solo
visualizzazione), SDI 3/4, Monitor e HDMI.

(tasto ITEM 5) o il comando MENU per
modificare unimpostazione.

Nella pagina 2 si possono configurare le 4 ) _
impostazioni di LUT per mirino, SxS Rec e Sub Premere il comando MENU o il tasto Set (tasto
Rec. ITEM 3) per applicare I'impostazione.

2 Selezionare I'uscita desiderata con i tasti [TEM
2,3,5e6.
Viene visualizzata la schermata di modifica
delle impostazioni.

3 Premere il tasto B (tasto ITEM 2), il tasto &
(tasto ITEM 5) o il comando MENU per
modificare un'impostazione.

4 Premere il comando MENU o il tasto Set (tasto
ITEM 3) per applicare l'impostazione.
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Voce Descrizione Voce Descrizione
Shutter Imposta I'angolo o la velocita dell'otturatore elettronico. LUT Configura impostazioni relative alla LUT da applicare al video in uscita.
Premere il tasto Step/Cont. (tasto ITEM 1) per passare dalla selezione di valori in .
- i . ) ) S Pagina 1
passi discreti allimpostazione di valori continui e viceversa.
Step: Consente di selezionare il valore desiderato fra fino a 16 valori di preset, SDI'1/2 (tasto ITEM 2): Log
registrati come valori di otturatore. Premendo il tasto Step Edit (tasto ITEM 4), & Solo visualizzazione in quanto non & possibile applicare LUT allimmagine in
possibile modificare qualsiasi valore di preset dopo averlo selezionato. uscita su SDI'1/2.
Possono essere selezionate le opzioni indicate di seguito, in base SDI'3/4 (tasto ITEM 3): Log/Look
allimpostazione di Technical > System Configuration > Shutter Mode Seleziona la LUT da applicare allimmagine in uscita su SDI 3/4.
(pagina 50) nel menu completo. Disabilitato quando la voce in categoria Monitoring > Output Format > SDI
T , , 1/2 e impostata su 4K/QFHD nel menu.
Angle: Indicazione dell'angolo dell'otturatore Monitor (tasto ITEM 5): Log/s709/R709(800%)
Opzioni selezionabili predefinite La selezione diventa Log/Look quando la voce in categoria Monitoring >
360/180/172.8/144/90/45/22.5/11.2/5.6 Output Format > SDI 1/2 & impostata su 4K/QFHD nel menu.
Speed: Indicazione della velocita dell'otturatore HDMI (tasto ITEM 6): Log/s709/R709(800%)
Opzioni selezionabili predefinite Fisso su Log quando la voce in categoria Monitoring > Output Format > SDI
1/24,1/25,1/30, 1/50, 1/60, 1/100, 1/120, 1/250, 1/500, 1/1000, 1/2000" 1/2 ¢ impostata su 4K/QFHD e HDMI e impostato su 4K/QFHD nel menu. In
Nota) tutti gli altri casi, le opzioni disponibili sono identiche a quelle di Monitor.
Di seguito si indicano i valori predefiniti di velocita per le varie impostazioni di Project Pagina 2
Frame Rate (pagina 36). Viewfinder (tasto ITEM 2): Log/s709/R709(800%)
23.98/24:1/24,25:1/25,29.97:1/30, 50: 1/50, 59.94: 1/60 Seleziona la LUT da applicare allimmagine in uscita sul mirino.
Cont.: Consente di selezionare I'angolo o la velocita desiderati all'interno di una SXS Rec (tasto ITEM 5): Log/Look
gamma predefinita. Disabilitata quando la voce in categoria Project > SxS Rec Format & impostata
ND Filter Imposta la posizione del filtro ND. Sono disponibili le seguenti impostazioni: su Rec Off nel menu, oppure ¢ fissata su Log se la voce & impostata su XAVC.

Clear/0.3/0.6/0.9/1.2/15/1.8/2.1/2.4

Sub Rec (tasto ITEM 6): Log/Look
Disabilitata quando la voce in categoria Project > SxS Rec Format & impostata
su Rec Off nel menu.
Elementi comuni alle pagine 1 e 2
Edit Look: Imposta una LUT da applicare come Look.
s709/R709(800%)

WB (White Balance) Imposta la temperatura di colore e il tono di colore per il bilanciamento del
bianco.
Opzioni selezionabili predefinite
3200K+00/4300K+00/5500K+00
Premendo il tasto Step Edit (tasto ITEM 4), & possibile modificare il valore di preset
e il valore di Tint del bilanciamento del bianco.

) Le opzioni sono: 1/60 e valori successivi quando la frequenza fotogrammi di progetto é 59.94; 1/50 e valori successivi
quando e 50.0; 1/30 e valori successivi quando e 29.97; 1/25 e valori successivi quando & 25.0.
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Schermata funzioni utente

Premendo il tasto USER (pagina 8), & possibile
visualizzare la schermata delle funzioni utente che
consente di utilizzare i tasti ITEM da 1 a 5 come
tasti programmabili (da User 1 a User 5).

Sono disponibili anche quattro tasti programmabili
(pagine 6, 7, 8) a cui possono essere

assegnate varie funzioni.

Le funzioni possono essere assegnate a questi tasti
sia utilizzando la schermata delle funzioni utente
che la voce in Project > Assignable Button nel
menu completo.

Tasto ITEM 1 Tasto ITEM 2 Tasto ITEM 3

o o o

User 1 User 3

SDI Frame Line

User 2
Monitor Monitor
Status Info LUT bypass

On On Off

00:00:00:00
Off Auto

Monitor Fan Mode

Highlight Clip Ind
User 4

o o o

Tasto ITEM 4

User 5

Tasto ITEM 5 Tasto ITEM 6

Modifica della funzione dei tasti

La schermata di selezione delle funzioni utente
viene visualizzata premendo il tasto Edit (tasto
ITEM 6) nella schermata delle funzioni utente.

La schermata di selezione delle funzioni utente
consente di assegnare funzioni ai tasti Userda 1 a
5 e ai tasti programmabilida 1 a 4.

Select

SDI Frame Line
User 2
User 3
User 4
User 5
Assign Btn 1

Monitor Status Info

Monitor LUT bypass

Monitor Highlight Clip Ind
Fan Mode
VF Highlight Clip Ind
$ Done

1 Nella schermata di selezione delle funzioni
utente, spostare il cursore sul tasto desiderato,
quindi premere il tasto Select (tasto ITEM 3).
Vengono visualizzate le funzioni selezionabili.

*

] Not Assigned
<user > SDI Frame Line

SIS IS SDI Status Info

SDILUT bypass
Monitor Frame Line

Monitor Status Info
¥ Cancel

2 Premere il tasto B (tasto ITEM 2), il tasto &
(tasto ITEM 5) o il comando MENU per
modificare un'impostazione.

3 Al termine, premere il tasto Set (tasto ITEM 3).
Il display torna alla schermata delle funzioni
utente visualizzando la nuova funzione.

Le seguenti tabelle elencano le funzioni gia assegnate al momento della spedizione dell'unita dalla

fabbrica.

Tasto

Funzione Impostazione del tasto

programmabile

Programmabile 1

Visualizza in rosso, nel mirino, le aree soggette a
clipping.

VF Highlight Clip Ind

Programmabile 2 Nessuna funzione assegnata Not Assigned
Programmabile 3 Nessuna funzione assegnata Not Assigned
Programmabile 4 Nessuna funzione assegnata Not Assigned

Tasto ITEM 1 Nessuna funzione assegnata Not Assigned

Tasto ITEM 2 Nessuna funzione assegnata Not Assigned

Tasto ITEM 3 Nessuna funzione assegnata Not Assigned

Tasto ITEM 4 Visualizza in rosso, sull'uscita Monitor, le aree Monitor Highlight Clip Ind

soggette a clipping.
Tasto ITEM 5 Imposta la modalita di comando della ventola. Fan Mode

Funzioni assegnabili ai tasti [TEM 1-5

Impostazione del
tasto programmabile

Funzione Stato all'accensione dell'unita

Not Assigned

Nessuna funzione assegnata -

SDI Frame Line

Attiva o disattiva la sovraimpressione delle linee di  Impostazione mantenuta
quadro sullimmagine di uscita SDI 3/4.

SDI Status Info

Attiva o disattiva la visualizzazione di informazioni
sullimmagine di uscita SDI 3/4.

Impostazione mantenuta

SDI'LUT bypass

Mentre viene premuto il tasto, disabilita la LUT
applicata allimmagine di uscita SDI 3/4 ed
imposta la qualita immagine Log senza applicare
una LUT.

Impostazione non mantenuta

Monitor Highlight Clip
Ind

Attiva o disattiva la funzione che visualizza in
rosso sullimmagine di uscita Monitor le aree di
alte luci soggette a clipping.

Impostazione mantenuta

Monitor Frame Line

Attiva o disattiva la sovraimpressione delle linee di  Impostazione mantenuta
quadro sull'immagine di uscita Monitor.

Monitor Status Info

Attiva o disattiva la visualizzazione di informazioni
sull'immagine di uscita Monitor.

Impostazione mantenuta
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Impostazione del Funzione Stato all'accensione dell'unita

tasto programmabile

Funzioni assegnabili ai tasti programmabili 1- 4

Monitor LUT bypass Mentre viene premuto il tasto, disabilita la LUT Impostazione non mantenuta
applicata allimmagine di uscita Monitor ed Impostazione del tasto Funzione Stato all'accensione dell’'unita
imposta la qualita immagine Log senza applicare programmabile
una LUT. Not Assigned Nessuna funzione assegnata -

Color Bars Attllva o disattiva la visualizzazione delle barre di Impostazione mantenuta SDI Frame Line Attiva o disattiva la sovraimpressione  Impostazione mantenuta
colore. delle linee di quadro sullimmagine di

AXS Slot Change Commuta lo slot attivo quando sono inserite due  Impostazione mantenuta uscita SDI 3/4.
schede di memoria AXS. ' , SDI Status Info Attiva o disattiva la visualizzazione di  Impostazione mantenuta
Passa da A a B e viceversa ad ogni pressione del informazioni sullimmagine di uscita
tasto. SDI 3/4.

SXS Slot Change Cohmgnuég lo slot gttlsvosquando sono inserite due  Impostazione mantenuta SDI LUT bypass Mentre viene premuto il tasto, Impostazione non mantenuta
schede di memotla XS. A ‘ disabilita la LUT applicata
Passa da A a B e viceversa ad ogni pressione del allimmagine di uscita SDI 3/4 ed
tasto. imposta la qualita immagine Log

Fan Mode Imposta la modalita di comando della ventola. Impostazione mantenuta senza applicare una LUT.

Ad ogni pressione del tasto, seleziona una
modalita operativa nella sequenza: Auto — Max
— Off in Rec/Auto — Off in Rec/Max.

Monitor Frame Line Attiva o disattiva la sovraimpressione  Impostazione mantenuta
delle linee di quadro sullimmagine di

uscita Monitor.

Format Media AXS

Slot A

Formatta il supporto di memoria contenuto nello -

slot AXS A

Format Media AXS
Slot B

Formatta il supporto di memoria contenuto nello
slot AXS B.

Monitor Status Info

Attiva o disattiva la visualizzazione di
informazioni sullimmagine di uscita

Monitor.

Impostazione mantenuta

Format Media SxS
Slot A

Formatta il supporto di memoria contenuto nello
slot SxS A.

Monitor LUT bypass

Mentre viene premuto il tasto,
disabilita la LUT applicata

Impostazione non mantenuta

allimmagine di uscita Monitor ed
imposta la qualita immagine Log
senza applicare una LUT.

Format Media SxS Formatta il supporto di memoria contenuto nello -
Slot B slot SxS B.

Attiva o disattiva la funzione che
visualizza in rosso sullimmagine di
uscita Monitor le aree di alte luci
soggette a clipping.

APR Esegue la funzione APR. - Monitor Highlight Clip Ind Impostazione mantenuta

Seleziona l'interfaccia dell'obiettivo
Ad ogni pressione del tasto, passa da Off —
Type Ce viceversa.

Lens Interface Impostazione mantenuta

Attiva o disattiva la visualizzazione
delle barre di colore.

Color Bars Impostazione mantenuta

Attiva o disattiva la funzione che visualizza in
rosso, sullimmagine in uscita sul mirino, le aree di

VF Highlight Clip Ind Impostazione mantenuta

AXS Slot Change Commuta lo slot attivo quando sono -
inserite due schede di memoria AXS.
Passa da A a B e viceversa ad ogni

pressione del tasto.

alte luci soggette a clipping.

SxS Slot Change Commuta lo slot attivo quando sono -
inserite due schede di memoria SxS.
Passa da A a B e viceversa ad ogni

pressione del tasto.

Rec Review Esegue la funzione Rec Review. Impostazione non mantenuta
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Impostazione del tasto Funzione Stato all'accensione dell'unita
programmabile
VF Frame Line Attiva o disattiva la sovraimpressione  Impostazione mantenuta

delle linee di quadro sullimmagine in
uscita sul mirino.

VF Zebra Attiva o disattiva la funzione zebra Impostazione mantenuta
sullimmagine in uscita sul mirino.

VF Status Info Attiva o disattiva la visualizzazione di  Impostazione mantenuta
informazioni sullimmagine in uscita
sul mirino.

VF Focus Magnifier Attiva o disattiva la funzione di Impostazione non mantenuta
ingrandimento della messa a fuoco
sul mirino.

VF LUT bypass Mentre viene premuto il tasto, Impostazione non mantenuta
disabilita la LUT applicata
allimmagine in uscita sul mirino ed
imposta la qualita immagine Log
senza applicare una LUT.

VF Highlight Clip Ind Attiva o disattiva la funzione che Impostazione mantenuta
visualizza in rosso, sullimmagine in
uscita sul mirino, le aree di alte luci
soggette a clipping.
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Utilizzo dei menu

Premendo il tasto MENU durante la ripresa

(registrazione o standby di registrazione) oppure

durante la riproduzione, € possibile visualizzare

e utilizzare la schermata del menu sul display

secondario.

® (Categoria Project: Impostazioni principali e
impostazioni di formato di registrazione

® (Categoria TC/Media: Valore del codice temporale
e impostazioni di formato del codice temporale

® (ategoria Monitoring: Formato del segnale
di uscita esterno su SDI/HDMI/Monitor, OSD,
impostazioni di sovraimpressione di marcatori e
indicazioni

® (Categoria Audio: Sorgente audio e impostazioni
dilivello audio

® (ategoria Info: Informazioni relative alla sezione
telecamera, ai supporti di memoria e allo stato
della batteria

Comandi

Tasto MENU (pagina 7)
Premere per visualizzare il menu sul display
secondario.

Tasti [TEM da 1 a6 (pagina 7)

Selezionano la categoria del menu.

Comando SEL/SET (comando MENU) (pagina 7)

Ruotare questo comando per spostare il cursore
nella direzione corrispondente e selezionare voci o
impostare valori.

Premere il comando MENU per applicare la voce
selezionata.

Tasto BACK (pagina 8)
Premere per tornare al menu precedente. Le
modifiche non confermate vengono annullate.

Operazioni principali

1 Premere il tasto MENU.
Viene visualizzata la schermata di menu.

2 Selezionare la categoria desiderata con i tasti
ITEMda1aé.

3 Ruotare il comando MENU per spostare il
cursore sulla voce di impostazione desiderata.
Per ciascuna voce di menu, ne viene
visualizzato il valore di impostazione.

“Elenco delle voci di menu” (pagina 36)

Project TC/Media Monitoring
Imager Mode 4K 17:9
Project Frame Rate 23.98
S-Gamut3.Cine/Slog3
Rec Off
XAVC 4K Class300

Rec Off

Input Color Space
AXS Rec Format
SxS Rec Format
Sub Rec Format
Audio

Project Details >

4 Premere il comando MENU.
La schermata di selezione del valore di
impostazione viene visualizzata accanto alla
voce selezionata.

Project TC/Media Monitoring

4K 17:9
3.8K 16:9
Rec Off
XAVC 4K Class300
Rec Off

Imager Mode
Project Frame Rate
Input Color Space
AXS Rec Format
SxS Rec Format
Sub Rec Format

Audio

Project Details >

5 Ruotare il comando MENU per spostare il
cursore sul valore di impostazione.

6 Premere il comando MENU per applicare
l'impostazione.
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Elenco delle voci di menu

Di seguito si elencano le voci disponibili in ciascuna categoria.

(ategoria Project

| valori predefiniti sono sottolineati e in grassetto.

(ategoria T(/Media

| valori predefiniti sono sottolineati e in grassetto.

Voce

Impostazioni

Descrizione

Voce

Impostazioni

Descrizione

Imager Mode

6K 3:2/4K 4:3/4K 17:9/3.8K 16:9

Imposta le dimensioni effettive dellimmagine.

[Note]

® "6K 3:2"e"4K 4:3"sono visualizzati solo se € installata
la relativa licenza.

® | clip registrati in 6K 3:2 non possono essere
riprodotti sull'unita.

Project Frame Rate

23.98/24/25/29.97/50/59.94

Imposta la frequenza di fotogrammi di progetto.

Input Color Space

S-Gamut3.Cine/Slog3

Imposta lo spazio colore. Fisso su S-Gamut3.
Cine/Slog3 nella versione 1.0 del firmware.

TC Mode

Preset F-Run (Ext-Lk)/
Preset R-Run/Int Regen

Imposta la modalita del codice
temporale.

Preset F-Run (Ext-Lk): Il codice temporale
avanza senza interruzione, a partire dal
valore specificato, indipendentemente
dal fatto che sia attiva una registrazione
0 meno.

Preset R-Run: Il codice temporale avanza,
proseguendo dal valore specificato, solo
durante la registrazione.

Int Regen: 'avanzamento del codice
temporale prosegue da quello del clip
precedente.

TC Display

Timecode/Duration

Commuta l'indicazione temporale.

AXS Rec Format"

Rec Off/RAW SQ/X-OCN

Imposta il formato di registrazione per le schede

(Solo se & montato un ST/X-OCN LT di memoria AXS quando € montato un
registratore AXS-R7) registratore AXS-R7.
SxS Rec Format" Rec Off/XAVC 4K Class480/ Imposta il formato di registrazione principale per
XAVC 4K Class300/XAVC le schede di memoria SxS.
QFHD Class480/XAVC QFHD
Class300/MPEG HD P/
MPEGHD i
Sub Rec Format" Rec Off/MPEG HD P/ Imposta il formato di registrazione secondaria
MPEGHD i per le schede di memoria SxS.

TC Setting
(impostare per il
passaggio a un altro
schermo)

Setting
(H M,S,F)

Imposta il codice temporale su un valore
desiderato.

Reset

Ripristina il codice temporale a
00:00:00:00.

TC Format

DF/NDF

Seleziona il formato del codice
temporale.

DF: Drop frame

NDF: Non drop frame

TC Source

Internal/External

Solo visualizzazione.

Project Details
(Tasto ITEM 6)

Visualizza il contenuto del menu Project
(pagina 43) nel menu completo.

V| formati di registrazione disponibili variano a seconda della combinazione fra limpostazione delle dimensioni effettive

dellimmagine e I'impostazione della frequenza fotogrammi di progetto. Per informazioni dettagliate su queste impostazioni,
vedere “Impostazioni del formato di registrazione” (pagina 39).

Cam D

DallaAallaz

Imposta I'ID della videocamera per la
generazione di nomi di clip.

Nome clip: Camera ID + Reel Number +
Shot Number + data + stringa casuale

Reel#

Da 001 a 999

Imposta la parte numerica del Reel
Number utilizzato per la generazione di
nomi dei clip.

Nome clip: Camera ID + Reel Number +
Shot Number + data + stringa casuale

Camera Position

C/L/R

Imposta la stringa di caratteri della prima
porzione dello Shot Number utilizzato
per la generazione di nomi dei clip.
Nome clip: Camera ID + Reel Number +
Shot Number + data + stringa casuale
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Voce Impostazioni Descrizione Voce Impostazioni Descrizione
Format Media AXS Slot A Formatta la scheda di memoria AXS SDI'1/2 Frame Line  A/B/Off Seleziona le linee di quadro da
(eseguito con il nello slot A. visualizzare in sovraimpressione
passaggio aunaltro  AXS Slot B Formatta la scheda di memoria AXS sull'uscita SDI1/2.
schermo) nello slot B. [Notal
SxS Slot A Formatta la scheda di memoria SxS nello Le linee di guadro vengono visualizzate in
slot A sovraimpressione solo se il formato di uscita
SxS Slot B F - la scheda di ia SxS nell /D,
XS Slot ormatta la scheda di memoria SXS nello - - o - T
dotB SDI'3/4 Output Le impostazioni disponibili Seleziona il formato di uscita SDI 3/4."
D Cord - : - schoda <D [Nota] Format variano in base
ar ormatta la scheda SD. p » !
In base allimpostazione allimpostazione di SDI 1/2.
Media Details Visualizza il contenuto del menu TC/ di Output Format di Info A/B/Off Seleziona le informazioni da visualizzare
(Tasto ITEM 6) Media (pagina 44) nel menu SDI'1/2, le impostazioni in sovraimpressione sull'uscita SDI 3/4.
completo. Output Format, - ' : :
Info e Frame Line di Frame Line  A/B/Off Seleziona le linee di quadro da
SDI 3/4 potrebbero visualizzare in sovraimpressione
essere vuote e non sull'uscita SDI 3/4.
modificabili.
) o Monitor Output Le impostazioni disponibili Seleziona il formato di uscita Monitor?
(ategoria Monitoring Format variano in base
‘ o ' o allimpostazione di SDI 1/2.
I valori predefiniti sono sottolineati  in grassetto. Info A/B/Off Seleziona le informazioni da visualizzare
[Note] in sovraimpressione sull'uscita Monitor.
o .Lumta lcqr?sentel di configurare Infq e Frame que mdlpendentemehte per clascun sistema. Le informazioni visualizzate sulle Frame Line A/B/Off Seleziona le linee di quadro da
immagini in uscita A e B sono configurate tramite il menu Monitoring (pagina 45). isuali . . .
® |n base alle impostazioni di Output Format, Info e Frame Line potrebbero non essere visualizzabili. In tal caso, il menu mostra \/\su’a \Z;are in spvrampresyone
"_"e limpostazione non pud essere modificata. sull'uscita Monitor.
HDMI Output Le impostazioni disponibili Seleziona il formato di uscita HDMI.?
Voce Impostazioni Descrizione Format variano in base
VF Info A/B/Off Seleziona le informazioni da visualizzare allimpostazione di SDI 1/2.
inlslovraimpressione sullimmagine del Moni. Details Visualizza il contenuto del menu
mirino. (Tasto ITEM 6) Monitoring (pagina 45) nel menu
Frame Line  A/B/Off Seleziona le linee di quadro da completo.
VISL,‘a|IZZ&|'eA " Sovralmpressmne U Per informazioni dettagliate sui formati selezionabili, fare riferimento a “Formati di uscita del connettore SDI OUT"
sullimmagine del mirino. (pagi
pagina 66).
SDI/2 Output Le impostazioni disponibili Seleziona il formato di uscita SDI 1/2.7 2 Per informazioni dettagliate sui formati selezionabili, fare riferimento a “Formati di uscita per i connettori MONITOR OUT e
Format variano a seconda della HDMI OUT" (pagina 68).
modalita Imager, della
frequenza fotogrammi di
progetto e del formato di
registrazione SxS.
Info - Le informazioni non vengono

visualizzate in sovraimpressione
sull'uscita SDI 1/2.
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Categoria Audio Controllo dello stato tramite la categoria Info

| valori predefiniti sono sottolineati e in grassetto.

La categoria Info consente di controllare lo stato dei supporti di memoria e della batteria, nonché di
controllare il contenuto degli avvisi ed errori che sono stati emessi. Le informazioni visualizzate cambiano
in tempo reale riflettendo lo stato corrente dell'unita.

La categoria Info consiste delle sei pagine di informazioni descritte di seguito. Ruotare il comando MENU
per passare da una pagina all‘altra.

Voce Impostazioni Descrizione

Source Switch LINE / AES/EBU / MIC Visualizza la posizione del selettore AUDIO IN
(pagina 8) che seleziona la sorgente di
ingresso CH1 e CH2.

CH-1 Audio Level Auto/Manual Se impostato su Auto, il livello di registrazione
Da-99a+0a+99 audio viene regolato automaticamente. N. Pagina Descrizione
Se impgstato suManual, il livello diregistrazione 1 Camera Condition Visualizza messaggi di avvertenza e di errore. Se non vi sono
audio viene regolato manualmente. messaggi, l'indicazione "All Systems are OK” appare nella parte
CH-2 Audio Level Auto/Manual Se impostato su Auto, il livello di registrazione superiore dell'area di visualizzazione.
Da-99a=0a+99 audio viene regolato automaticamente. 2 Firmware Visualizza la versione del firmware dell'unita, il numero di serie e
Se impostato su Manual, il ivello di registrazione la versione del firmware del registratore AXS-R7 montato
audio viene regolato manualmente. sull'unita, nonché il nome e la validita delle licenze software
MIC Reference -60dB/-50dB/-40dB Seleziona il livello di riferimento di ingresso del opzionali presenti sull'unita. Le opzioni non presenti o
microfono. correntemente non valide sono identificate con “Not Installed” o
Monitor CH Quando Monitor Output CH Seleziona il canale audio emesso su cuffie e “Expired”
Pair & impostato su CH-1/CH-2  altoparlante. 3 System Visualizza le seguenti informazioni sul sistema:
CH-1/CH-2, CH-1,CH-2 e Dataeora
Quando Monitor Output CH ® Velocita di rotazione della ventola
Pair & impostato su CH-3/CH-4 e Temperatura rilevata dal sensore
CH-3/CH-4, CH-3,CH-4 e Contaore
Monitor Level Da0a99 Regola il livello dell'audio di monitoraggio. e |ndirizzo IP
CH1 Level Meter - Visualizza l'indicatore di livello CH1. 4 Battery Visualizza le seguenti informazioni sulla batteria:
CH2 Level Meter - Visualizza l'indicatore di livello CH2. ¢ Nome otipa della batteria rilevata
— — ® Capacita rimanente (%)
CH3 Level Meter - Visualizza l'indicatore di livello CH3. e Tempo rimanente stimato
CH4 Level Meter - Visualizza l'indicatore di livello CH4. e Capacita rimanente (Ah)
Audio Details Visualizza il contenuto del menu Audio ® Tensione (V)
(tasto ITEM 6) (pagina 48) nel menu completo. e Numero di volte che la batteria é stata caricata

Alimentazione
Tensione fornita dalla sorgente di alimentazione.

5 Media Visualizza la capacita rimanente, il tempo di registrazione
rimanente e dati sulla durata della vita utile di schede di
memoria SxS, schede di memoria AXS (quando € montato un
registratore AXS-R7) e schede SD.
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N. Pagina

Descrizione

6 Lens

Visualizza le seguenti informazioni sull'obiettivo montato
sull'unita:

e Nome di modello dell'obiettivo

® Valore T del diaframma

® Lunghezza focale

® Distanza di messa a fuoco

e Profondita di campo

Numero di serie

Impostazioni del formato di registrazione

In base alle varie combinazioni di dimensioni effettive dellimmagine e frequenza fotogrammi di progetto,
potranno essere selezionati i formati di registrazione indicati di sequito.
Se e selezionato un valore sottolineato e in grassetto, potra essere applicata unimpostazione di LUT al
segnale video registrato.

Project Frame Rate  Dimensioni Formato di registrazione principale Formato di registrazione
effettive immagine Ay Rac Format SxS Rec Format secondaria SxS (Sub Rec
(Imager Mode) Format)

23.98 4K17:9 Off Off -

(4096x2160) 4K XAVC-l Class480  Off
MPEG HD422"
4K XAVC-I Class300  Off
MPEG HD422"
RAW/X-OCN Off -
ST/X-OCN LT MPEG HD422" _
3.8K16:9 Off Off Off
(3840x2160) QFHD XAVC-| Off
Class480 MPEG HD422
QFHD XAVC- Off
Class300 MPEG HD422
MPEG HD422 -
RAW/X-OCN Off -
ST/X-OCN LT MPEG HD422 _
4K 4:3 Off Off Off
Anamorphic X-OCN ST/X-OCN LT = Off -
(4096x3024) MPEG HD422 1 ~
6K 3:2 (6048%4032)  Off Off Off
X-OCN ST/X-OCN LT~ Off Off
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Project Frame Rate  Dimensioni Formato di registrazione principale Formato di registrazione Project Frame Rate  Dimensioni Formato di registrazione principale Formato di registrazione
effettive immagine Ay Rec Format S Pae Bammen secondaria SxS (Sub Rec effettive immagine Ay Rac Format 5SS Rec Format secondaria SxS (Sub Rec
(Imager Mode) Format) (Imager Mode) Format)
24 4K17:9 Off Off - 50/59.94 4K17:9 Off Off -
(4096x2160) 4K XAVC-l Class480  Off (4096x2160) 4K XAVC-l Class300  Off
4K XAVC-l Class300  Off MPEG HD422"
RAW/X-OCN Off - RAW/X-OCN Off -
ST/X-OCN LT ST/X-OCN LT MPEG HD422" _
38K 169 Off Off Off 38K 16:9 Off Off Off
(3840x2160) RAW/X-OCN off - (3840%2160) OFHD XAVC- Off
Son? XOCN LT o = Class300 MPEG HD422
iﬁ:ﬁorphgc X-OCN ST/X-OCN LT Off - ML hbia -
(4096x3024) RAW/X-OCN Off -
6K 32 (6048x4032)  Off off off SO MPEG HD422 -
X-OCN ST/X-OCN LT Off Off " Quadro orizzontale con barre nere in alto e in basso (letterboxing).
25/29.97 4K17:9 Off Off -
(4096x2160) 4K XAVC-| Class480  Off
MPEG HD422"
4K XAVC-l Class300  Off
MPEG HD422"
RAW/X-OCN Off -
ST/X-OCN LT MPEG HD422" _
3.8K16:9 Off Off Off
(3840%2160) QFHD XAVCH Off
Class480 MPEG HD422
QFHD XAVC- Off
Class300 MPEG HD422
MPEG HD422 -
RAW/X-OCN Off -
ST/X-OCN LT _

MPEG HD422
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Operazioni del menu completo

Il menu completo, per la configurazione delle
impostazioni necessarie per la ripresa e la
riproduzione, puo essere visualizzato sul display
secondario mantenendo premuto il tasto MENU
per almeno 2 secondi.

Menu Maintenance

Menu utilizzato per eseguire impostazioni relative
all'unita stessa, come le impostazioni dell'orologio
e lalingua.

Struttura del menu

Comandi

Menu Shooting

Menu utilizzato per eseguire le impostazioni
relative alla ripresa.

Menu Project

Menu utilizzato per eseguire le principali
impostazioni per i progetti.

Menu TC/Media

Menu utilizzato per eseguire le impostazioni
relative a supporti di registrazione e codice
temporale.

Menu Monitoring

Menu utilizzato per eseguire le impostazioni
relative alle uscite video e mirino.

Menu Audio

Menu utilizzato per eseguire le impostazioni
relative all'audio.

Menu Technical

Menu utilizzato per eseguire varie impostazioni di

natura tecnica.

Tasto MENU (pagina 7)

Mantenere premuto per almeno 2 secondi
per visualizzare il menu completo sul display
secondario.

Comando SEL/SET (comando MENU) (pagina 7)

Ruotare questo comando per spostare il cursore e
selezionare voci o impostare valori.

Premere il comando MENU per applicare la voce
selezionata.

Tasto BACK (pagina 8)
Premere per tornare al menu precedente. Le
modifiche non confermate vengono annullate.

Impostazione delle voci dei menu

Ruotare il comando MENU per spostare il cursore

sulla voce di menu da impostare, quindi premere il

comando MENU per selezionare tale voce.

® |‘area di selezione delle voci di menu visualizza
fino a sette righe. Se le voci selezionabili non
sono tutte visualizzabili in un'unica schermata,
scorrere verso l'alto o verso il basso spostando il
cursore.

® Se lagamma di opzioni disponibili per una voce
€ molto ampia (ad esempio da -99 a +99), I'area
di selezione non viene visualizzata. Viene invece
evidenziato il valore corrente per indicare che
tale valore pud essere modificato.

® Se si seleziona Execute per una voce che
prevede l'esecuzione di un‘azione, viene
eseguita la funzione corrispondente.

® Se si seleziona una voce che deve essere
confermata prima della sua esecuzione, verra
visualizzato un messaggio di conferma. Seguire
le istruzioni visualizzate nel messaggio per
eseguire o annullare 'operazione.
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Elenco delle voci del menu completo

Di seguito vengono elencate le funzioni e le impostazioni disponibili per ciascuna voce di menu.

Menu Shooting

| valori predefiniti sono sottolineati e in grassetto.

Shooting > ND
Imposta la posizione del filtro ND.

Voce di menu Impostazioni

Descrizione

ND Position
21724

Clear/0.3/0.6/0.9/1.2/1.5/1.8/

Seleziona la densita del filtro ND.

Shooting > Exposure Index
Consente di impostare il valore El.

Shooting > Shutter

Esegue impostazioni relative all'otturatore elettronico.

Voce di menu Impostazioni

Descrizione

Voce di menu Impostazioni Descrizione

Shutter Select Quando Shutter Mode Seleziona I'angolo di otturazione o la velocita
(pagina 50) e impostato su dell'otturatore elettronico.
Speed Di sequito si indicano i valori predefiniti di velocita

Opzioni selezionabili predefinite
1/24,1/25,1/30, 1/50, 1/60,
1/100, 1/120, 1/250, 1/500,
1/1000, 1/2000"

Quando Shutter Mode

(pagina 50) & impostato su

Angle

Opzioni selezionabili predefinite
360.0/180.0/172.8/144.0/
90.0/45.0/22.5/11.2/5.6

Quando Step/Cont. Select &

impostato su Continuous, la

gamma di valori selezionabile &
compresa fra 360.0 e 4.2 (per

Angle) oppure fra 1/24" e

1/8000? (per Speed).

per le varie impostazioni di Project Frame Rate
(pagina 43).

23.98/24:1/24

25:1/25

29.97:1/30

50:1/50

59.94:1/60

El Select

1250E1/1600El/2000E

125EI/160EI/200El/250E1/320El/
400EI/500EI/640El/800EI/1000El/

Seleziona il valore di El.

Shooting > White Balance

Esegue impostazioni relative al bilanciamento del bianco.

Step/Cont. Select Step/Continuous

Specifica se i valori di impostazione dell'otturatore
elettronico devono essere visualizzati in passi
discreti 0 possono essere impostati su valori scelti
liberamente.

Add/Change Step

Aggiunge o modifica unopzione selezionabile
quando Shutter Select e impostata sulla modalita
Step.

E possibile aggiungere fino a 16 opzioni
selezionabili.

Delete Step

Elimina un'opzione selezionabile quando Shutter
Select e impostata sulla modalita Step.

Voce di menu Impostazioni Descrizione

Color Temp. Select 3200K+00/4300K+00/ Visualizza e seleziona la temperatura e il tono
5500K+00 colore del bilanciamento del bianco memorizzata
+ altre opzioni aggiunte (fino a nella memoria del bianco.
16)

Add/Change Step Aggiunge o modifica un'opzione selezionabile
cambiando i valori di temperatura di colore e tinta
del bilanciamento del bianco.

Delete Step Elimina un'opzione selezionabile aggiunta.

Shooting > LUT Select

Esegue impostazioni relative alla LUT da applicare allimmagine emessa in uscita.

Voce di menu Impostazioni Descrizione

SDI/2 Log Solo visualizzazione in quanto non & possibile
applicare LUT allimmagine in uscita su SDI 1/2.

SDI'3/4 Log/Look/-- Seleziona la LUT da applicare allimmagine in
uscita su SDI 3/4.

Monitor Log/s709/R709(800%)/Look/-—-  Seleziona la LUT da applicare allimmagine

Di seguito si indicano i valori

predefiniti.

Quando Output Format >

SDI'1/2 e 2K/HD: s709

Quando Output Format >
SDI'1/2 & 4K/QFHD: Look

sull'uscita Monitor.
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Shooting > LUT Select
Esegue impostazioni relative alla LUT da applicare allimmagine emessa in uscita.

Menu Project

Voce di menu Impostazioni Descrizione
HDMI Log/s709/R709(800%)/Look Visualizza la LUT da applicare allimmagine in | valori predefiniti sono sottolineati e in grassetto.
Di seguito si indicano i valori uscita su HDMI. Project > Basic Setting
predefiniti. Esegue impostazioni relative alle dimensioni dellimmagine e alla frequenza fotogrammi di progetto.
Quando\Output Format > Voce di menu Impostazioni Descrizione
SDI1/2 € 2K/HD: 5709 Imager Mode 6K 3:2/4K 4:3/4K 17:9/3.8K16:9  Seleziona le dimensioni effettive dellimmagine.
Quando Output Format >
SDI'1/2 & 4K/QFHD e HDMI [Note]
non & 4K/QFHD: Look ® 6K 3:2"e"4K 4:3"sono visualizzati solo se & installata la

relativa licenza.

Quando Output Format > e | clip registrati in 6K 3:2 non possono essere riprodotti

HDMI & 4K/QFHD: Log

sull'unita.

VF LUT Log/s709/R709(800%) Seleziona la LUT da applicare allimmagine in Project Frame Rate 23.98/24/25/29.97/50/59.94 Seleziona la frequenza di fotogrammi di progetto.
uscita sul mirino. AXS Rec Format Rec Off/RAW SQ/X-OCN ST/ Seleziona il formato video per la registrazione su

SxS Rec Loa/Look/--- Seleziona la LUT da applicare al video registrato (Solose e montatoun  X-OCN LT una scheda di memoria AXS inserita nel
per il clip SDI principale. registratore AXS-R7) registratore AXS-R7.

Sub Rec Log/Look/-— Seleziona la LUT da applicare al video registrato SxS Rec Format Rec Off/XAVC 4K Class480/ Imposta il formato video per la registrazione su
per il clip SDI secondario. XAVC 4K Class300/XAVC QFHD  una scheda di memoria SxS.

: Class480/XAVC QFHD Class300/
Shooting > 'Look o ' MPEG HD P/MPEGHD i
Esegue impostazioni relative al Preset Look Sub Rec Format Rec Off/MPEG HD P/MPEGHD i  Seleziona il formato di registrazione secondaria

Voce di menu Impostazioni Descrizione per le schede di memoria SxS.

Category Preset Look Visualizza la categoria della LUT, SxS/Output x2.0 Mostra lo stato del processo di de-squeeze per i

Preset Look Select $709/R709(800%) Seleziona il Preset Look. De-Squeeze segnali di registrazione SxS e per i segnali di uscita
Emette in uscita immagini adatte come punto di video.
partenza per procedure di color grading o Appare solo quando Imager Mode é impostata su
immagini simili alla stampa su pellicola. 4K 4:3.

s709: Colore cinema

Project > Assignable Button
R709(800%): Colore fedele ! )

Assegna funzioni ai tasti programmabili.

! Le opzioni sono: 1/60 e valori successivi quando la frequenza fotogrammi di progetto & 59.94; 1/50 e valori successivi

. - - R ) N R Per informazioni dettagliate sull'assegnazione delle funzioni, fare riferimento a “Schermata funzioni utente” (pagina 32).
quando e 50.0; 1/30 e valori successivi quando € 29.97; 1/25 e valori successivi quando & 25.0. ! zlon! glate su gnaz e en unzionty (pagi )

2 Le opzioni sono: 1/7000 e valori precedenti quando la frequenza fotogrammi di progetto e 50.0 0 25.0; e 1/6000 e valori Voce di menu Impostazioni Descrizione

precedenti quando é 24.0 0 23.98.

<1> pagina 32 Assegna una funzione al tasto programmabile 1.
<2> pagina 32 Assegna una funzione al tasto programmabile 2.
<3> pagina 32 Assegna una funzione al tasto programmabile 3.
<4> pagina 32 Assegna una funzione al tasto programmabile 4.
<User 1> pagina 32 Assegna una funzione al tasto ITEM 1.
<User 2> pagina 32 Assegna una funzione al tasto ITEM 2.
<User 3> pagina 32 Assegna una funzione al tasto ITEM 3.
<User 4> pagina 32 Assegna una funzione al tasto ITEM 4.

<User 5> pagina 32 Assegna una funzione al tasto ITEM 5.
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Project > All File
Esegue impostazioni relative ai file All-settings.

Voce di menu Impostazioni

Descrizione

Menu TC/Media

| valori predefiniti sono sottolineati e in grassetto.

TC/Media > Timecode

Esegue impostazioni relative al codice temporale.

Voce di menu Impostazioni

Descrizione

Load SD Card Carica un file All-settings da una scheda SD.

Save SD Card Salva un file All-settings su una scheda SD.

File ID Visualizza l'identificativo di file del file All-settings
per la modifica.

Format SD Card Formatta una scheda SD.

Mode Preset F-Run (Ext-Lk)/
Preset R-Run/Int Regen

Seleziona la modalita del codice temporale.

Preset F-Run (Ext-Lk): Il codice temporale avanza
senza interruzione, a partire dal valore
specificato, in sincronia con un codice
temporale esterno in ingresso.

Preset R-Run: Il codice temporale avanza,
proseguendo dal valore specificato, solo
durante la registrazione.

Int Regen: lavanzamento del codice temporale
prosegue da quello del clip precedente.

Manual Setting Da 00:00:00:00 a 23:59:59:29

Imposta un valore di codice temporale arbitrario.

Reset Execute/Cancel Ripristina il codice temporale su 00:00:00:00
(eseguire selezionando Execute).

TC Format DF/NDF Seleziona il formato del codice temporale.
DF: Drop frame
NDF: Non drop frame

TC Source Internal/External Visualizza la sorgente di sincronizzazione del TCG.

Time Data Display Timecode/Duration

Seleziona i dati temporali da visualizzare.

TC/Media > Clip Name Format

Imposta il nome dei clip. (Nome del clip: Camera ID + Reel Number + Shot Number + data + stringa

casuale)
Voce di menu Impostazioni Descrizione
Camera ID DallaAallaZ Imposta I'ID della videocamera per la generazione
di nomidi clip.
Reel Number Da 001 a999 Imposta la parte numerica del Reel Number
utilizzato per la generazione di nomi dei clip.
Camera Position C/L/R Imposta la stringa di caratteri della prima porzione

dello Shot Number utilizzato per la generazione di
nomi dei clip.
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TC/Media > Format Media A
4 ec o Menu Monitoring
Formatta i supporti di memorizzazione.
Voce di menu Impostazioni Descrizione
AXS Slot A Execute/Cancel Inizializza la scheda di memoria AXS contenuta I valori predefiniti sono sottolineati e in grassetto.
(Solo se & montato un nello slot A (eseguire selezionando Execute). Monitoring > Output Format
registratore AXS-R7) Esegue impostazioni relative al formato di uscita.
AXS Slot B Execute/Cancel Inizializza la scheda di memoria AXS contenuta Voce di menu Impostazioni Descrizione
(SO!O se & montato un nello slot B (eseguire selezionando Execute). SDI 1/2 Le impostazioni disponibili Seleziona il formato di uscita SDI 1/2.
registratore AXS-R7) variano a seconda della modalita  Le impostazioni disponibili variano in base al
SXS Slot A Execute/Cancel Inizializza la scheda di memoria SxS contenuta Imager, della frequenza formato di registrazione (pagina 66).
nello slot A (eseguire selezionando Execute). fotogrammi di progetto e del
SxS Slot B Execute/Cancel Inizializza la scheda di memoria SxS contenuta formato di registrazione SxS.
nello slot B (eseguire selezionando Execute). SDI'3/4 Le impostazioni disponibili Seleziona il formato di uscita SDI 3/4.
SD Card Execute/Cancel Formatta la scheda SD (esequire selezionando variano in base allimpostazione  Le impostazioni disponibili variano in base al
Execute). di SDI 1/2. formato di registrazione (pagina 66).
- R Monitor Le impostazioni disponibili Seleziona il formato di uscita Monitor
TC/Media > Update Media : P . . p ) ) . I )
Aatonme 1) fle e st del suppario variano in base allimpostazione  Le impostazioni disponibili variano in base al
— | - 5 di SDI'1/2. formato di registrazione (pagina 68).
oce di menu mpostazioni escrizione : - - . ; T
: - — - - HDMI Le impostazioni disponibili Seleziona il formato di uscita HDMI.
AXS SIOt‘A Execute/Cancel Agglorr']a il file di gestione della scheda di variano in base allimpostazione  Le impostazioni disponibili variano in base al
(Solo se € montato un memoria AXS contenuta nello slot A del disDI1/2. formato di registrazione (pagina 68).
registratore AXS-R7) registratore AXS (eseguire selezionando Execute).
AXS Slot B Execute/Cancel Aggiorna il file di gestione della scheda di MonEltorlng‘> Utz OSP i relative adlinf ionilellnee di quad ) | o ) |
(Solo se & montato un memoria AXS contenuta nello slot B del segue impostazioni relative ad informazioni e linee di quadro sovraimposte sul segnale in uscita su
registratore AXS-R7) registratore AXS (eseguire selezionando Execute). mirno.
SXS Slot A Execute/Cancel Aggiorna il file di gestione della scheda di Voce di menu T(EEE FElT] Dicic 2o
memoria SxS contenuta nello slot A (eseguire Status Info On/Off Attiva o disattiva la sovraimpressione di varie
selezionando Execute). informazioni sul segnale in uscita sul mirino.
SxS Slot B Execute/Cancel Aggiorna il file di gestione della scheda di Status Info Select Info. A/Info. B Seleziona le informazioni da visualizzare in
memoria SxS contenuta nello slot B (eseguire sovraimpressione sul segnale in uscita sul mirino.
selezionando Execute). Frame Line On/Off Attiva o disattiva la sovraimpressione delle linee di
quadro sul segnale in uscita sul mirino.
Frame Line Select Frame Line A/Frame Line B Seleziona il tipo di linee di quadro da visualizzare
in sovraimpressione sul segnale in uscita sul
mirino.

Monitoring > SDI OSD
Esegue impostazioni relative ad informazioni e linee di quadro sovraimposte sul segnale in uscita SDI.

Voce di menu Impostazioni Descrizione

Status Info On/Off Attiva o disattiva la sovraimpressione di varie
informazioni sul segnale di uscita SDI 3/4.

Status Info Select Info. A/Info. B Seleziona le informazioni da visualizzare in
sovraimpressione sul segnale di uscita SDI 3/4.
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Monitoring > SDI OSD

Esegue impostazioni relative ad informazioni e linee di quadro sovraimposte sul segnale in uscita SDI.

Voce di menu Impostazioni

Descrizione

Monitoring > Status Info A

Esegue impostazioni relative alle informazioni visualizzate sullimmagine di uscita quando Status Info
Select e impostato su “Info. A" per ciascuna voce del menu OSD.

Frame Line On/Off

Attiva o disattiva la sovraimpressione delle linee di
quadro sul segnale di uscita SDI 3/4.

Frame Line Select Frame Line A/Frame Line B

Seleziona le linee di quadro da visualizzare in
sovraimpressione sul segnale di uscita SDI 3/4.

Voce di menu Impostazioni Descrizione

VF Status On/Off Visualizza o meno l'indicatore dello stato del
mirino.

Lens Status On/Off Visualizza 0 meno informazioni sull'obiettivo.

Monitoring > Monitor OSD

Esegue impostazioni relative ad informazioni e linee di quadro sovraimpresse sul segnale di uscita

Monitoring > Status Info B

Esegue impostazioni relative alle informazioni visualizzate sullimmagine di uscita quando Status Info

Monitor/HDMI. Select e impostato su “Info. B per ciascuna voce del menu OSD.
Voce di menu Impostazioni Descrizione Voce di menu Impostazioni Descrizione
Status Info On/Off Attiva o disattiva la sovraimpressione di varie Project On/Off Visualizza o meno informazioni di progetto.
informazioni sul segnale di uscita Monitor/HDMI. Timecode On/Off Visualizza o meno informazioni di codice
Status Info Select Info. A/Info. B Seleziona le informazioni da visualizzare in temporale.
;OSS;mDFESSIOHQ sul segnale di uscita Monitor/ Audio Level Meter On/Off Visualizza o meno gli indicatori di livello audio.
On/Of : g | Jole] g Look Status On/Off Visualizza o meno l'indicatore del tipo di Look.
Frame Line n/O Attiva o disattiva la sovraimpressione delle linee di . . ) - . ;
- ) ) P . Output LUT On/Off Visualizza o meno informazioni relative alla LUT di
quadro sul segnale di uscita Monitor/HDMI. Uscita
Frame Line Select Frame Line A/Frame Line B Seleziona le linee di quadro da visualizzare in - — - - ) :
) ) q . . ) Recording LUT On/Off Visualizza o meno informazioni relative alla LUT di
sovraimpressione sul segnale di uscita Monitor/ ) )
HDMI registrazione.
VF Status On/Off Visualizza o meno l'indicatore dello stato del
Monitoring > HDMI OSD mirino.
Esegue impostazioni relative alle informazioni sovraimposte sul segnale in uscita HDMI. Lens Status On/Off Visualizza 0 meno informazioni sullobiettivo.

Voce di menu Impostazioni

Descrizione

OSD Status Same as SDI/Same as Monitor

Specifica se le informazioni visualizzate in
sovraimpressione sul segnale di uscita HDMI
devono essere identiche a quelle del segnale di
uscita SDI o a quelle del segnale di uscita Monitor.

Monitoring > Display Info

Esegue impostazioni relative alla visualizzazione delle unita di misura per la messa a fuoco.

Voce di menu Impostazioni

Descrizione

Monitoring > Status Info A

Esegue impostazioni relative alle informazioni visualizzate sullimmagine di uscita quando Status Info
Select e impostato su “Info. A" per ciascuna voce del menu OSD.

Focus Distance Format  Meter/Feet

Seleziona I'unita di misura visualizzata per la
posizione di messa a fuoco.

Monitoring > Frame Line A

Esegue impostazioni relative alle informazioni visualizzate sullimmagine di uscita quando Frame Line e
impostata su Frame Line A per ciascuna voce del menu OSD.

Voce di menu Impostazioni Descrizione

Project On/Off Visualizza 0 meno informazioni di progetto. Voce di menu Impostazioni Descrizione

Timecode On/Off Visualizza o meno informazioni di codice Center Marker On/Off Visualizza o meno l'indicatore di centro quadro.
o temporale. Aspect Ratio On/Off Visualizza o meno l'indicazione di aspetto.

Audio Level Meter On/Off Visualizza 0 meno gli indicatori di livello audio. Aspect Safety Zone On/Off Visualizza 0 meno l'indicazione della zona di

Look Status On/Off Visualizza 0 meno l'indicatore del tipo di Look. sicurezza per l'aspetto.

Output LUT On/Off Visualizza 0 meno informazioni relative alla LUT di Picture Area On/Off Yisua\izza o meno l'indicazione della zona di

uscita. immagine.
Recording LUT On/Off Visualizza 0 meno informazioni relative alla LUT di Safety Zone On/Off Visualizza 0 meno l'indicazione della zona di

registrazione.

sicurezza.
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Monitoring > Frame Line A
Esegue impostazioni relative alle informazioni visualizzate sullimmagine di uscita quando Frame Line e
impostata su Frame Line A per ciascuna voce del menu OSD.

Monitoring > Frame Line
Esegue impostazioni relative alle linee e agli indicatori visualizzati sullimmagine di uscita.

Voce di menu Impostazioni Descrizione

Voce di menu

Impostazioni

Descrizione

On/Off Visualizza o meno l'indicatore delle linee di

quadro utente.

User Frame Line

Frame Line on Playback On/Off

Attiva o disattiva la sovraimpressione delle linee di
quadro durante la riproduzione.

Monitoring > Frame Line B
Esegue impostazioni relative alle informazioni visualizzate sullimmagine di uscita quando Frame Line e
impostata su Frame Line B per ciascuna voce del menu OSD.

Monitoring > User Frame Line

Esegue impostazioni relative alle linee di quadro utente.

Voce di menu

Impostazioni

Descrizione

Width

Da 3 a479 (240)

Specifica la larghezza della linea di quadro utente

Voce di menu Impostazioni Descrizione (distanza dal centro ai bordi destro e sinistro).
Center Marker On/Off Visualizza o meno l'indicatore di centro quadro. Height Da 3 a 269 (135) Specifica I'altezza della linea di quadro utente
Aspect Ratio On/Off Visualizza 0 meno lindicazione di aspetto. (distanza dal centro ai bordi superiore e inferiore).
Aspect Safety Zone On/Off Visualizza o meno l'indicazione della zona di H Position Max. da -476 a 476 (+£0) Specifica la posizione orizzontale del centro delle
sicurezza per l'aspetto. linee di quadro utente.
Picture Area On/Off Visualizza o meno l'indicazione della zona di La gamma di valori disponibili si restringe con
immagine. I'aumento al di sopra del valore di 3
Safety Zone On/Off Visualizza o meno lindicazione della zona di dellimpostazione di Width.
sicurezza. V Position Max. da —266 a 266 (+0) Specifica la posizione verticale del centro delle
User Frame Line On/Off Visualizza o meno l'indicatore delle linee di quadro linee di quadro utente.

utente.

Monitoring > Frame Line
Esegue impostazioni relative alle linee e agli indicatori visualizzati sullimmagine di uscita.

La gamma di valori disponibili si restringe con
I'aumento al di sopra del valore di 3
dellimpostazione di Height.

Voce di menu Impostazioni Descrizione
Color White/Yellow/Cyan/Green/ Seleziona il colore delle linee di quadro.
Magenta/Red/Blue

Monitoring > VF Display
Esegue impostazioni relative alla visualizzazione sul mirino.

Voce di menu

Impostazioni

Descrizione

Center Marker

Cross/Open Cross/Dot

Seleziona il tipo di indicatore centro immagine.

Safety Area

80%/90%/92.5%/95%

Seleziona la percentuale della zona di sicurezza.

VFLUT

Log/s709/R709(800%)

Seleziona la LUT da applicare allimmagine in
uscita sul mirino.

Aspect Ratio Type

Line/Mask

Seleziona il tipo di indicazione di aspetto
visualizzata.

Line: Visualizza linee, nel colore impostato con
Color.

Mask: Visualizza un livello di segnale video
inferiore per le aree esterne all'indicatore.

Aspect Ratio Select

17:9/16:9/15:9/14:9/13:.9/4:3/
1.66:1/1.85:1/2.35:1/2.39:1

Seleziona la modalita di visualizzazione
dellindicazione di aspetto.

Status Info On/Off Attiva o disattiva la sovraimpressione delle
informazioni sullimmagine in uscita sul mirino.

Status Info Select Info. A/Info. B Seleziona le informazioni da visualizzare in
sovraimpressione sullimmagine in uscita sul
mirino.

Frame Line On/Off Attiva o disattiva la sovraimpressione delle linee di

quadro sull'immagine in uscita sul mirino.

Aspect Ratio Mask

Da0al15(12)

Seleziona la luminosita dell'immagine all'esterno
dellindicazione di aspetto quando Aspect Ratio
Type e impostato su Mask.

Frame Line Select

Frame Line A/Frame Line B

Seleziona il tipo di linee di quadro da visualizzare
in sovraimpressione sullimmagine in uscita sul
mirino.

Aspect Safety Area

80%/90%/92.5%/95%

Seleziona le dimensioni (percentuale dello
schermo intero) dell'indicazione della zona di
sicurezza aspetto.

Color

Da-99a+0a+99

Specifica la profondita di colore dell'immagine del
mirino.
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Monitoring > VF Function

Esegue impostazioni relative alle funzioni del mirino.

Menu Audio

I valori predefiniti sono sottolineati e in grassetto.

Audio > Audio Input
Esegue impostazioni relative ai livelli di registrazione audio.

Voce di menu Impostazioni Descrizione

Double Speed Scan On/Off Attiva o disattiva la funzione di scansione a
doppia velocita del mirino.

Peaking Frequency Normal/High Specifica se il peaking deve utilizzare una
frequenza normale o una frequenza piu alta.

Zebra On/Off Attiva o disattiva la funzione zebra.

Zebra Select 1/2/Both Seleziona il motivo zebra (Zebra 1, Zebra 2 o0 Both

per entrambi).

Zebral Level

Da 0% a 107% (41%)

Specifica il livello di visualizzazione del motivo
Zebra 1.

Zebral Aperture Level

Da 1% a 20% (10%)

Specifica il livello di apertura del motivo Zebra 1.

[Nota]

Il livello di registrazione audio con segnale AES/EBU é fisso.

Voce di menu Impostazioni Descrizione

CH-1 Audio Select Auto/Manual Se impostato su Auto, regola automaticamente il
livello di registrazione audio.

CH-2 Audio Select Auto/Manual Se impostato su Auto, regola automaticamente il

livello di registrazione audio.

Zebra2 Level

Da 0% a 109% (61%)

Specifica il livello di visualizzazione del motivo
Zebra 2.

CH-1 Audio Level Da-99a+0a+99 Regola il livello di registrazione audio quando

CH-1 Audio Select € impostato su Manual.

CH-2 Audio Level Da-99a+0a+99 Regola il livello di registrazione audio quando

CH-2 Audio Select e impostato su Manual.

MIC Reference -60dB/-50dB/-40dB Seleziona il livello di riferimento di ingresso del

microfono.

Audio > Audio Monitor
Esegue impostazioni relative ai livelli di monitoraggio audio.

Voce di menu Impostazioni Descrizione

Monitor CH Quando Monitor Output CH Pair ~ Seleziona il canale audio emesso su cuffie e
€ impostato su CH-1/CH-2 altoparlante.
CH-1/CH-2, CH-1, CH-2 CH-1/CH-2 (CH-3/CH-4): Canale 142 (Canale 3+4)
Quando Monitor Output CH Pair  CH-1 (CH-3): Solo canale 1 (Canale 3)
€ impostato su CH-3/CH-4 CH-2 (CH-4): Solo canale 2 (Canale 4)

CH-3/CH-4, CH-3,CH-4

Monitor Level Da0a99 Regola il livello dell'audio di monitoraggio.

Audio > Audio Configuration
Esegue impostazioni relative ai livelli di ingresso/uscita audio.

Voce di menu Impostazioni Descrizione

Off/-6dB/-9dB/-12dB/-15dB/  Selezionare la caratteristica del limitatore (livello di

-17dB saturazione) per i segnali di ingresso di livello
elevato rilevati durante la regolazione manuale
del livello di ingresso audio. Selezionare Off se si
preferisce non utilizzare il limitatore.

Input Limiter Mode

AGC Level -6dB/-9dB/-12dB/-15dB/-17dB Seleziona la caratteristica del’AGC (livello di

saturazione).
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Audio > Audio Configuration
Esegue impostazioni relative ai livelli di ingresso/uscita audio.

Menu Technical

I valori predefiniti sono sottolineati e in grassetto.

Technical > Test Signals

Esegue impostazioni relative alle barre di colore.

Voce di menu Impostazioni Descrizione

AGC Mono/Stereo Mono/Stereo Regola automaticamente il livello di ingresso dei
segnali audio analogici registrati sui canali 1e2 e
consente di selezionare se tale regolazione deve
essere eseguita per ciascun canale
indipendentemente (Mono) o in modalita stereo
(Stereo).

MIC Input Mono/ Mono/Stereo Specifica se il microfono anteriore € mono o

Stereo stereo.

Phantom Power +48V  On/Off Attiva o disattiva la funzione di alimentazione

esterna a +48V per il microfono (alimentazione
phantom).

Voce di menu Impostazioni Descrizione

Color Bars On/Off Attiva o disattiva la visualizzazione delle barre di
colore.

Color Bars Type ARIB/SMPTE Seleziona il tipo di barre di colore.

1KHz Tone on Color On/Off Attiva o disattiva I'emissione di un segnale

Bars acustico di prova a 1 kHz durante la
visualizzazione delle barre di colore.

Test Saw On/Off Attiva o disattiva il segnale di test.

Monitor Output CH CH-1/CH-2, CH-3/CH-4 Imposta la coppia di canali di uscita audio sui
Pair canali 1 e 2 oppure sui canali 3 e 4.
Headphone Mono/ST ~ Mono/Stereo Imposta I'uscita cuffie su mono o stereo.

Technical > Switch & Rec Light
Esegue impostazioni relative al tasto REC.

Voce di menu

Impostazioni

Descrizione

Lock Operator Side

without Rec Button/with Rec
Button

Specifica se bloccare o meno il funzionamento
del tasto REC quando gli altri tasti sono stati
bloccati con il selettore LOCK sul lato operatore.

Lock Assistant Side

without Rec Button/with Rec
Button

Specifica se bloccare o meno il funzionamento
del tasto REC quando gli altri tasti sono stati
bloccati con il selettore LOCK sul lato assistente.

Rec Light

On/Off

Attiva o disattiva la spia REC.

Rec Start/Stop Beep

On/Off

Attiva o disattiva I'emissione di un segnale
acustico all'avvio e all'arresto della registrazione.
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Technical > System Configuration

Esegue impostazioni relative al funzionamento dell'unita.

Technical > Battery
Esegue impostazioni relative alle batterie.

Voce di menu Impostazioni Descrizione Voce di menu Impostazioni Descrizione
Fan Control Auto/Max/Off in Rec/Auto/ Seleziona la modalita di comando della ventola. Near End:Info Battery ~ Da 5% a 100% (incrementi del Imposta il valore di soglia al quale l'indicatore
Off in Rec/Max Auto: La ventola viene attivata automaticamente 5%) della capacita rimanente della batteria comincia a

in risposta alla temperatura interna della
videocamera.

Max: La ventola opera sempre alla massima
velocita.

Off in Rec/Auto: La ventola e silenziosa durante la
registrazione, ma si attiva automaticamente in
risposta alla temperatura interna quando la
videocamera non sta registrando.

Off in Rec/Max: La ventola e silenziosa durante la
registrazione ma si attiva alla velocita
massima quando la videocamera non sta
registrando.

lampeggiare se e utilizzata una batteria
InfoLithium.

End:Info Battery Da 0% a 5%

Imposta il valore di soglia per la visualizzazione
dell'avvertenza “Battery End” quando si utilizza
una batteria InfoLithium.

Da 11.5V a 17V (in incrementi di
0.1V)

Near End:Sony Battery

Imposta il valore di soglia al quale I'indicatore
della capacita rimanente della batteria comincia a
lampeggiare se e utilizzata una batteria Sony di
tipo non InfolLithium.

Lens Interface Type C/Off

Consente di specificare il tipo di interfaccia
dell'obiettivo (prima del montaggio) in base
all'obiettivo utilizzato.

[Nota]

Se é necessario cambiare questa impostazione mentre
|'obiettivo & gia montato, e necessario anche spegnere e
riaccendere I'unita.

Da 11.0Va 11.5V (in incrementi

di0.1V)

End: Sony Battery

Imposta il valore di soglia per la visualizzazione
dell'avvertenza “Battery End” quando si utilizza
una batteria Sony di tipo non InfoLithium.

Near End:Other Battery Da 11.5Va 17V (11.8V) (in Imposta il valore di soglia al quale l'indicatore
incrementi di 0.1V) della capacita rimanente della batteria comincia a
lampeggiare se & utilizzata una batteria non Sony.
End:Other Battery Da 11.0V a 14V (inincrementidi  Imposta il valore di soglia per la visualizzazione

0.1v)

dell'avvertenza “Battery End” quando si utilizza
una batteria non Sony.

SDI Rec Remote Trigger Off/HD SDI Remote I/F/Parallel
Rec

Seleziona il metodo di comando a distanza SDI.

Off: Disabilita il comando a distanza.

HD SDI Remote I/F: Utilizza la modalita di
comando a distanza HD SDI Remote.

Parallel Rec: Utilizza il metodo di comando a
distanza tramite flag validi.

Detected Battery Sony Info Battery/Sony Battery/
Other Battery/DCIN (12V)/DC IN

(24V)

Visualizza i risultati del rilevamento automatico
del tipo di batteria.

Technical > DC Voltage Alarm
Imposta allarmi relativi all'alimentazione c.c. esterna.

SD HDMI On/Off

Attiva o disattiva la funzione di impostazione del
segnale di uscita HDMI sul formato SD.

Shutter Mode Speed/Angle

Seleziona la modalita operativa dell'otturatore
elettronico.

Technical > APR

Esegue la funzione APR (Auto Pixel Restoration: regolazione automatica del sensore immagini).

Voce di menu Impostazioni Descrizione
DC Low Voltage1 Da11.5Va 17V (inincrementidi  Imposta il valore di soglia per la visualizzazione
0.1V) dell'avvertenza di bassa tensione quando si

utilizza una sorgente di alimentazione connessa al
connettore DC IN.

DC Low Voltage? Da 11.0V a 14V (in incrementi di

0.1V)

Imposta il valore di soglia per la visualizzazione
dell'avvertenza di tensione insufficiente quando si
utilizza una sorgente di alimentazione connessa al
connettore DC IN.

Voce di menu Impostazioni Descrizione

APR Execute/Cancel Esegue la funzione di riduzione automatica del
rumore pixel (eseguire selezionando Execute).

Reset Execute/Cancel Elimina le macchiette bianche aggiunte

dall'esecuzione delle funzioni APR e
bilanciamento automatico del nero (eseguire
selezionando Execute).

DC(24V) Low Voltagel Da 22.5V a 34.0V (in incrementi

di0.1v)

Imposta il valore di soglia per la visualizzazione
dell'avvertenza di bassa tensione quando si
utilizza una sorgente di alimentazione a 24V
connessa al connettore DC IN.
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Technical > DC Voltage Alarm
Imposta allarmi relativi all'alimentazione c.c. esterna.

Voce di menu Impostazioni

Descrizione

DC(24V) Low Voltage2  Da 22.0V a 28.0V (in incrementi
di0.1V)

Imposta il valore di soglia per la visualizzazione
dell'avvertenza di tensione insufficiente quando si
utilizza una sorgente di alimentazione a 24V
connessa al connettore DC IN.

Menu Maintenance

I valori predefiniti sono sottolineati e in grassetto.

Maintenance > Clock Set

Esegue impostazioni relative all'orologio incorporato.

Technical > Control Display
Esegue impostazioni relative ai display.

Voce di menu Impostazioni

Descrizione

Brightness level High/Mid/Low/Minimum

Regola la luminosita del display secondario e del
mini display.

Technical > Genlock
Esegue impostazioni relative alla funzione Genlock.

Voce di menu Impostazioni

Descrizione

Input Source HD SDI/Analog

Seleziona il segnale di ingresso genlock.
HD SDI: Digitale
Analog: Analogico

Voce di menu Impostazioni Descrizione
Time Zone Da UTC + 14:00 a UTC Specifica la differenza rispetto all'ora UTC (ora del
Greenwich a UTC - 12:00 (in meridiano di Greenwich) in incrementi di
incrementi di 30 minuti) 30 minuti.
Date Mode YYMMDD/MMDDYY/DDMMYY  Seleziona il formato di visualizzazione della data.
YYMMDD: Anno, mese, giorno
MMDDYY: Mese, giorno, anno
DDMMYY: Giorno, mese, anno
Date Imposta la data corrente (applicare premendo
Set).
Time Imposta l'ora corrente (applicare premendo Set).

Internal/External(HD)/
External(SD)

Reference Lock Type

Visualizza lo stato genlock. Visualizza il tipo di
segnale dopo l'esecuzione del genlock.
Internal: Nessun genlock.

External(HD): Aggancio genlock da segnale HD.
External(SD): Aggancio genlock da segnale SD.

Maintenance > Language
Seleziona la lingua per messaggi e menu.

Voce di menu Impostazioni

Descrizione

Select

English/ A3 (1)

Seleziona la lingua per messaggi e menu
completo.

Maintenance > Hours Meter
Visualizza il tempo cumulativo di utilizzo.

Voce di menu Impostazioni Descrizione

Camera(System) Visualizza le ore d'uso totali dell'unita (non puo
essere azzerato).

R7 Recorder Visualizza le ore d'uso totali del registratore AXS

(System) montato sull'unita (non puo essere azzerato).

(Solo se & montato un

registratore AXS-R7)

Camera(Resettable) Visualizza le ore d'uso totali dell'unita (puo essere
azzerato).

R7 Recorder Visualizza le ore d'uso totali del registratore AXS

(Resettable) montato sull’'unita (puod essere azzerato).

(Solo se & montato un

registratore AXS-R7)

Reset-Cam Execute/Cancel Azzera il contaore Camera(Resettable) (eseguire

(Resettable)

selezionando Execute).
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Maintenance > Hours Meter
Visualizza il tempo cumulativo di utilizzo.

Voce di menu Impostazioni Descrizione

Reset-R7 Execute/Cancel Azzera il contaore R7 Recorder(Resettable) del
(Resettable) registratore AXS montato sull'unita (eseguire
(Solo se & montato un selezionando Execute).

registratore AXS-R7)

Maintenance > Reset to Default
Ripristina le impostazioni predefinite di fabbrica dell'unita.

Voce di menu Impostazioni Descrizione

Reset Execute/Cancel Inizializza tutte le impostazioni dell'unita (eseguire
selezionando Execute).

Maintenance > License Options
Installa opzioni software.

Voce di menu Impostazioni Descrizione
Install: <licenza_ Execute/Cancel Installa opzioni software (eseguire selezionando
desiderata> Execute).
Anamorphic Permanent License Installed/ Indica se l'opzione Anamorphic & attiva.
XX days Remaining (YY keys)/ Permanent License Installed: E installata una
Expired/Not Installed licenza permanente.

XX days Remaining (YY keys): Scadenza della
licenza temporanea.

Expired: La licenza temporanea e scaduta.
Not Installed: Non installata

Full Frame Permanent License Installed/ Indica se l'opzione Full Frame é attiva.
XX days Remaining (YY keys)/ Permanent License Installed: £ installata una
Expired/Not Installed licenza permanente.

XX days Remaining (YY keys): Scadenza della
licenza temporanea.

Expired: La licenza temporanea é scaduta.
Not Installed: Non installata

Unique Device ID Visualizza l'identificativo utilizzato per l'emissione
della chiave di licenza per le opzioni software.

Maintenance > Firmware
Visualizza la versione dell’'unita e del registratore AXS e aggiorna I'unita

Voce di menu Impostazioni Descrizione

Camera Visualizza la versione del firmware dell'unita (Vx.
XX).

AXS Visualizza la versione del firmware del registratore

(Solo se & montato un AXS montato sull'unita (Vx.xx).

registratore AXS-R7)

FW Update-camera Execute/Cancel Aggiorna l'unita (eseguire selezionando Execute).
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Schermata dell'elenco dei clip

1S
TCR 00:00:00:00

>

Dur 00:00:01:56

=

12
)
g
7/
6

=

XAVC QFHD C480

2018/1/1 11:30

IS

. Tasto di selezione supporto

Mostra “SxS/AXS” se sono riproducibili sia
supporti SxS che supporti AXS. Premere il tasto
ITEM 1 per passare da un supporto all‘altro.

. Tasto cursore in alto

Premere il tasto ITEM 2 per selezionare
nell'elenco il clip da riprodurre.

. Tasto di avvio della riproduzione

Premere il tasto ITEM 3 per visualizzare la
schermata di riproduzione (pagina 13) e
awviare la riproduzione.

Operazioni sui clip

2

[

A001C001_180101CQ
A001C002_180101G7
A001C003_180101HR
A001C004_180101WK

A001C005_180101S8
A001C006_180101GF

@
5

Per operare sui clip, € possibile utilizzare la schermata dell'elenco dei clip e la schermata di riproduzione.
E possibile riprodurre un clip selezionandolo nella schermata dell'elenco dei clip visualizzata sul display
secondario.
| supporti AXS possono essere riprodotti quando AXS Rec Format non e impostato su Rec Off nella
categoria Project. Analogamente, i supporti SxS possono essere riprodotti quando SxS Rec Format non &
impostato su Rec Off.

Premere il tasto CLIPS (pagina 8) sul lato assistente per visualizzare sul display secondario l'elenco dei
clip contenuti sul supporto attivo per la riproduzione.

3

() Subf
a4 B
a B 4
a B
a B
a4 B

Elenco dei clip

Visualizza I'elenco dei clip disponibili sul
supporto attivo per la riproduzione. Visualizza
anche lo stato dei clip mediante icone.

Icona Significato

Sub Clip con sub clip creato

Clip bloccato (protetto contro la
scrittura)

. Tasto cursore in basso

Premere il tasto ITEM 5 per selezionare
nellelenco il clip da riprodurre.

10.

11.

12.

Posizione del clip sul supporto di
riproduzione

Indica il numero del clip evidenziato dal
cursore e il numero totale dei clip presenti.

Data e ora di creazione
Indica la data e l'ora di creazione del clip
evidenziato dal cursore.

Formato (codec)
Indica il formato di registrazione (codec) del
clip evidenziato dal cursore.

Indicazione frequenza fotogrammi/
dimensioni immagine

Indica la frequenza fotogrammi di progetto e
le dimensioni di immagine del clip evidenziato
dal cursore.

Durata (Dur)
Indica la durata del clip evidenziato dal
cursore.

Codice temporale (TCR)
Indica il codice temporale del primo
fotogramma del clip evidenziato dal cursore.

Supporto di riproduzione attivo
Indica il supporto di riproduzione attivo fra
quelli visualizzati in elenco.
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Schermata di riproduzione

La schermata di riproduzione appare quando si seleziona un clip da riprodurre nella schermata dell'elenco

dei clip e si preme il comando MENU o il tasto Play (tasto ITEM 3).

Area di visualizzazione delle funzioni

1.

2.

3.

1

2

bur 00:00:00:00 23.98fps 3.8K 16:9

> x24 DCIN 15.0V FPS 60

SXS @ 002/010 XAVCQFHD C480

A001C002_160328WW &

<< |
» Prev Stop/Clips
4 5

. Tasto Prev

Tasto F Rev
Esegue la riproduzione ad alta velocita in
direzione indietro.

Tasto Play/Pause
Riproduce o mette in pausa la riproduzione di
un clip.

Tasto F Fwd
Esegue la riproduzione ad alta velocita in
direzione avanti.

Salta all'inizio del clip precedente.

. Tasto Stop/Clips

Arresta la riproduzione e torna alla schermata
di elenco dei clip.

. Tasto Next

Salta all'inizio del clip successivo.

Area di visualizzazione stato

1 2

Indicazione dati temporali
Visualizza il codice temporale della posizione
in corso di riproduzione.

Numero clip
Visualizza numero del clip in riproduzione
corrente/Numero totale di clip riproducibili.

Indicatore frequenza fotogrammi/modalita
Imager

Visualizza la frequenza fotogrammi di progetto
e le dimensioni immagine.

Indicatori di livello audio
Visualizza il livello di riproduzione dell'audio.

Indicazione formato di riproduzione clip
(codec)

Visualizza il formato (codec) del clip in
riproduzione.

. Visualizzazione icone

Visualizza lo stato del clip mediante icone.

Icona Significato

Sub Clip con sub clip creato

Clip bloccato (protetto contro la
scrittura)

Indicatore nome clip
Visualizza il nome del clip.

3

Indicatore supporto
Mostra il supporto riprodotto.

Indicazione dello stato della riproduzione
Visualizza lo stato della riproduzione.
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Riproduzione

E possibile riprodurre clip registrati mentre l'unita
¢ in standby.

[Nota]

| comandi di riproduzione appaiono sui tasti TEM da 1 a 6

(pagina 7). Premere un tasto ITEM per selezionare la voce
corrispondente.

1 Inserire la scheda di memoria SxS da
riprodurre.

2 Premere il tasto CLIPS (pagina 8) sul lato
assistente.
Il display secondario visualizzera un elenco dei
clip disponibili sul supporto di riproduzione
attivo.

3 Premere il tasto q(tasto ITEM2), il tasto §
(tasto ITEM 5) o il comando MENU per
selezionare il clip da riprodurre.

4 Premere il comando MENU o il tasto Play (tasto
ITEM 3).
Lo schermo del mirino visualizzera l'immagine
di riproduzione.

XCON ST

12:34:56:00  A001C001 Play

Operazioni di riproduzione

Le operazioni di riproduzione vengono eseguite

utilizzando i tasti sul display secondario.

(pagina 54)

Tasto Play/Pause: Mette in pausa la riproduzione.
Per riprendere la riproduzione, premere di
nuovo questo tasto.

Tasti F Fwd e F Rev: Avanzamento veloce o ritorno
veloce. Per tornare alla riproduzione normale,
premere il tasto Play/Pause.

Tasto Stop/Clips: Arresta la riproduzione e torna
alla schermata di elenco dei clip.

Monitoraggio dell'audio

Nella modalita di riproduzione normale e possibile
monitorare 'audio registrato tramite I'altoparlante
incorporato (pagina 6) oppure collegando

cuffie alla videocamera.

Quando si collegano cuffie al connettore cuffie
(pagina 6), l'altoparlante incorporato viene
disabilitato.

Le voci in categoria Audio > Monitor CH e Monitor
Level (pagina 38) del menu consentono di
selezionare il canale da monitorare e regolarne il
volume.

Ricerca di clip (cueing)

Per avviare la riproduzione dall'inizio del clip,
premere il tasto Prev sul display secondario
(pagina 27).

Per saltare clip ed avviare l'operazione da un altro
clip, premere ripetutamente i tasti Prev e Next.

Selezione delle schede di memoria SxS

Se sono inserite due schede di memoria SxS,
premere il tasto SLOT SELECT (pagina 7) per
passare da una scheda all‘altra.

[Nota]

Non ¢ consentito passare a un‘altra scheda di memoria
SXS durante la riproduzione. Non e possibile eseguire la
riproduzione continua delle schede contenute negli slot A
eB.

Selezione di una scheda di memoria AXS

E possibile avviare rapidamente la riproduzione
di video registrato su una scheda di memoria AXS
inserita nel registratore AXS-R7.

Per selezionare e passare alla scheda di memoria
AXS, premere il tasto ITEM 1 (pagina 27) sul
display secondario.

Il segnale di riproduzione viene emesso sul
connettore di uscita dell'unita.
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Utilizzo della schermata Home del mini display

La schermata Home del mini display consente

di controllare lo stato dell'unita e configurarne le

principali impostazioni.

1

1. FPS
Mostra la frequenza fotogrammi video.
2. Shutter

Visualizza e imposta angolo o velocita
dell'otturatore elettronico.

3. ND Filter

Visualizza e imposta la densita del filtro ND.

4. Exposure Index

Visualizza e imposta l'indice di esposizione (El).

5. WB (White Balance)
Visualizza e imposta il bilanciamento del
bianco.

Comandi

Tasto HOME (pagina 6)
Premere per tornare alla schermata Home. Le

modifiche non confermate vengono annullate.

Tasto I[TEM 1 () (pagina 6)

Premere per selezionare voci sulla schermata
HOME.

Tasto ITEM 2 (@) (pagina 6)

Premere per applicare la voce selezionata.

Tasto ITEM 3 () (pagina 6)
Premere per selezionare voci sulla schermata
HOME.

Operazioni principali

1

2

Premere il tasto ITEM 1,2 0 3.
Compare il cursore.

Selezionare la voce da impostare utilizzando il
tasto B (tasto ITEM 1) o il tasto & (tasto ITEM
3).

FPS Fixed 24
4 180.0

ND Clear

500
wB 56000

Premere il pulsante @ (tasto ITEM 2).
Viene visualizzata la schermata di selezione del
valore di impostazione della voce selezionata.

[Nota]

l'indicatore @ mostra l'impostazione corrente.

Spostare il cursore sulla voce o sul valore di
impostazione desiderato con i tasti B o &
(rispettivamente tasto ITEM 1 e tasto ITEM 3).

Premere il tasto @ (tasto ITEM 2) per applicare
limpostazione.

Premere il tasto HOME per nascondere il
cursore.
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3. Utilizzo della videocamera: Utilizzo della schermata Home del mini display

Voci della schermata Home nel mini display

Di seguito si elencano i nomi delle voci e i rispettivi valori di impostazione disponibili.
| valori predefiniti sono sottolineati e in grassetto.

Voce

Descrizione

FPS

Mostra la frequenza fotogrammi video. Il valore & determinato dallimpostazione
di categoria Project > Project Frame Rate (pagina 36) nel menu.

Project Frame Rate Display
2398 Fixed 24
24 Fixed 24
25 Fixed 25
29.97 Fixed 30
50 Fixed 50
59.94 Fixed 60

Exposure Index

Imposta il valore di El. Sono disponibili le seguenti impostazioni:
125E1/160El/200E1/250E1/320E1/400EIl/500EI/640EI/800EI/1000El/
1250E1/1600EI/2000E!

Shutter Imposta I'angolo o la velocita dell'otturatore elettronico.
Consente di selezionare uno dei valori di otturazione di preset registrati.
[Nota]
Non é disponibile quando la modalita di funzionamento dell'otturatore elettronico &
impostata su Continuous.
Possono essere selezionate le opzioni indicate di seguito, in base allimpostazione
diTechnical > System Configuration > Shutter Mode (pagina 50) nel menu
completo.
Angle (A): Indicazione dell'angolo dell'otturatore
360.0/180.0/172.8/144.0/90.0/45.0/22.5/11.2"
Speed (SS): Indicazione della velocita dell'otturatore
1/24,1/25,1/30, 1/50, 1/60, 1/100, 1/120, 1/250, 1/500, 1/1000, 1/2000 "
ND Filter Imposta la densita del filtro ND. Sono disponibili le seguenti impostazioni:

Clear/0.3/0.6/0.9/1.2/15/1.8/2.1/2.4

WB (White Balance)

Imposta la temperatura del colore per il bilanciamento del bianco.

Consente di selezionare uno dei valori di bilanciamento del bianco (WB) di preset
reqgistrati.

3200K+00/4300K+00/5500K+00"

) Le opzioni selezionabili possono essere modificate mediante Step Edit nella schermata Home del display secondario.
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4. Ripresa

Operazioni di base

Le procedure descritte di seguito consentono di
eseguire registrazioni di base.

1 Assicurarsi che tutti i dispositivi necessari siano
collegati all'unita e che i dispositivi siano
correttamente alimentati.

2 Spostare l'interruttore di alimentazione
(pagina 6) sulla posizione ON.
Nel mirino viene visualizzata la schermata di
registrazione.

3 Inserire una o piu schede di memoria.
Se vengono inserite due schede di memoria
SxS, la registrazione continua passando
automaticamente alla seconda scheda quando
lo spazio sulla prima si esaurisce.

4 Premere il tasto REC (pagine 6, 8).
La spia REC si illumina e si avvia la
registrazione.

[Nota]

Se l'unita non e in grado di avviare la registrazione
immediatamente dopo aver premuto il tasto REC, la spia
REC lampeggia. La spia REC si illumina all'avvio della
registrazione.

5 Per arrestare la registrazione, premere
nuovamente il tasto REC.
La registrazione si arresta e |'unita passa alla
modalita STBY (standby di registrazione).
Quando si arresta la registrazione, il video,
I'audio e i dati accessori dall'inizio alla fine della
registrazione vengono salvati in un unico clip.

Nome dei clip

Per assegnare il nome ai clip viene utilizzato il

formato “Cam ID + Reel#" Il nome del clip viene

creato secondo le regole descritte di seguito.

® Se nella scheda di memoria SxS o AXS inserita
& gia presente un clip con memorizzato nel
formato di nome “Cam ID + Reel#" il nuovo file
eredita le informazioni dall'ultimo file.
Ad esempio, se sulla scheda di memoria
AXS esiste un clip con il nome “B002C003_
XXXXXXXX", al nuovo clip verra assegnato il
nome “B002C004_XXXXXXXX"

® Se la scheda di memoria AXS inserita non
contiene nessun file, viene aggiunto “1"al Reel
Number del clip registrato per ultimo.
Ad esempio, se si registra su una scheda vuota
(2) dopo aver registrato il clip “D00TCXXX_
XXXXXXXX" su una scheda precedente (1),
al nuovo clip creato successivamente sulla
scheda 2 verra assegnato il nome “D002C001_
XXXXXXXX! Il nome del clip lampeggia fino
all'avvio della registrazione.

® Se siimposta Camera ID e Reel Number con la
voce di categoria TC/Media > Clip Naming del
menu, verranno utilizzati i valori impostati.
Ad esempio, se Camera ID viene cambiato e
impostato su “F"e Reel Number viene impostato
su“001"nel menu della scheda di memoria AXS
sulla quale sono stati registrati clip fino al nome
"EO03CXXX_XXXXXXXX', al clip successivo verra
assegnato il nome “FOOTCXXX_XXXXXXXX". Se si
cambia solo Camera ID, il Reel Number diventa
‘001"

Durata massima di un clip

La lunghezza massima di un singolo clip
registrabile su una scheda di memoria SxS e di 6
ore.

La registrazione si arresta se il tempo di
registrazione eccede la durata massima consentita

per il clip.
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Funzioni utili

Registrazione simultanea (Simul Rec)

Questa funzione consente di registrare
simultaneamente immagini in due dimensioni
diverse sulla stessa scheda di memoria SxS
inserita in uno slot. E possibile anche registrare un
segnale HD sulla scheda di memoria SxS dell'unita
contemporaneamente a video e audio in formato
RAW sul registratore AXS-R7.

E possibile eseguire la registrazione simultanea
tramite le voci in categoria Project > AXS Rec
Format e SxS Rec Format oppure SxS Rec Format
e Sub Rec Format nel menu, come descritto
in“Impostazioni del formato di registrazione”
(pagina 39).

[Nota]

Nella modalita di registrazione simultanea, I'unita non € in

grado di passare automaticamente a una seconda scheda,
neanche nel caso in cui si esaurisca lo spazio sulla prima.

Nella modalita di registrazione simultanea su uno
slot, il clip XAVC 4K Class480/XAVC 4K Class300/
XAVC QFHD Class480/XAVC QFHD Class300 viene
registrato nella directory XDROOT/Clip della
scheda di memoria SxS, mentre il clip MPEG2
1920x1080 viene registrato nella directory
XDROQT/Sub. Al nome del clip viene aggiunto il
suffisso “S02".

Revisione della registrazione
(Rec Review)

Funzione di ingrandimento della
messa a fuoco

Funzione di scansione a doppia
velocita del mirino

Per rivedere sullo schermo I'ultimo clip registrato,
assegnare la funzione Rec Review a uno dei tasti
programmabilida 1 a 4 (pagina 32).

Dopo aver arrestato la registrazione, premere il
tasto programmabile configurato con la funzione
Rec Review per riprodurre il clip a velocita normale,
a partire dal primo fotogramma.

Il clip viene riprodotto fino alla fine, la funzione Rec
Review termina e I'unita torna alla modalita STBY
(standby di registrazione).

Se viene premuto il tasto HOME sul lato operatore
o sul lato assistente durante la riproduzione, la
riproduzione si arresta e I'unita passa alla modalita
di ripresa.

Premendo il tasto FOCUS MAG del mirino (DVF-
EL200, DVF-L700) montato sull'unita, & possibile
ingrandire la parte centrale dellimmagine
visualizzata sul mirino per facilitare la messa a
fuoco. Dopo aver eseguito la messa a fuoco,
premere nuovamente il tasto per ritornare alla
schermata normale (registrazione).
L'ingrandimento della visualizzazione non ha

alcun effetto sullimmagine registrata o sul segnale
emesso in uscita.

Con frequenza fotogrammi di progetto di 23.98P,
24P, 25P 0 29.97P, ruotando lateralmente l'unita
durante la ripresa, le immagini potrebbero apparire
poco nitide o indistinte a causa della bassa
frequenza di fotogrammi.

In questi casi, pud essere possibile migliorare la
chiarezza e la nitidezza delle immagini attivando la
funzione di scansione a doppia velocita del mirino.
Per attivar la funzione, impostare la voce in
categoria Monitoring > Moni. Details > VF Function
> Double Speed Scan (pagina 48) nel menu su

On.

[Nota]

Quando questa funzione & attivata, 'angolo dell'otturatore
della funzione di otturatore elettronico e limitato a un
massimo di 180 gradi.
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5. Collegamento di dispositivi esterni

Connessione di monitor e dispositivi di registrazione esterni

Per visualizzare su un monitor esterno le
immagini in corso di registrazione o riproduzione,
selezionare il segnale in uscita e collegare il
monitor mediante un cavo appropriato.

Il segnale in uscita dall'unita pud essere registrato
collegando un dispositivo di registrazione, ad
esempio un VTR.

E possibile visualizzare sul monitor esterno gli
stessi menu e informazioni di stato visibili nel
mirino. Impostare il contenuto da visualizzare, in
base al segnale di uscita per il monitor, utilizzando
il menu Monitoring (pagina 45).

Connettore SDI'OUT (tipo BNC)

Impostare il formato di uscita mediante il menu
Monitoring (pagina 45).

Per il collegamento, utilizzare un normale cavo

coassiale da 75 Ohm disponibile in commercio.

[Notal

Assicurarsi che la connessione di terra fra l'unita e il
dispositivo esterno sia efficacemente connessa a terra prima
di accendere l'alimentazione. (Si consiglia di accendere
I'unita e il dispositivo esterno solo dopo aver collegato il cavo
coassiale da 75 Ohm).

Se e necessario collegare il dispositivo esterno all'unita
mentre questa & gia accesa, collegare il cavo coassiale da

75 ohm all'unita solo dopo averlo prima collegato al
dispositivo esterno.

Per avviare la registrazione sincronizzata su un
dispositivo esterno

Quando e selezionata un'uscita di segnale SDI, &
possibile attivare una registrazione sincronizzata
fornendo un segnale di trigger REC al dispositivo
di registrazione esterno collegato al connettore
SDI OUT. Abilitare la registrazione sincronizzata
impostando Technical > System Configuration >
SDI Rec Remote Trigger (pagina 50) nel menu su
HD SDI Remote I/F o Parallel Rec.

[Nota]
Se il dispositivo esterno connesso non e compatibile conil
segnale di trigger REC, il dispositivo non pud essere comandato.

Connettore MONITOR OUT (tipo BNC)

Emette in uscita un segnale HD SDI.

Impostare il formato di uscita mediante il menu
Monitoring (pagina 45).

Per il collegamento, utilizzare un normale cavo

coassiale da 75 Ohm disponibile in commercio.

Connettore HDMI QUT (connettore
tipo A)

Impostare il formato di uscita mediante il menu
Monitoring (pagina 45).

Per il collegamento, utilizzare un normale cavo
HDMI disponibile in commercio.

Se il formato di uscita ha la stessa risoluzione del
segnale del connettore MONITOR OUT, viene
emesso lo stesso segnale video.

Connettore 12V OUT (DCOUT 12V,
Hirose, 4 pin)

Connettore 24V OUT (DCOUT 24V,
Fischer, 3 pin)

Fornisce alimentazione 12 Vcc a un accessorio
quando l'interruttore di alimentazione e ON. II
connettore 12V OUT consente anche di emettere
in uscita un segnale di REC Tally e ricevere in
entrata un segnale di REC Trigger.

Fornisce alimentazione 24 Vcc a un accessorio
quando l'interruttore di alimentazione € ON. I
connettore 24V OUT consente anche di emettere
in uscita un segnale di RECTally e ricevere in
entrata un segnale di REC Trigger.

Ol0) @(D
©]© ®
N. Segnale 1/0  Specifiche N. Segnale Specifiche
1 UNREG GND - GND per UNREG 1 GND
2 RECTALLY OUT  Uscita a collettore 2 24V-AUX Ingressoda11Va 17V
aperto Tensione di uscita: 24V
(Max. 50 mA) Corrente massima di uscita:
Basso: REC 1,0A
3 RECTRIGGER  IN  Apertoo+5Vcc: Ingresso da 22Va32V
Normale Tensione di uscita: Identica
GND: Attivo (REC) alla tensione in ingresso
4 UNREG+12V  OUT Uscitada+11Vcca ggr/rfme massima di uscita:
ouTt 17 Vcc .
Ingressoda11Va 3 R/S
17V
Tensione di uscita:
Identica alla

tensione in ingresso
Corrente massima di

uscita: 1,0 A
Ingresso da 22V a
32V

Tensione di uscita:
15V

Corrente massima di

uscita: 0,8 A
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Connettore AUX (LEMO 5 pin)

Emette in uscita il segnale del codice temporale.

2%
®@
N. Segnale
1 Factory Use
2 NC
3 —
4 TCOUT
5

GND
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5. Collegamento di dispositivi esterni

Sincronizzazione esterna

Durante le riprese con piu di un'unita, & possibile
sincronizzare la registrazione utilizzando uno
specifico segnale di riferimento per sincronizzare i
codici temporali di tutti gli apparecchi.

Sincronizzazione della fase del
segnale video (Genlock)

La funzionalita Genlock viene abilitata fornendo
uno dei seguenti segnali di riferimento al
connettore GENLOCK IN (pagina 9) dell'unita.

® HDSDI 1.5G digitale | ((interlacciato) o PsF)

® HDY analogico

® SDVBS analogico

Impostare il segnale di ingresso genlock tramite
Technical > Genlock > Input Source (pagina 51)
nel menu completo.

I segnali di ingresso di riferimento validi variano
a seconda dellimpostazione della frequenza
fotogrammi di progetto.

Project frame Segnale di riferimento valido
rate (frequenza

fotogrammi di

progetto)

23.98P 1920x1080 47.95i (23.98PsF)

24P 1920x1080 48i (24PsF)

25P 1920%1080 50i
720x576 50i

29.97P 1920x1080 59.94i
720x486 59.94i

50i 1920%1080 50i
720x576 50i

50P 1920%1080 50i
720x576 50i

59.94i 1920x1080 59.94i
720x486 59.94i

59.94P 1920x1080 59.94i
720x486 59.94i

E possibile controllare lo stato di aggancio genlock
tramite la voce Technical > Genlock > Reference
Lock Type (pagina 51) nel menu.

[Note]

e Seil segnale diriferimento é instabile, non & possibile
eseguire un corretto aggancio di genlock.

® || subcarrier non e sincronizzato.

Sincronizzazione del codice
temporale con un altro dispositivo

Impostare 'unita che fornisce il codice temporale
in una modalita in cui I'uscita del codice temporale
continua ad avanzare (Modalita Free Run).

1 Impostare TC/Media > Timecode > Mode
(pagina 44) nel menu su Preset F-Run
(Ext-Lk).

2 Fornire sul connettore GENLOCK IN
(pagina 9) un segnale di riferimento video
HD o SD e sul connettore TC IN (pagina 9)
un codice temporale di riferimento
sincronizzato con il segnale di riferimento
video.

Il generatore di codice temporale incorporato
dell'unita si aggancia sul codice temporale di
riferimento. Sullo schermo viene visualizzato il
messaggio “Ext-Lk"

Dopo dieci secondi circa dall'acquisizione della
sincronizzazione, lo stato di sincronizzazione
esterno viene mantenuto anche se la sorgente del
codice temporale esterno viene scollegata.

[Note]

e Controllare che il codice temporale di riferimento e il
segnale video di riferimento siano in un rapporto di fase
conforme agli standard SMPTE per i codici temporali.

e Una volta conclusa la procedura precedente, il codice
temporale viene immediatamente sincronizzato con
il codice temporale esterno e l'indicazione dei dati
temporali mostrera il valore del codice temporale esterno.
Ad ogni modo, prima di registrare attendere alcuni
secondi la stabilizzazione del generatore del codice
temporale.

® Selafrequenza del segnale video di riferimento e diversa
dalla frequenza di fotogramma, non sara possibile acquisire
un aggancio e |'unita non funzionera correttamente. In
questo caso, il codice temporale non potra sincronizzarsi
correttamente con il codice temporale esterno.

e Quando il collegamento viene rimosso, I'avanzamento del
codice temporale potrebbe scostarsi di un fotogramma
all'ora rispetto al codice temporale di riferimento.

Rilascio della sincronizzazione esterna

Cambiare l'impostzione di TC/Media > Timecode >
Mode (pagina 44) nel menu.
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6. Appendice

Precauzioni per l'uso

Leggere questa sezione insieme alle informazioni
contenute nel documento “Prima di usare I'unita”
fornito con I'apparecchio stesso.

Utilizzo e conservazione

Non sottoporre |unita a urti eccessivi

Il meccanismo interno potrebbe risultarne
danneggiato e la struttura dell'apparecchio
deformata.

Non coprire 'unita durante il funzionamento

La copertura del dispositivo con un panno, ad
esempio, potrebbe provocare un calore interno
eccessivo.

Dopo l'uso

Impostare sempre l'interruttore di accensione su
OFF.

Prima diriporre I'unita per periodi prolungati
Rimuovere la batteria.

Non lasciare I'unita con l'obiettivo rivolto in
direzione del sole

La luce solare diretta condotta dalle ottiche pud
mettersi a fuoco allinterno dell’'unita e causare
incendi.

Spedizione

® Rimuovere le schede di memoria prima di
trasportare l'unita.

® |n caso di spedizione o trasporto mediante
camion, nave, aereo o altro mezzo, imballare
sempre 'unita nel suo imballo di spedizione.

Manutenzione dell’unita

Se sporca, pulire I'unita con un panno morbido e
asciutto. In casi estremi, usare un panno inumidito
con alcune gocce di detergente neutro, quindi
asciugare.

Per evitare di scolorire o danneggiare la finitura
superficiale dell'unita, non utilizzare mai solventi
organici, ad esempio alcool o diluenti.

Per evitare di danneggiare i componenti ottici, non
utilizzare aria compressa per la pulizia, come ad
esempio bombolette antipolvere.

In caso di problemi di funzionamento

In caso di problemi, rivolgersi al proprio rivenditore
Sony.

Sostituzione periodica della ventola e
della batteria

La ventola e la batteria sono considerate
componenti di consumo che dovranno essere
sostituite periodicamente.

Se l'apparecchio viene utilizzato a temperatura
ambiente, il ciclo normale di sostituzione e di circa
5 anni.

Tuttavia, cio ha un valore puramente indicativo

e non implica alcuna garanzia sulla durata di

vita prevista di questi componenti. Per ulteriori
informazioni sulla sostituzione dei componenti,
rivolgersi al proprio rivenditore.

Durata prevista del condensatore
elettrolitico

La vita utile prevista del condensatore elettrolitico
e di circa 5 anni a temperature normali e in
condizioni di utilizzo normale (8 ore al giorno

per 25 giorni al mese). Se le condizioni di utilizzo
eccedono i valori normali sopra indicati, la vita
prevista si ridurra proporzionalmente.

Nota sul terminale di contatto della
batteria

Il morsetto della batteria dell'apparecchio (il
connettore per pacchi batteria e adattatori CA) e
un prodotto di consumo.

Se i piedini del morsetto sono piegati e deformati
a causa di urti o vibrazioni, o se vengono corrosi
a causa di un uso prolungato all‘aria aperta,
I'alimentazione potrebbe non essere fornita
correttamente.

Si consiglia di eseguire dei controlli periodici

per assicurare il funzionamento corretto
dell'apparecchio e prolungarne la vita utile.

Per ulteriori informazioni sui controlli, contattare il
servizio tecnico o un rappresentante Sony.

Ambienti d'uso e conservazione

Conservare in un luogo ventilato e a temperatura

costante.

Evitare di usare o conservare 'apparecchio negli

ambienti indicati di seguito.

® |n ambienti eccessivamente caldi o
eccessivamente freddi (campo di temperatura
operativa: da 0 °C a 40 °C)
Ricordare che in estate, in climi caldi, la
temperatura all'interno di un‘auto con i finestrini
chiusi pud facilmente superare i 50 °C.

® |n luoghi umidi o polverosi.

® |n luoghiin cuil'unita potrebbe essere esposta
a pioggia.

® |n luoghi sottoposti a forti vibrazioni.

® |n prossimita di forti campi magnetici.

® |n prossimita di impianti di trasmissione radio o
TV che producono forti campi elettromagnetici.

® |n esposizione alla luce solare diretta o in
prossimita di fonti di riscaldamento per periodi
prolungati.

Per evitare interferenze elettromagnetiche causate
da dispositivi di comunicazione portatili

L'uso di telefoni portatili e di altri dispositivi

di comunicazione in prossimita del presente
dispositivo potrebbe causare problemi di
funzionamento e interferenze con i segnali audio
e video.

Si consiglia di spegnere eventuali dispositivi di
comunicazione portatili nelle vicinanze di questo
apparecchio.

Nota sui raqgi laser

I raggi laser possono danneggiare il sensore
immagine CMOS. Qualora vengano riprese scene
in cui sono presenti raggi laser, evitare che tali
raggi colpiscano l'obiettivo dell'unita. | particolare,
i fasci laser ad alta potenza generati da dispositivi
medicali o di altro tipo possono causare danni
anche se riflessi o diffusi.
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Informazioni sugli schermi

® Non lasciare gli schermi esposti alla luce solare
diretta in quanto la luce solare diretta potrebbe
causare danni.

® Non esercitare eccessiva pressione
premendo o passando le dita sugli schermi,
né lasciare oggetti appoggiati su di essi
in quanto la pressione potrebbe causarne
il malfunzionamento, come ad esempio
irregolarita dellimmagine, ecc.

® Gli schermi potrebbero riscaldarsi durante I'uso.
Non si tratta di un guasto.

Pannelli LCD e OLED

Il pannello LCD di cui & dotato I'apparecchio &
prodotto con tecnologia ad alta precisione che
consente di ottenere una percentuale di pixel
funzionanti minima di ben 99,99%. £ quindi
possibile che una piccolissima percentuale dei
pixel possa rimanere “bloccata’, sempre disattivata
(nera), sempre attivata (rossa, verde o blu) oppure
lampeggiante. £ inoltre possibile che, dopo un
lungo periodo d'uso, alcuni pixel si “blocchino”
spontaneamente a causa delle caratteristiche
fisiche del display a cristalli liquidi. Tali fenomeni
non sono il risultato di guasti e non hanno alcun
effetto sui dati registrati.

Anche il pannello OLED (Organic Light Emitting
Diode - Diodo organico ad emissione luminosa)
dell'apparecchio pud presentare pixel “bloccati”
e/o punti luminosi. Questi fenomeni non possono
essere considerati guasti.

Informazioni sulla condensa

Qualora l'unita venga spostata rapidamente

da un ambiente freddo a uno caldo, oppure se

la temperatura ambiente dovesse aumentare
improvvisamente, & possibile che si formi

umidita sulle superfici esterne dell'unita e/o al

suo interno. Questo fenomeno e denominato
condensazione. In tal caso, spegnere 'unita ed
attendere la scomparsa della condensazione prima
di riavviarla. L'utilizzo dell'unita mentre e presente
condensazione puo causare danni all'unita stessa.

Fenomeni relativi ai sensori
immagine CMOS

| seguenti fenomeni possono verificarsi nelle
immagini e sono relativi ai sensori immagine CMOS
(Complementary Metal Oxide Semiconductor). Essi
non indicano malfunzionamenti.

Macchiette bianche

Sebbene i sensori immagine CMOS siano prodotti

con tecnologie di alta precisione, in rari casi &

possibile che compaiano delle piccole macchie

bianche sullo schermo, causate da raggi cosmidi,

ecc. Cio e dovuto al principio dei sensori immagine

CMOS e non si tratta di un malfunzionamento.

In particolare le macchie bianche tendono a

comparire nei sequenti casi:

® Durante I'utilizzo a temperature ambientali
elevate

Aliasing

Se vengono riprese immagini in cui sono presenti
motivi, righe o strisce molto “fitti’, questi possono
apparire spezzettati o tremolare.

Piano focale

A causa delle caratteristiche di lettura dei segnali
video degli elementi di cattura (i sensori CMQS), i
soggetti in rapido movimento da un lato all'altro
dello schermo potrebbero apparire leggermente
distorti.

Flashbanding

La luminanza delle sezioni superiore e inferiore
dello schermo potrebbe risultare alterata durante
le riprese di fasci di luce o sorgenti luminose che
lampeggiano rapidamente.

Sfarfallio

Se la registrazione viene effettuata con
illuminazione prodotta da lampade a scarica
elettrica, ad esempio lampade fluorescenti o ai
vapori di sodio o di mercurio, lo schermo potra
presentare fenomeni di sfarfallio, i colori potranno
apparire alterati o eventuali righe orizzontali
potranno apparire distorte.

Nota relative allo schermo

® | e seguenti operazioni possono causare
distorsioni alle immagini sullo schermo del
mirino:

- Modifica del formato video

® Cambiando il punto di vista mentre si guarda nel
mirino, & possibile che si vedano colori primari
(rosso, verde e blu). Questo fenomeno non
indica la presenza di guasti. | colori primari non
vengono registrati sui supporti di registrazione.

Frammentazione

Se non e possibile registrare o riprodurre
correttamente le immagini, provare a formattare
il supporto di registrazione. Se vengono eseguite
operazioni di registrazione o riproduzione
ripetutamente su uno stesso supporto di memoria
per un periodo prolungato, e possibile che si
verifichi la frammentazione dei file contenuti nel
supporto, impedendo una corretta registrazione
e memorizzazione. In tal caso, eseguire il backup
dei clip contenuti nel supporto quindi formattare
il supporto tramite TC/Media >Format Media
(pagina 45) nel menu.

Tensioni di uscita dell'unita

La potenza totale in uscita che puo essere fornita
a dispositivi periferici ed accessori dall’'unita varia
in base alla tensione di ingresso fornita all’'unita e
allo stato di tali accessori collegati. | connettori di
alimentazione potrebbero quindi non essere in
grado di fornire la potenza massima nominale di
uscita in base alle condizioni d'uso.

Connettore LENS: 1 A max.

Connettore 12V OUT (4 pin):
0,8 A max. (Tensione di ingresso: da 22V a
32V)
1 A max. (Tensione diingresso:da 11Va 17V)

Connettore 24V OUT (3 pin):
2 A max. (Tensione di ingresso: da 22V a 32V)
1 A max. (Tensione diingresso:da 11Va 17V)

Se sono montati un registratore AXS-R7 e un
mirino DVF-EL200, e la tensione di ingresso
all'unita € 14V o inferiore, la potenza di
alimentazione fornibile ai dispositivi periferici &
limitata.
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Potenza totale nominale dei dispositivi
periferici: Y [W]

Tensione di alimentazione all'unita: X [V]
Consumo di potenza dell'unita: Circa 60 W
Consumo di potenza del registratore AXS-R7:
Circa 24 W

Consumo di potenza del mirino DVF-EL200:
Circa25W

Y [W]=X[V]x9,0I[A]" - (60 + 24 + 2,5) [W]

Se é necessario fornire alimentazione dall'unita a
dispositivi periferici, assicurarsi che I'assorbimento
totale di potenza non superi il valore nominale
totale di potenza risultante dall'equazione di cui
sopra.

(Si osservi inoltre che I'equazione non é applicabile
se il risultato calcolato supera la somma della
potenza di uscita massima consentita per ciascun
connettore di alimentazione in uscita.)

V6,0 [A] quando si usa 'AC-DN10.
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Formati di registrazione e segnali di uscita

Formati di uscita del connettore SDI OUT

Il segnale digitale seriale emesso in uscita sul connettore SDI OUT varia in base alle impostazioni delle categorie Project e Monitoring nel menu.
Per informazioni dettagliate sulle combinazioni possibili delle impostazioni della categoria Project, fare riferimento a “Impostazioni del formato di registrazione” (pagina 39).

I valori predefiniti sono sottolineati e in grassetto.

Project Monitoring > Output Format Formato di uscita
Project Frame Rate  Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
59.94/50 4K17:9 XAVC-1 4K Class300/ 4096x2160P 2SI 4096x2160P 2SI 4096x2160P YPbPr 3G Level B-DL
Rec Off 4096x2160P Square  4096x2160P Square 4096x2160P YPbPr 3G Level B-DL
2048x1080P 1920x1080i 2048x1080P YPBPr 3G 2048x1080P YPBPr 3G 1920x1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G
— Level B-DL Level B-DL
1920x1080P 1920x1080i 1920x1080P YPLPr 3G 1920x1080P YPLPr 3G 1920%x1080i YPbPr 1.5G 1920%x1080i YPbPr 1.5G
. Level B-DL Level B-DL
1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920%1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G
3.8K 169 XAVC-I QFHD Class300/ 3840x2160P 2SI 3840%x2160P 2SI 3840x2160P YPbPr 3G Level B-DL
Rec Off 3840x2160P Square  3840x2160P Square 3840%2160P YPbPr 3G Level B-DL
1920x1080P 1920x1080i 1920x1080P YPbPr 3G 1920x1080P YPDPr 3G 1920x1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G
E— Level B-DL Level B-DL
1920%x1080i 1920x1080i 1920%x1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G 1920x1080i YPbPr 1.5G
;H;}Zg/g MPEG 192010801 1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920%1080i YPbPr 1.5G 1920%x1080i YPbPr 1.5G 1920%x1080i YPbPr 1.5G
29.97/25 4K17:9 XAVC-l 4K Class480/ 4096x2160P 2SI - 4096x2160P YPbPr 3G Level B-DS Nessuna uscita Nessuna uscita
XAVC-1 4K Class300/  4096x2160P Square  4096x2160P Square 4096x2160P YPbPr 1.5G
Rec Off
2048x1080PsF 2048x1080PsF 1920x1080PsF 1920x1080PsF
2048x1080PsF 1920x1080Psk YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G
1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF
1920x1080PsE 1920x1080PsE YPbPr 15G YPbPr 15G YPbPr 15G YPbPr 1.5G
3.8K16:9 XAVC-I QFHD Class480/  3840x2160P 2SI - 3840x2160P YPbPr 3G Level B-DS Nessuna uscita Nessuna uscita
:Avé}lf QFHD Class300/ 384052160P Square  3840x2160P Square 3840x2160P YPbPr 1.5G
ec
1920x1080PsF 1920x1080PsF 1920x1080PsF 1920x1080PsF
1920x1080PsE 1920x1080PsE YPbPr 15G YPbPr 15G YPbPr 15G YPbPr 1.5G
4K 179/ MPEG 1920x1080P 1920x1080PsF 1920x1080PsF 1920%x1080PsF 1920x1080PsF
38K 169 1920x1080PsE 1520x1080PsE YPbPr 1.5G YPbPr 15G YPbPr 15G YPbPr 15G
24 6K 3:2/4K 4:3/ XAVC-| 4K Class480/ 4096x2160P 2SI - 4096x2160P YPbPr 3G Level B-DS Nessuna uscita Nessuna uscita
4K17:9 XAVC-1 4K Class300/ 4096x2160P Square  4096x2160P Square 4096x2160P YPbPr 1.5G
Rec Off
2048x1080PsF 2048x1080PsF 1920x1080P 1920x1080P
2048x1080P 1920x1080P YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G
1920x1080PsF 1920x1080PsF 1920x1080P 1920x1080P
1920x1080P 1920x1080P YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G
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Project Monitoring > Output Format Formato di uscita
Project Frame Rate  Imager Mode SxS Rec Format SDI 1/2 SDI 3/4 SDI 1 SDI 2 SDI 3 SDI 4
23.98 6K 3:2/ XAVC-l 4K Class480/ 4096x2160P 2SI - 4096x2160P YPbPr 3G Level B-DS Nessuna uscita Nessuna uscita
4K 4:3/ XAVC-| 4K Class300/ 4096x2160P Square 4096x2160P Square 4096x2160P YPbPr 1.5G
K179 Rec Off 0481 080P ) 2048x1080PsF 20481080PsF 1920x1080P 1920x1080P
YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G
1920x1080PsF 1920x1080PsF 1920x1080P 1920x1080P
1920x1080F 1920x1080P YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G
3.8K16:9 XAVC-l QFHD Class480/  3840x2160P 2SI - 3840x2160P YPbPr 3G Level B-DS Nessuna uscita Nessuna uscita
XAVC-I QFHD 3840%x2160P Square  3840x2160P Square 4096x2160P YPbPr 1.5G
Class300/Rec Off - 020w 1080P 1920x1080PsF 1920x1080PsF 1920x1080P 1920x1080P
—— T YPbPr 1.5G YPbPr 1.5G YPbPr1.5G YPbPr 1.5G
a3/ MPEG 1920>1080P 1920x1080PsF 1920x1080PsF 1920x1080P 1920x1080P
SRA 1920x1080F 1920x1080P YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G YPbPr 1.5G

3.8K16:9
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Formati di uscita per i connettori MONITOR OUT e HDMIOUT

Il segnale digitale emesso in uscita sui connettori MONITOR OUT e HDMI OUT varia in base alle impostazioni delle categorie Project e Monitoring nel menu.
Per informazioni dettagliate sulle combinazioni possibili delle impostazioni della categoria Project, fare riferimento a “Impostazioni del formato di registrazione” (pagina 39).

| valori predefiniti sono sottolineati e in grassetto.

Project Monitoring > Output Format Formato di uscita
Project Frame Rate  Imager Mode SxS Rec Format SDI1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
59.94/50 4K17:9 XAVC-1 4K Class300/ . 4096x2160P . 4096x2160P
Rec Off 4096x2160P 2SI 4096x2160P 2SI 1920x1080i 71 920x1080i 1920%1080i YPbPr 1.5G 192051080
4096x2160P Square 4096x2160P Square 1920x1080i 1920x1080i 1920%1080i YPbPr 1.5G 1920x1080i
2048x1080P 1920x%1080i 1920%x1080i 1920%1080i 1920%1080i YPbPr 1.5G 1920x1080i
1920x1080P 1920x%1080i 1920%1080i 1920%1080i 1920%1080i YPbPr 1.5G 1920x1080i
1920x1080i 1920x1080i 1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i
3.8K 169 XAVC-I QFHD Class300/ ) 3840x2160P . 3840x2160P
Rec Off 3840x2160P 2SI 3840x2160P 2SI 1920x1080i 71 9201080 1920%1080i YPbPr 1.5G 1920%1 0801
3840x2160P Square 3840x2160P Square 1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i
1920x1080P 1920x1080i 1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920%1080i
1920x1080i 1920x1080i 1920x1080i 1920%1080i 1920%1080i YPbPr 1.5G 1920x1080i
4K 17:9/ MPEG 1920x1080i 1920x1080i 1920x1080i 1920x1080i YPbPr 1.5G 1920x1080i
38K16:9 1920x1080i 1920x1080i 720x480P"? | Nessuna uscita 720%480P
- 720x576P "3 Nessuna uscita 720x576P
29.97/25 4K 4:3/4K17:9 XAVC-l 4K Class480/ 4096x2160P 4096x2160P
XAVC-1 4K Class300/ 4096x2160P 2SI - 1920x1080PsF 7192())(1 080P<F 1920x1080PsF YPbPr 1.5G 192051080P<F
Rec Off 4096x2160P Square 4096x2160P Square 1920x1080PsF  1920x1080PsF | 1920x1080PsF YPbPr 1.5G 1920x1080PsF
2048x1080PsF 1920x1080PsF 1920x1080PsF  1920x1080PsF | 1920x1080PsF YPbPr 1.5G 1920x1080PsF
1920x1080PsF 1920x1080PsF 1920x1080PsF  1920x1080PsF | 1920x1080PsF YPbPr 1.5G 1920x1080PsF
3.8K 169 XAVC-I QFHD Class480/ 3840x2160P 3840x2160P
XAVC-1 QFHD Class300/ 3840x2160P 28I - 1920x1080PsF W 1920x1080PsF YPbPr 1.5G 192051 080PF
Rec Off 3840x2160P Square 3840x2160P Square 1920x1080PsF  1920x1080PsF | 1920x1080PsF YPbPr 1.5G 1920x1080PsF
1920x1080PsF 1920x1080PsF 1920x1080PsF  1920x1080PsF | 1920x1080PsF YPbPr 1.5G 1920x1080PsF
ggizz/g MPEG 19201080 1920x1080PsF 1920x1080PsF 1920x1080PsF  1920x1080PsF | 1920x1080PsF YPbPr 1.5G 1920x1080PsF
24 6K 3:2/ XAVC-l 4K Class480/ 4096x2160P 4096x2160P
4K 43/ XAVC-1 4K Class300/ 4096x2160P 2SI - 1920x1080P 71920% 080P 1920x1080P YPbPr 1.5G 192051080P
4179 Rec Off 4096x2160P Square  4096x2160P Square  1920x1080P  1920x1080P | 1920x1080P YPbPr 1.5G 1920%1080P
2048x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
1920x1080P 1920x1080P 1920%x1080P 1920%1080P 1920%1080P YPbPr 1.5G 1920x1080P
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Project Monitoring > Output Format Formato di uscita
Project Frame Rate  Imager Mode SxS Rec Format SDI1/2 SDI 3/4 Monitor HDMI Monitor Out HDMI
2398 6K 3:2/ XAVC-| 4K Class480/ 4096x2160P 4096x2160P
4K 4:3/ XAVC-1 4K Class300/ 4096x2160P 2SI - 1920x1080P 71920><1 080P 1920x1080P YPbPr 1.5G 1920 1080P
479 Rec Off 4096x2160P Square 4096x2160P Square 1920x1080P 1920x1080P 1920%1080P YPbPr 1.5G 1920x1080P
2048x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
1920x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
3.8K16:9 XAVC-I QFHD Class480/ 3840x2160P 3840x2160P
XAVC-l QFHD Class300/ 3840x2160P 2SI - 1920x1080P 71 920x1080P 1920x1080P YPbPr 1.5G 192051 080P
Rec Off 3840x2160P Square 3840x2160P Square 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
1920x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
4K 4:3/ MPEG 1920x1080P
4K17:9/ 1920x1080P 1920x1080P 1920x1080P 1920x1080P 1920x1080P YPbPr 1.5G 1920x1080P
3.8K16:9

U Quando AXS Rec Format é impostato su Rec Off, & selezionata questa uscita se Technical > System Configuration > SD HDMI & impostato su On nel menu

2 Quando Project Frame Rate & 59.94.
? Quando Project Frame Rate ¢ 50.0.
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Indicazioni di errore e di avvertenza

Qualora si verifichino avvisi, avvertenze o condizioni che richiedono una conferma, il display secondario
dell’'unita visualizza un messaggio, la spia REC inizia a lampeggiare e viene emesso un segnale acustico.
Il segnale acustico viene emesso sull'altoparlante interno o sulle cuffie collegate tramite il connettore
cuffie.

Se non e stata eseguita la funzione di regolazione automatica del sensore immagine (APR) per un certo
periodo di tempo, I'unita visualizza, all'accensione, un messaggio sullo schermo del display secondario
che richiede 'esecuzione dell/APR. In tal caso, seguire le istruzioni a schermo per eseguire la regolazione
APR (pagina 50).

Awviso di errori

Qualora abbia luogo una condizione che causa la visualizzazione di un messaggio del tipo indicato di
seguito, I'unita si arresta.

Messaggio di errore Segnalatore Spia REC Causa e soluzione

acustico

E + codice errore Intermittente  Lampeggia L'unita potrebbe essere difettosa. La registrazione si

Messaggio di avviso Segnalatore Spia REC Causa e soluzione
acustico
Insufficient Voltage”  Continuo Lampeggia La tensione sul connettore DC IN ¢ insufficiente. La

rapidamente

registrazione é disabilitata.
Collegare un‘altra sorgente di alimentazione.

EXT.I/F Signal Error - -

E stato rilevato un errore del segnale sul terminale di
montaggio di una unita di espansione.

Controllare il collegamento al registratore AXS-R7 o ad
altro dispositivo.

AXS Recorder Temp. - -
High"

La temperatura interna del registratore AXS ¢ elevata.
Spegnere I'unita e lasciarla raffreddare prima di
utilizzarla nuovamente.

" Messaggio non visualizzato sullo schermo del monitor.

Indicazioni di attenzione e conferma operazione

rapidamente

arresta anche se @REC & visualizzato sul mirino.

Spegnere e controllare 'apparecchiatura collegata, i cavi
e i supporti. Se il messaggio d'errore persiste anche dopo
aver riacceso l'unita, rivolgersi al proprio rappresentante

di assistenza tecnica Sony. (Se non é possibile spegnere la

videocamera spostando l'interruttore di accensione su
OFF, rimuovere la batteria o scollegare la sorgente di
alimentazione dal connettore DC IN).

Sullo schermo del monitor o sul display secondario possono essere visualizzati messaggi di avviso o di
conferma, mentre icone di avvertenza e messaggi possono essere visualizzati in categoria Info > Camera
Condition nel menu, come descritto di seguito. Seguire le istruzioni fornite per risolvere il problema.

Indicazione visualizzata

Causa e soluzione

Battery Error
Please Change Battery

E stata rilevata un'anomalia nella batteria.
Sostituire con una batteria normale.

Avvertenza

Qualora venga visualizzato uno dei seguenti messaggi, provare a risolvere il problema come descritto
nella tabella seguente.

Backup Battery End
Please Change

La carica della batteria di backup e insufficiente.
Sostituire la batteria di backup.

Cannot Use SxS(A)*
Please Change

£ stata inserita una scheda di memoria che & stata
partizionata oppure una scheda di memoria
contenente un numero di clip superiore al massimo
gestibile da questa unita.

La scheda non puo essere utilizzata nell'unita e deve
essere sostituita.

Messaggio di avviso Segnalatore Spia REC Causa e soluzione

Cannot Use SxS(A)*
Unsupported File System

£ stata inserita una scheda con un file system diverso
oppure non formattata.

La scheda non puo essere utilizzata nell'unita e deve
essere sostituita oppure formattata con l'unita.

acustico
Media Full? Continuo Lampeggia Non e possibile registrare, copiare o dividere clip perché
rapidamente  la capacita rimanente sulla scheda SxS € insufficiente.
Sostituire immediatamente.
Battery End " Continuo Lampeggia La batteria e scarica. La registrazione e disabilitata.

rapidamente  Arrestare le operazioni e ricaricare la batteria.

Media Error
SXS(A)* Needs to be Restored

E stato rilevato un errore nella scheda di memoria. E
necessario ripristinare la scheda.
Ripristinare la scheda.

Temperature High"  Intermittente Lampeggiante La temperatura interna e elevata.
Spegnere 'unita e lasciarla raffreddare prima di

utilizzarla nuovamente.

SXS(A)* Error
Recording Halted
Playback Halted

La registrazione o la riproduzione si sono arrestate a
causa di un errore sulla scheda di memoria.
Se il problema persiste, sostituire la scheda di memoria.
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Indicazione visualizzata

Causa e soluzione

Input AES/EBU is Invalid Emphasis

E stato fornito in ingresso un segnale Emphasis non
compatibile con I'ingresso AES/EBU.
L'unita € compatibile solo con 50u-15u Emphasis.

Input AES/EBU is not Pro Use

E stato fornito in ingresso un segnale diverso da
Professional Use sull'ingresso AES/EBU.
L'unita e compatibile solo con Professional Use.

Fan Stopped

La ventola dell'unita si & fermata.

Evitare I'utilizzo in condizioni di elevata temperatura.
Spegnere I'unita e rivolgersi a un rappresentante di
assistenza Sony.

AXS Recorder Fan Stopped

La ventola del registratore AXS-R7 connesso all'unita si
é fermata.

Evitare I'utilizzo in condizioni di elevata temperatura.
Rimuovere il registratore AXS-R7 dall'unita e rivolgersi
a un rappresentante di assistenza Sony.

Unsupported FPS
Change AXS(A) to AXS S48 Memory

E stata rilevata una memoria AXS non supportata.
Impossibile eseguire la registrazione. Cambiare il
formato di registrazione della scheda di memoria AXS,
oppure sostituire la scheda con una tipo AXS-A512548
0 AXS-A1TS48.

Abnormal Lens Communication
Please Check“Lens IF" Setting

Il tipo di obiettivo montato non corrisponde
allimpostazione sull'unita.

Controllare l'impostazione Technical > System
Configuration > Lens Interface nel menu.

Please Execute APR

La regolazione automatica del sensore di immagine
(APR) non ¢ stata eseguita per un certo periodo.
Eseguire APR premendo il comando MENU.

Invalid setting value was reset:
Media/Clip Naming/Camera Position
Please save All File again

Limpostazione di Clip Naming & stata resettata perché
¢ stato caricato un file All-settings non valido.

Salvare nuovamente il file All-settings dopo aver
impostato i valori desiderati.

XXXX License Y days Remaining
(XXXX: tipo di licenza, Y: numero di giorni alla
scadenza)

MancanoY giorni alla scadenza della licenza per
l'opzione software.

* "SxS(B)"indica la scheda di memoria SxS nello slot B, "AXS(A)"indica la scheda di memoria AXS nello slot A del registratore
AXS-R7, mentre "AXS(B)"indica la scheda di memoria AXS nello slot B del registratore AXS-R7.
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Impostazioni salvate in file

Legenda
Si: salvato
No: non salvato

—:non salvato (impostazione temporanea)

Project Menu
Voce Voce secondaria Tipo di file
All

Basic Setting Imager Mode Si
Project Frame Rate Si
AXS Rec Format Si
SxS Rec Format Si
Sub Rec Format Si
SxS/Output De-Squeeze No

Assignable Button <1> Si
<2> Si
<3> Si
<4> Si
<User 1> Si
<User 2> Si
<User 3> Si
<User 4> Si
<User 5> Si

All File Load SD Card -
Save SD Card -
File ID Si
Format SD Card -

Menu Shooting
Voce Voce secondaria Tipo di file
All
Shutter " Shutter Select Si
Step/Cont. Select Si
Add/Change Step Si
Delete Step Si
ND ND Position Si
Exposure Index El Select Si
White Balance " Color Temp. Select Si
Add/Change Step Si
Delete Step Si
LUT Select SDI 1/2 Si
SDI 3/4 Si
Monitor Si
HDMI Si
VF LUT Si
SXS Rec Si
Sub Rec Si
Look Category -
Preset Look Select Si

" Vengono salvate anche le opzioni selezionabili aggiunte o modificate dall'utente.
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Menu TC/Media

Menu Monitoring

Voce Voce secondaria Tipo di file Voce Voce secondaria Tipo di file
All All
Timecode Mode Si Output Format SDI1/2 Si
Manual Setting - sDI 3/4 ol
Reset 7 Monitor Si
TC Format Si HOMI S:I
TC Source B VF OSD Status Info Si
- - - Status Info Select Si
Time Data Display Si - -
- - Frame Line Si
Clip Name Format Camera ID Si Frame Line Select =
Reel Number ! SDI OSD Status Info Si
Camera Position Sl Status Info Select Si
Format Media AXS Slot A - Frame Line S
AXS Slot B - Frame Line Select Si
S5 Slot A - Monitor OSD Status Info Si
5x5 Slot B - Status Info Select Si
SD Card - Frame Line Si
Update Media AXS Slot A - Frame Line Select Si
AXS Slot B - HDMI OSD OSD Status -
SXS Slot A - Status Info A Project Si
SXS Slot B - Timecode Si
Audio Level Meter Si
Look Status Si
Output LUT Si
Recording LUT Si
VF Status Si
Lens Status Si
Status Info B Project Si
Timecode Si
Audio Level Meter Si
Look Status Si
Output LUT Si
Recording LUT Si
VF Status Si
Lens Status Si
Display Info Focus Distance Format Si
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Menu Audio

Voce Voce secondaria Tipo di file
All
Audio Input CH-1 Audio Select Si
CH-2 Audio Select Si
CH-1 Audio Level Si
CH-2 Audio Level Si
MIC Reference Si
Audio Monitor Monitor CH Si
Monitor Level Si
Audio Configuration Input Limiter Mode Si
AGC Level Si
AGC Mono/Stereo Si
MIC Input Mono/Stereo Si
Phantom Power +48V Si
Monitor Output CH Pair Si
Headphone Mono/ST Si

Voce Voce secondaria Tipo di file
All
Frame Line A Center Marker Si
Aspect Ratio Si
Aspect Safety Zone Si
Picture Area Si
Safety Zone Si
User Frame Line Si
Frame Line B Center Marker Si
Aspect Ratio Si
Aspect Safety Zone Si
Picture Area Si
Safety Zone Si
User Frame Line Si
Frame Line Color Si
Center Marker Si
Safety Area Si
Aspect Ratio Type Si
Aspect Ratio Select Si
Aspect Ratio Mask Si
Aspect Safety Area Si
Frame Line on Playback Si
User Frame Line Width Si
Height Si
H Position Si
V Position Si
VF Display VF LUT Si
Status Info Si
Status Info Select Si
Frame Line Si
Frame Line Select Si
Color Si
VF Function Double Speed Scan Si
Peaking Frequency Si
Zebra Si
Zebra Select Si
Zebral Level Si
Zebral Aperture Level Si

Zebra2 Level

Si
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Menu Technical

Menu Maintenance

Voce Voce secondaria Tipo di file Voce Voce secondaria Tipo di file
All All
Test Signals Color Bars Si Clock Set Time Zone Si
Color Bars Type Si Date Mode Si
1kHz Tone on Color Bars Si Date -
Test Saw Si Time -
Switch & Rec Light Lock Operator Side Si Language Select Si
Lock Assistant Side Si Hours Meter Camera(System) -
Rec Light Si R7 Recorder(System) -
Rec Start/Stop Beep N Camera(Resettable) -
System Configuration Fan Control Si R7 Recorder(Resettable) -
Lens Interface Si Reset-Cam(Resettable) -
SDI Rec Remote Trigger Si Reset-R7(Resettable) -
SD HDMI Si Reset to Default Reset -
Shutter Mode Si License Options Install: xxx -
APR APR - Anamorphic -
Reset - Full Frame -
Battery Near End:Info Battery Si Unique Device ID -
End:Info Battery Si Firmware Camera -
Near End:Sony Battery Si AXS -
End:Sony Battery Si FW Update-camera -
Near End:Other Battery Si
End:Other Battery Si
Detected Battery -
DC Voltage Alarm DC Low Voltage1 Si
DC Low Voltage2 Si
DC(24V) Low Voltage Si
DC(24V) Low Voltage? Si
Control Display Brightness level Si
Genlock Input Source Si

Reference Lock Type
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Licenze

Licenza MPEG-4 Visual Patent
Portfolio

QUESTO PRODOTTO VIENE CONCESSO IN LICENZA
Al SENSI DELLA LICENZA DI RACCOLTA DI BREVETTI
VISUALI MPEG-4 PER LUSO PERSONALE E NON

COMMERCIALE DA PARTE DEL CONSUMATORE PER

(i) LA CODIFICA DI VIDEO IN CONFORMITA CON
MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO") E/O
(ii) LA DECODIFICA DI VIDEO MPEG-4 CODIFICATI
DAL CONSUMATORE NEL CORSO DI ATTIVITA
PERSONALI E NON COMMERCIALI E/O OTTENUTI
DA UN FORNITORE DI VIDEO AUTORIZZATO DA
MPEG LA ALLA FORNITURA DI VIDEO MPEG-4.

NESSUNA LICENZA VIENE CONCESSA O PUO
ESSERE USATA PER QUALSIASI ALTRA FINALITA.
ULTERIORI INFORMAZIONI, COMPRESE QUELLE
CHE SIRIFERISCONO A PROMOZIONI, USI INTERNI
E COMMERCIALI, E LICENZE, POSSONO ESSERE
OTTENUTE DA MPEG LA, LLC. CONSULTARE IL SITO
HTTP://WWW.MPEGLA.COM

MPEG LA rilascia licenze per (i) la produzione/
vendita di supporti per l'archiviazione di
informazioni video in formato visuale MPEG-4 (ii)
la distribuzione/trasmissione di informazioni video
in formato visuale MPEG-4 sotto qualsiasi forma
(Come servizi di distribuzione di video online,
trasmissione via Internet, trasmissione TV).

Per altri usi del prodotto, potrebbe essere
necessario ottenere una licenza da MPEGLA.
Contattare MPEG LA per ulteriori informazioni.
MPEG LA. LL.C, 250 STEELE STREET, SUITE 300,
DENVER, COLORADO 80206.
http://www.mpegla.com

Licenza MPEG-4 AVC Patent Portfolio

QUESTO PRODOTTO E SOGGETTO A LICENZA AVC
PATENT PORTFOLIO PER USO PERSONALE E NON
COMMERCIALE DEL CLIENTE O ALTRI'USI PER |
QUALI'NON SIRICEVE ALCUN COMPENSO PER

(i) CODIFICARE VIDEO IN CONFORMITA ALLO
STANDARD AVC ("‘AVCVIDEO") E/O

(if) DECODIFICARE VIDEO AVC CODIFICATO DA UN
CLIENTE IMPEGNATO IN ATTIVITA PERSONALE E/O
OTTENUTO DA UN PROVIDER VIDEO CON LICENZA
PER FORNIRE VIDEO AVC.

NESSUNA LICENZA E CONCESSA O E DA
RITENERSI IMPLICITA PER ALTRO USO. ULTERIORI
INFORMAZIONI SONO DISPONIBILI PRESSO MPEG
LA, LLC.VISITARE IL SITO
HTTP//WWW.MPEGLA.COM

Sull'accesso al software a cui si
applicano le licenze GPL/LGPL

Questo prodotto utilizza software a cui si applicano
licenze GPL/LGPL. Siinforma I'utente che ha diritto
di accesso, modifica e ridistribuzione del codice
sorgente di tali programmi software alle condizioni
delle licenze GPL/LGPL.

Il codice sorgente & fornito su internet. Utilizzare

il seguente URL e seguire le istruzioni per il
download.
http://www.sony.net/Products/Linux/common/
search.html

Preferiremmo non essere contattati relativamente
al contenuto del codice sorgente.

Per i contenuti di queste licenze, vedere “Licensel.
pdf"nella cartella“License” del CD-ROM in
dotazione.

Per visualizzare i file PDF, & necessario installare
Adobe Reader sul computer.

Se Adobe Reader non e installato sul computer, e
possibile scaricarlo accedendo al sequente URL.
http://get.adobe.com/reader/

Licenze per software aperto

Sulla base dei contratti di licenza tra Sony e i
titolari del copyright del software, questo prodotto
utilizza un software aperto.

Per conformarsi ai requisiti dei titolari del copyright
del software, Sony deve informare I'utente sul
contenuto di queste licenze.

Per il contenuto di queste licenze, vedere il file
“License1.pdf”nella cartella “License” del CD-ROM
fornito in dotazione.
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Specifiche

(aratteristiche generali

Peso Circa 3,9 kg (escluso maniglia,
adattatore mirino, coperchio
inferiore)

Dimensioni

Vedere pagina 79.
Requisiti di alimentazione
12Vce (da 11 Veca 17 Vee)
24 Vcc (da 22 Vec a 32 Vo)
Potenza assorbita
Circa 60 W (durante la registrazione
XAVQ)
Temperatura di funzionamento
Da0°Ca40°C
Temperatura di conservazione
Da -20°Ca+60°C
Tempo di funzionamento continuato
Circa 60 minuti (con batteria BP-FLX75)
Formato di registrazione (video)
RAW SQ (4K,17:9)
(quando é connesso un
registratore AXS-R7)
X-OCN ST (6K 3:2, 4K 4:3, 4K 17:9)
(quando é connesso un
registratore AXS-R7)
X-OCN LT (6K 3:2, 4K 4:3, 4K 17:9)
(quando é connesso un
registratore AXS-R7)
XAVC-I Class480 (4K, QFHD)
XAVC-I Class300 (4K, QFHD)
MPEG HD422 (HD)

Formato di registrazione (audio)

LPCM 8CH (registrazione/riproduzione 2CH),
24 bit, 48 kHz

Frequenza fotogrammi di registrazione

RAW SQ (quando e connesso un registratore

AXS-R7):
4K 17:9/3.8K16:9

59.94P/50P/29.97P/25P/24P/
23.98P

X-OCN (quando & connesso un registratore
AXS-R7):

6K 3:2
24P/23.98P
4K 4:3
24P/23.98P
4K 17:9/3.8K 16:9
59.94P/50P/29.97P/25P/24P/
23.98P
XAVC-| Class480:
4K: 4096x2160
29.97P/25P/24P/23.98P
QFHD: 3840x2160
29.97P/25P/ 23.98P
XAVC-| Class300:
4K: 4096x2160
59.94P/50P/29.97P/25P/24P/
23.98P
QFHD: 3840x2160
59.94P/50P/29.97P/25P/23.98P
MPEG HD422 (50Mbps):
HD: 1920x1080
29.97P/25P/23.98P/59.94i/50i
Tempo di registrazione e/o riproduzione
XAVC-I Class480 23.98P
Circa 34 minuti con SBP-128B/C/D
XAVC-l Class300 23.98P
Circa 54 minuti con SBP-128B/C/D
MPEG2 HD422
Circa 108 minuti con SBS-64G1A/B

[Nota]

I tempi di registrazione e di riproduzione si riferiscono alla
registrazione continua di un unico clip. | tempi effettivi
possono essere inferiori a seconda del numero di clip
registrati. | tempi di registrazione e riproduzione potrebbero
variare a seconda delle condizioni di utilizzo e delle
caratteristiche della memoria.

Videocamera

Dispositivo di imaging
Sensore di immagine CMOS a singolo
chip, 35 mm, full size
Numero di pixel
24,8 M (totale)
Filtri incorporati

Filtro ND A
Clear 0.3 0.6
(1/2) (1/4)
FiltroNDB Clear  Clear 03 06
(1/2) (1/4)
0.9 0.9 1.2 15
(/8 (/8  (216)  (1/32)
1.8 1.8 2.1 24
(1/64) (1/64) (1/128) (1/256)

Sensibilita ISO
ISO 500 (sorgente luminosa D55)
Attacco obiettivo
Attacco PL (con adattatore di attacco
obiettivo)
Lunghezza focale di flangia
52 mm
Latitudine
15+ stop

Ingresso/Uscita

Ingresso audio
CH-1/CH-2:tipo XLR, 5 pin (femmina)
(1), LINE / AES/EBU / MIC /
MIC+48V selezionabile
Ingresso CC
Tipo XLR, 4 pin (maschio), da 11 Vcca
17Vccoda22Vcca 32 Vcc
Uscita CC (12V)
Hirose, 4 pin (1),
da 11 Vcca 17 Vec (tensione di
uscita: identica a tensione di
ingresso, corrente massima di
uscita: 1,0 A),
da 22 Vcc a 32 Vec (tensione di
uscita: 15V, corrente massima di
uscita: 0,8 A),
utilizzando adattatore batteria

[Note]

® |l connettore 12V OUT consente anche di emettere in
uscita un segnale di REC Tally e ricevere in entrata un
segnale di REC Trigger.

e Collegare al connettore 12V OUT solo dispositivi con un
assorbimento di corrente non superiore a 1,0 A quando
la tensione in ingresso e da 11V a 17V, 0 non superiore a
0,8 A quando la tensione in ingresso & da 22V a 32 V.

Uscita CC (24V)
Fischer, 3 pin (2),

da 11 Vcca 17 Vcc (tensione di
uscita: 24V, corrente massima di
uscita: 1,0 A),
da 22 Vcc a 32 Vec (tensione di
uscita: identica a tensione di
ingresso, corrente massima di
uscita: 2,0 A)

[Nota]

Collegare al connettore 24V OUT solo dispositivi con un

assorbimento di corrente non superiore a 1,0 A quando la

tensione in ingresso e da 11V a 17V, o non superiore a 2,0 A
quando la tensione in ingresso € da22Va32V.

Uscita SDI' Tipo BNC (4)
3G-SDI: SMPTE ST424/425 Level B-DL/
DS



078

6. Appendice: Specifiche

HD SDI: conforme a SMPTE ST292

AUX

LEMO 5 pin (1)
Uscita mirino

LEMO 26 pin (1)
Rete

Tipo RJ45 (1)
Telecomando

8 pin (1)
Uscita MONITOR

Tipo BNC (1)

HD SDI: conforme a SMPTE ST292
Ingresso codice temporale

TC IN: Tipo BNC (1)
Ingresso GENLOCK

Tipo BNC (1)
Uscita HDMI

Tipo A (1)
Connettore dispositivo esterno

Host USB: tipo A (1)
Uscita cuffie

Mini jack stereo (1)
Uscita altoparlante

Mono

Slot per supporti di memoria

Tipo Slot ExpressCard/34 (2)
Slot per scheda SD (1)

Accessori forniti in dotazione

Adattatore VF (1)

Maniglia (1)

Cavo VF (1)

Spessore (circolare) (1)

Spessore (1/3 diarco) (15)
Coperchio attacco obiettivo (1)
Prima di usare l'unita (1)
Istruzioni per 'uso (CD-ROM) (1)

Accessori opzionali

Mirino da 0,7 pollici
DVF-EL200
Mirino da 7 pollici
DVF-L700
Cavo VF per il collegamento di un DVF-L700
A-2201-632-A 0 A-2201-633-A
Registratore di memoria portatile
AXS-R7
Schede di memoria SxS (SxS-1/5xS Pro/SxS Pro+)
SBP-256D, SBP-128B/C/D, SBP-64A/B/
C/D, SBP-32G1A/B
Lettore di schede
SBAC-US30, SBAC-UT100, AXS-AR1
Adattatore a spalla (per il montaggio su adattatore
VCT-14 con slittaa V)
VCT-FSA5
Obiettivo con attacco PL
SCL-PK6&/F (piedi), SCL-PK6/M (metri)
(kit con sei ottiche: 20, 25, 35, 50,
85, 135 mm),
SCL-P11X15 (zoomda 11 mm a
16 mm)
Batteria
BP-FL75, BP-FLX75
Adattatore CA
AC-DN2B, AC-DN10
Microfono
ECM-680S, ECM-678%, ECM-674*
(*: richiede I'utilizzo di cavetto
adattatore XLR da 3 a 5 pin
EC-0.5X3F5M)
Adattatore per doppia batteria
BKW-L200 (connessione tramite
adattatore di connessione batteria)
Monitor SDI/HDMI
serie BVM, serie PVM, serie LMD
Schede di memoria XQD (richiedono I'utilizzo di
adattatore ExpressCard QDA-EX1
da XQD a SxS)
QD-S64E, QD-S32E, QD-N64,
QD-G128A, QD-G64A, QD-G32A

Le caratteristiche di progettazione e di natura
tecnica sono soggette a modifiche senza
preavviso.

Note

® Fsequire sempre una registrazione di prova, e
verificare che il contenuto sia stato registrato
correttamente.

LA SONY NON SARA RESPONSABILE DI DANNI
DI QUALSIASITIPO, COMPRESI, MA SENZA
LIMITAZIONE A, RISARCIMENTI O RIMBORSI A
CAUSA DI GUASTI DI QUESTO APPARECCHIO
O DEI SUOI SUPPORTI DI REGISTRAZIONE,
SISTEMI DI MEMORIZZAZIONE ESTERNA O
QUALSIASI ALTRO SUPPORTO O SISTEMA

DI MEMORIZZAZIONE PER REGISTRARE
CONTENUTI DI QUALSIASITIPO.

e \erificare sempre che I'apparecchio stia
funzionando correttamente prima di usarlo.
LA SONY NON SARA RESPONSABILE DI DANNI
DI QUALSIASITIPO, COMPRESI, MA SENZA
LIMITAZIONE A, RISARCIMENTI O RIMBORSI A
CAUSA DELLA PERDITA DI PROFITTI ATTUALI
O PREVISTI DOVUTA A GUASTI DI QUESTO
APPARECCHIO, SIA DURANTE IL PERIODO
DI VALIDITA DELLA GARANZIA SIA DOPO
LA SCADENZA DELLA GARANZIA, O PER
QUALUNQUE ALTRA RAGIONE.

® SONY NON SARA RESPONSABILE PER
RICHIESTE O RICORSI DI NESSUN TIPO
PRESENTATI DA UTENTI DI QUESTO APPARATO
O DATERZI.

® SONY NON SARA RESPONSABILE PER LA
PERDITA, RIPARAZIONE O RIPRODUZIONE
DEI DATI REGISTRATI SUL SISTEMA DI
MEMORIZZAZIONE INTERNO, SU SUPPORTI
DI REGISTRAZIONE, SU SISTEMI DI
MEMORIZZAZIONE ESTERNI, O SU QUALSIASI
ALTROTIPO DI SUPPORTO O SISTEMA DI
MEMORIZZAZIONE.

® SONY NON SARA RESPONSABILE PER
LA CANCELLAZIONE O LA MANCATA
CONTINUAZIONE PER QUALSIASI CAUSA
O CIRCOSTANZA DI SERVIZI CORRELATI A
QUESTO APPARATO.
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6. Appendice: Specifiche

Dimensioni
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Marchi

® XAVCe sono marchi registrati di Sony
Corporation.

® | termini HDMI e HDMI High-Definition
Multimedia Interface e il logo HDMI sono marchi
o marchi registrati di HDMI Licensing LLC negli
Stati Uniti e in altri paesi.

® Tutti gli altri nomi di sistema e di prodotti sono
marchi o marchi registrati dei rispettivi titolari.
All'interno del presente documento, i marchi
non sono riportati con i simboli ® o ™.
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